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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed PeopleSoft Online Help

If you’re setting up an on-premises PeopleSoft environment, and your organization has firewall
restrictions that prevent you from using the hosted PeopleSoft Online Help, you can install the online help
locally. Installable PeopleSoft Online Help is made available with selected PeopleSoft Update Images and
with PeopleTools releases for on-premises installations, through the Oracle Software Delivery Cloud.

Your installation documentation includes a chapter with instructions for how to install the online help

for your business environment, and the documentation zip file may contain a README.txt file with
additional installation instructions. See PeopleSoft 9.2 Application Installation for your database platform,
“Installing PeopleSoft Online Help.”

To configure the context-sensitive help for your PeopleSoft applications to use a locally installed online
help website, see Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

* Application Fundamentals
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» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.

In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.
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Typographical Convention Description

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
¢ Latin America

¢ North America

Industry ldentifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

» USF (U.S. Federal)
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* E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.

Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

»  Using the PeopleSoft Online Help.
» Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

PeopleSoft HCM Related Links

Oracle Help Center

PeopleSoft Online Help Home

PeopleSoft Information Portal

My Oracle Support

PeopleSoft Training from Oracle University

PeopleSoft Video Feature Overviews on YouTube

PeopleSoft Business Process Maps (Microsoft Visio format)

“HCM Abbreviations” (Application Fundamentals)

PeopleSoft Spotlight Series

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.
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Follow Us

Link

)
o
3

Watch PeopleSoft on YouTube

[]

Follow @PeopleSoft Info on X.

X

Read PeopleSoft Blogs

Connect with PeopleSoft on LinkedIn

1]
L
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Chapter 1

Getting Started with PeopleSoft Payroli
Interface

PeopleSoft Payroll Interface Overview

PeopleSoft Payroll Interface is a table-driven, generic export and import engine that enables you to
exchange data between PeopleSoft HCM and a third-party payroll system.

With Payroll Interface you maintain employee data in PeopleSoft HCM while using the third-party
payroll system to perform the payroll processing functions. Data is exchanged between the two systems
using the Payroll Interface Export and Import processes.

This diagram illustrates PeopleSoft Payroll Interface.

PeopleSoft Enterprise —Export—p- Third-party
HRMS +—  Payroll Interface e mport—] Payroll System

PeopleSoft Payroll Interface Business Processes

PeopleSoft Payroll Interface provides these business processes:
* Maintain payroll data.

* Run (calculate and confirm) deductions.

* Run exports and imports (exchange data).

We discuss these business processes in the business process topics in this product documentation.

PeopleSoft Payroll Interface Integrations

PeopleSoft Payroll Interface integrates with these PeopleSoft applications:
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This diagram illustrates the PeopleSoft applications with which Payroll Interface integrates.

Payroll Interface

¢ Y h 4

- : Human Resources
Benefits Administration A nce Man ment
enefits Administratio Manage Base Benefits bsence Manageme

We discuss integration considerations in the implementation topics in this product documentation.

Supplemental information about third-party application integrations is located on the My Oracle Support
website.

PeopleSoft Payroll Interface Implementation

16

PeopleSoft Setup Manager enables you to generate a list of setup tasks for your organization based on the
features that you are implementing. The setup tasks include the components that you must set up, listed in
the order in which you must enter data into the component tables, and links to the corresponding product
documentation.

Other Sources of Information

In the planning phase of your implementation, take advantage of all PeopleSoft sources of information,
including the installation documentation, table-loading sequences, data models, and business process
maps.

Refer to the PeopleSoft HCM 9.2 - Reorganization of Component Interface Permissions (Doc 1D
2342162.1) article on My Oracle Support for a list of system-delivered Cls and their usage, the mapping
of Cls and associated permission lists, and the mapping of CI permission lists and user roles.

See:
* Application Fundamentals

e Peoplelools: Setup Manager
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Chapter 2

Understanding PeopleSoft Payroll Interface

Interface Definitions

Payroll Interface is a table-driven export and import engine that enables you to exchange data between
PeopleSoft HCM and a third-party payroll system. Data exchanges are set up through the export and
import interface definitions, which enable you to download data from or upload data to database tables:

» The export interface definition retrieves, formats, and downloads payroll-related data from various
PeopleSoft HCM tables. The Export process writes the data to either a flat file or a database table.

* The import interface definition uploads the processed payroll results into seven Payroll Interface
import tables located in PeopleSoft HCM. The Import process reads data only from ASCII files.

Export Interface Definition

The export interface definition includes the payroll setup and the interface definition. The payroll setup
identifies the payroll-related data (earnings, deductions, taxes, and so forth) and determines the pay
schedules (the pay groups and pay calendars that determine which employees are processed during the
export run). The interface definition determines the data mapping between the PeopleSoft HCM system

and the third-party payroll system, defines the SQL retrievals and any additional COBOL processing, and

specifies the export file format.
This diagram illustrates the export framework:

This diagram illustrates the export framework:

PeopleSoft Enterprise
HRMS

v

Payroll Setup Deduction Calculation Export Interface Definition
Payroll Data —» Deduction Confirmation 4—  Control Tables
Payroll Schedules Export Cobol Routines

Who and When Y What and How
Export File
{Export Table)

!

Third-party
Payroll System
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Import Interface Definition

The import interface definition is simpler—and more limited—than the export interface definition. The
interface definition is set up such that the Import process can locate the import file and then load the
processed payroll data into the seven Payroll Interface import tables. You do not need to set up any type
of scheduling; the Import process can be run as soon as the import file is made available.

Note: The Import process does not perform data auditing or reverse translations. Depending on your
implementation, you may want to write a custom Structured Query Report (SQR) program that performs
these functions as well as loads the data into the seven import tables.

This diagram illustrates the import framework:

This diagram illustrates the import framework.

PeopleSoft Enterprise
HEMS

i

Import ]

[

Import File

T

Third-party
Payroll System

Import Interface Definition
Control Tables

Data Exchanges

18

Payroll Interface enables you to maintain employee data in PeopleSoft HCM while using the third-
party payroll system to perform the payroll processing functions. With Payroll Interface, data exchanges
between the two systems are performed in four phases:

1. (Optional) Run the Calculate Deductions and Deduction Confirmation processes to calculate and
confirm pay period deductions.

2. Run the Export process to retrieve and write the pay (and deduction) data from PeopleSoft HCM to an
export file or table.
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3. Make the export file or table available to the third-party payroll vendor. The third-party vendor uses
the appropriate software solution to load the data into the third-party payroll system, to perform the
payroll processing functions, and to write the processed payroll results to one or more import files.

4. (Optional) Run the Import process to read the import file and load the processed payroll data back into
PeopleSoft HCM.

This diagram illustrates the Payroll Interface Deduction, Export, and Import processes:

This diagram illustrates the Payroll Interface Deduction, Export, and Import processes.

PeopleSoft Enterprise
HRMS Deduction Deduction Pay Period
Employee Benefit — G;Iculahm ——» Confirmation |——» Deductions
and Deduction Data FOGESS Fireas
PeopleSoft Enterprise ¢
MRMS E Export Fil Third-party
¥port - xport File ird-pa
Employee Personal, > Process "| (Export Table) Payroll System
Salary, Tax data
PeopleSoft Enterprise
HRMS T
P Impart . hird-party
Payroll Interface N Process < I Payroll System
Import Tables

Deduction Process

You have the option of maintaining employee deduction information in PeopleSoft HCM using the
PeopleSoft HR Manage Base Benefits business process. If you maintain deductions, you must run the
Calculate Deductions and Deduction Confirmation processes before you run the Export process. The
deduction processes calculate and confirm per pay period benefit and general deduction amounts.

Note: If you do not maintain deductions (that is, if the third-party payroll system manages all deduction
information) then you do not need to run the Calculate Deductions or Deduction Confirmation processes.

Export Process

The Export process exports employee-level personal, job, salary, deduction, and tax information that
the third-party payroll system needs to produce paychecks each pay period. Payroll Interface can export
data from any PeopleSoft HCM table that includes the PeopleSoft EmplID field as a key field. Data is
exported to either a flat file or a database table.

Payroll Interface does not perform any payroll calculations. The third-party payroll system performs the
tax calculations, earnings calculations, gross-to-net calculations, and year-end processing. You use Payroll
Interface to track and export changes that occur, during a pay period, to static employee payroll-related
data. The data is considered static because it rarely changes, for example, a person's job code, pay rate,
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tax status, number of dependents, or benefit plan (which can be changed only during an open enrollment
period).

Warning! Payroll Interface is designed to export changes to static employee payroll-related data; for
example, job codes, benefit deductions, or wages - information that does not change that often during the
course of a year. Dynamic or transactional pay data, such as monthly commission payments or time and
labor calculations, must be set up and maintained by the third-party payroll system.

Import Process

You have the option of importing the payroll results produced by the third-party payroll system back into
PeopleSoft HCM. The Import process loads payroll check, earnings, deduction, and tax data into seven
Payroll Interface import tables. Once loaded, the data can be viewed online or by running reports. Data is
imported only from ASCII files.

Note: Further processing or technical configuration may be required to check the validity of the imported
data or to ensure that the data can be accessed in a secure manner.

Sample Data Definitions

PeopleSoft delivers sample data definitions for use with Payroll Interface. You can often more easily
begin an implementation by cloning (copying) one of the sample data definitions.

The export sample data definitions are logical (LOG), physical (PHY), comma-separated value (CSV),
and National Finance Center (NFC) for the federal government. The import sample data definitions are
check detail (DETI) and check balance (BALI). Corresponding system IDs, configuration IDs, and file
IDs are set up for most of these definitions.

Warning! Do not assume that the sample data is complete or that it will function in a production
environment without further modification.

Related Links

Cloning an Interface Definition
Working with Interface Definitions

Implementation Steps

To set up, test, and install a payroll interface, follow these steps. As you perform the tasks outlined here,
document everything; this will help you to troubleshoot any problems that arise.

Step Tasks

1. Assemble an implementation team and perform the gap/fit | See Implementation Tasks.
analysis.
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Step Tasks

2. Set up the PeopleSoft HCM core and foundation table See Application Fundamentals
components.

3. (optional) Set up PeopleSoft HR Manage Base Benefits. See

Note: Perform this step only if you maintain benefit PeopleSoft Human Resources Manage Base Benefits.

deductions.

4. Set up export (or import) interface. Perform these tasks:

Note: The import interface is usually set up and tested after *  Setup the payroll data and schedules.

you have set up and tested the export interface. ) )
See: Understanding Earnings

Understanding Deductions

Understanding Tax Data.
Understanding Payroll Schedules.

*  (optional) Clone an existing interface definition.
See Understanding the Cloning Process.

»  Set up the export (or import) interface definition.

See: Understanding the Control Tables.

Working with Interface Definitions.

5. Test the export (or import) interface. Using the sample data or a copy of the live system, perform
these tasks:

*  (optional) Run the Calculate Deductions and Deduction
Confirmation processes until error free.

See Understanding Deduction Processing.

*  Run the Export (or Import) process until error free.

See Understanding Data Exchanges.

6. Install the export (or import) interface. Using the live system:

» Install the export (or import) interface.

*  Run the Calculate Deductions and Deduction
Confirmation processes, the Export process, and the
Import process (whichever apply).

*  Train users to set up and maintain payroll data.

*  Train users to run the Calculate Deductions and

Confirmation processes, the Export process, or the Import
process (which ever apply).
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Implementation Tasks

This topic discusses:

Preliminary tasks.
Implementation team.

Gap/fit analysis.

Preliminary Tasks

Implementing a payroll interface requires a thorough understanding of PeopleSoft HCM and the
requirements of the third-party payroll system. To ensure a smooth implementation, you should:

Secure full executive sponsorship.

You need cooperation from multiple departments, such as payroll, human resources, finance, and
information services.

Set aside sufficient time and resources.

Implementing a payroll interface requires design, planning, development, implementation, and testing.
While strong project management is especially critical for global implementations with multiple
companies, all implementations require a firm hand with scheduling and details.

Attend Payroll Interface training.

Implementing a payroll interface requires both functional and technical expertise. Practice first by
using the delivered sample data to understand how Payroll Interface works. Then, create your own
definitions and output file using the delivered demo data as the model. Finally, copy a "live" database
—don't use the actual live database—from your organization. Configure it and test run the Payroll
Interface Calculate Deductions and Confirmation processes and the Export and Import processes
using your organization's actual data.

Apply any software updates or fixes.
Contact My Oracle Support for any applicable patches that have been posted since the general release.
Obtain the vendor documentation.

Obtain a complete set of documentation from the third-party payroll vendor. The payroll interface
that you set up is based on the data, formatting, and processing requirements of the third-party payroll
system.

Implementation Team

Recommended team members for a payroll interface implementation include:

22

Payroll interface lead.
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The lead is responsible for the payroll interface setup and configuration, and for the initial export/
import of data. The lead must understand Payroll Interface as well as the third-party payroll system.
Keep the backup lead informed during the entire implementation process.

Payroll functional lead.

The lead is the recipient of the exported payroll data file. The lead should know about payroll codes,
employee payroll data, and the steps involved in processing payroll. The lead needs to understand the
third-party payroll system capabilities, if not its technical details.

Database administrator (DBA) technical lead.

The lead manages PeopleSoft table maintenance, technical configurations, SQL, PeopleTools, the
Application Engine, COBOL, and PeopleCode.

HCM functional lead.

The lead must understand PeopleSoft HCM data and the transactions and business processes
involving a payroll interface, including benefits and deduction calculations.

HCM project lead.

The lead manages a payroll interface implementation and ongoing maintenance. Sometimes another
team member takes on these duties.

Gap/Fit Analysis

The gap/fit analysis is the most important step in the implementation process. This is where you identify
exactly what needs to be set up in the export interface definition (and to a lesser extent, the import
interface definition).

Conduct a Functional Analysis

Analyze your functional requirements:

Establish data ownership.
Establish who owns the data, typically either the human resources or the payroll department.
Identify business processes, transactions, and data flow.

Create a flow chart that shows data movement in different situations, such as for new hires, transfers,
and pay rate changes.

Determine common data elements.

Determine common elements and relationships between the existing employee data and the
requirements of the third-party application. Identify field mapping and translation requirements.

Conduct a Technical Analysis

Analyze your technical requirements:

Identify the PeopleSoft tables and fields.
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Identify the tables and fields containing employee-level payroll-related data to be exported.
Depending on the data requirements of the third-party payroll system, you may need to create
additional views.

Identify the third-party payroll system fields.

Identify the third-party payroll system fields that will receive the data that is exported from
PeopleSoft HCM. Understand the third-party payroll system import specifications. Refer to the
vendor documentation or use the third-party payroll system's technical support for assistance.

Identify data gaps.

Identify and isolate any gaps between PeopleSoft HCM and the third-party payroll system. Isolate
requirements as early as possible. Any gaps will have to be bridged using special processes, routines,
calculations, or conditional logic.

Obtain the Vendor Documentation

It is critical that you obtain the vendor documentation for the third-party payroll system. The vendor
documentation contains the requirements for the third-party payroll system and will guide you in setting
up the export or import interface definition.

Work with the third-party vendor to answer the following types of questions:

L]

What file format is required for import (for example, comma-delimited or a physical sequence)? Is
there a choice on the type of fields exported? Which type of file is recommended for personal data?

What's the required file layout? For example, should there be a header record using field names or
field name codes followed by the value? Also, should there be a trailer record?

Can you accept a flat file of employee data each pay period? (That is, a full export instead of just
changes.)

What are file naming conventions? Where should export files be placed?
Do earnings and personal data need to be in separate files?
Are any fields effective-dated?

What is the unique key field or combination of fields that identifies an employee? For example,
payroll ID or national ID (SSN).

What fields are mandatory? Are fields different for new hires or changes to existing data? Do any
fields need to be paired or grouped together?

What is the maximum number of fields per output record?
Can new hires and changes be in the same file?

Are there user-defined lists, such as cost center lists, that have to be pre-loaded with PeopleSoft HCM
values? (For each user-defined list, you need the third-party payroll provider's values to set up correct
data mappings.)

Are there reports that validate the payroll interface export file, for example, a report that identifies
changes to the system?
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*  Who prepares the export file from the third-party payroll system?

* How do you set up a test database with the third-party payroll software? (You should run test imports
into the third-party system, but you do not want to touch the production database.)

Perform the Data Mapping

Data mapping between PeopleSoft HCM and the third-party payroll system is a vital implementation step.
Base your data mapping on the information gathered during the functional and technical analyses. Data
mapping requires two considerations:

* PeopleSoft field locations must match up with third-party payroll system field locations.

For example, if your third-party payroll system receives data for hire status in the 30th position of a
physical export file, then you must configure Payroll Interface to place this data in the 30th position of
your export file.

» Data values must be translated accurately.

For example, the hire-status value for active employees is maintained in PeopleSoft HCM as Active.
In the third-party payroll system, the same data might be maintained using the value 4. To map the
PeopleSoft data to the third-party payroll system, you would need to construct your file export process
to write a value of 4 to the export file every time it sees a value of Active in the PeopleSoft data
(because the value of Active means nothing to the third-party payroll system).

To map values between PeopleSoft HCM and the third-party payroll system, use translate values.

See Setting Up the Field Definition Table.

Note: (USF) Every effort is made to ensue that the National Finance Center (NFC) sample data that is
delivered with Payroll Interface conforms to NFC requirements. However, you should always check the
data mapping in the delivered export configuration for accuracy.

This graphic shows a spreadsheet you can use as a starting point to facilitate data mapping:
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This graphic shows a spreadsheet you can use as a starting point to facilitate data mapping.

Spreadsheet Column Heading

Third-party field name

Third-party field values

Third-party field format

Payroll Interface field name

Length

Description

PeopleSoft record (table) field name

PeopleSoftThird-party translate values

Payroll Interface field format

Comments

Third-party requirements

Note: Use the Payroll Interface field name to set up the interface file definition when you define the
export/import file layouts.

Assess Employee Actions

Payroll Interface uses the PeopleSoft employee ID (EmplID) to track and export changes that occur to
employee payroll-related data. The PeopleSoft employee ID must be mapped to the third-party payroll
system employee ID. Analyze your human resources, benefits, and payroll transactions; make sure you
understand the relationships between these transactions and the requirements of the third-party payroll
system.

This table lists the types of questions to ask during the analysis:

Action

Questions

Hires

What ID do you use for payroll?

*  How do you assign employee IDs?

*  How does the payroll system identify new hires?

*  Are there special requirements for a new-hire transaction?

*  What are the minimum required data fields?
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Action Questions
Rehires *  How are rehires processed?
* Is the same payroll ID used over and over again?
*  How does the payroll system set up a rehire? Are
preexisting or new IDs used?
*  What impact might existing rehire procedures have on
Payroll Interface?
Terminations *  How does the payroll system handle terminations?
* Do you need to send over a special code?
* Do you need to zero out compensation values?
* Do you need to zero out date fields? Do you need to send
any stop transactions?
Employee ID Changes Do you need a procedure to translate the third-party payroll
system employee ID to the PeopleSoft EmplID?
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Processing

Deduction Processing

This topic discusses:
» Calculate Deductions process flow.
« DED _LINE and DED_CALC tables.

*  Deduction processing and multiple jobs.

Calculate Deductions Process Flow
This diagram illustrates the Calculate Deductions process flow:

This diagram illustrates the Calculate Deductions process flow.

Payroll Interface COBOL
Run Control ID LL_co)|—p PSPDCRUN [—calle PSPDCCAL [—call—m COBOL ||
Pay Run ID
» PSPDCEMP (— CHECK Armray
» PSFDARRY [— DARRY Array
» PSFUPDED
DED_LINE
Table
DED_MESSAGE
DED_CALC lalle
Table

Deduction processing occurs in the following way:

1. To start the Calculate Deductions process, enter a pay run ID and other parameters using the Calculate
Deductions (RUNCTL DED CALC) component, Calculate Deductions page.

2. PSPDCRUN reads the pay run ID and calls PSPDCCAL.
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3. PSPDCCAL calls the COBOL routines required to process deductions.
4. PSPDCCAL calls PSPDCEMP, which in turn creates the CHECK array.
5. PSPDCCAL calls PSPDARRY, which in turn creates the DARRY array.

6. PSPDCCAL calls PSPUPDED, which populates the DED_LINE and DED CALC tables.

PSPDCCAL calls PSPDCEMP
The PSPDCEMP COBOL routine:
» Selects the jobs and benefit programs to be processed by PSPDARRY.

* Stores the EMPL_RCD and BEN_RCD that might exist for the EMPLID in the CHECK array.

PSPDCCAL calls PSPDARRY
The PSPDARRY COBOL routine:

» Uses the CHECK array to select and calculate the deduction values that should be taken from an
employee's check.

» Stores the calculated deduction values in the DARRY array.

PSPDCCAL calls PSPUPDED

The PSPUPDED COBOL routine writes the results of the Calculate Deductions process to the
DED LINE and DED CALC tables.

Note: The EMPLID/EMPL_RCD key field combinations for an employee are determined using the
CHECK and DARRY arrays.

DED_LINE and DED_CALC Tables

30

Payroll Interface stores the results of the Calculate Deductions and Deduction Confirmation processes in
three tables: DED_CALC, DED_LINE, and DED MESSAGE.

This diagram illustrates the parent-child relationship between the DED_LINE and DED CALC tables:

This diagram illustrates the parent-child relationship between the DED LINE and DED CALC tables.

DED_LINE
Table

DED_CALC
Table

DED_LINE Table

The DED_LINE table stores the EMPLID and EMPL RCD key fields that are required to identify and
process an employee. The value of the PAY LINE STATUS field indicates whether the process finished
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successfully or failed. You can view the results using the Review Deductions (DED CALCULATIONS)
component.

Possible PAY LINE STATUS values are:

* Calculated (C): Deductions were calculated; no errors occurred
¢ Confirmed (F): Deductions were confirmed; no errors occurred.
e Error (E): An error occurred.

* Updated by user (U): An error occurred.

* Pay in progress (P): An error occurred.

DED_CALC Table

The DED CALC table stores the EMPLID and EMPL_RCD key fields that are required to identify an
employee as well as the results of the Calculate Deductions process, including the deduction codes and
amounts for each. You can view results using the Review Deductions component.

DED_MESSAGE Table

The DED MESSAGE table stores the EMPLID and EMPL_RCD key fields that are required to
identify an employee and is populated only if an error occurs during the Calculate Deductions or
Deduction Confirmation process. You can view the error messages using the Review Error Messages
(DED_MESSAGE) component.

Deduction Processing and Multiple Jobs
To calculate deductions for an employee with multiple jobs, the following criteria is used:

* An employee with multiple jobs can have different benefit programs for each job.

» If an employee has multiple jobs, some of which use the same benefit program, one of the jobs must
be selected as the primary job.

» Ifan employee has multiple jobs, all of which use different benefit programs, each job is selected as
the primary job.

*  Deductions are calculated only for primary jobs.

This table shows possible job and benefit program combinations for three employees:

EMPLID EMPL_RCD Benefit Program Benefit Record Primary Benefit Job
Number
8412 0 BAS 0 Y
8412 1 FLX 1 Y
8412 2 FLX 1 N
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EMPLID EMPL_RCD Benefit Program Benefit Record Primary Benefit Job
Number
8200 0 BAS Y
8300 0 BAS Y
8300 1 BAS N

Benefit deductions use key fields EMPLID and EMPL_RCD. General deductions use key fields EMPLID
and COMPANY (but not EMPL_RCD). Because the key fields are not the same, benefit deductions and
general deductions are processed differently. The following tables show the deduction results for the
employee whose EMPLID is 8421.

CHECK Array:
EMPLID Benefit Program BEN_RCD
(index for more than one)
8421 BAS 0
8421 FLX 1
DARRY Array:
Benefit Plan Benefit Program BEN_RCD
20 Life BAS 0
00 (general) none 999
20 LifeX FLX 1

DED_CALC table results:

Company Pay Group Pay End Date | EMPLID EMPLID_RCD | Plan Type Benefit Plan
PST WK1 07/03/00 8412 20 LIFE

PST WK1 07/03/00 8412 00 none

PST FLX 07/03/00 8412 20 LIFEX

32
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In the preceding example, Payroll Interface treats each EMPLID/EMPL_RCD key field combination
as a separate row of information; each job is treated as a separate check. The EMPLID and all multiple
jobs will be run through the deduction calculation process. Although a separate row is created for each
multiple job in the payroll interface, all of the employee's multiple job deductions are processed at the
same time.

General Deductions

In the preceding example, general deductions should be taken against only one of the jobs. However,
because general deductions do not include the EMPL_RCD key field, you must manually select the
EMPL _RCD using the Payroll Options (PAYROLL DATA) component, Payroll Options 2 page,
Deduction Calc Record field. The Deduction Calc Record (Deduction Calculation Record) field appears
for employees who have:

Multiple jobs in the same company.
Different benefit programs for each job.

General deductions.

Related Links
Export Processing and Multiple Jobs

Export Processing

This topic discusses:

Export process flow.

Export process details.

PI_PARTIC and PI_PARTIC EXPT tables.
PI_EXTIO and PI_PARTIC_EXTBL tables.

Export processing and multiple jobs.

Export Process Flow

This diagram illustrates the Export process flow:
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This diagram illustrates the Export process flow.

Payroll Interface Application Engine COBOL

Run Control ID

all
—call Pl_INRUMN FIPINRUN

f—return——

Pay Run 1D |

Run Number call PIPCMPAR |-call»] COBOL l:

A 4

h 4

PI_EXTFL FIPXPORT f(—call COBOL |:

Pl MESSAGE
Table
PI_PARTIC FI_EXTIO R .
Table Table g Ll
—_—
Pl_PARTIC_EXPT PI_PARTIC_EXTBL
Table Table e

Export processing occurs in the following way:

L.

To start the Export process, use the Import/Export Payroll Data (PI RUNCTL PNL) component,
Import/Export Payroll Data run control page to enter the pay run ID, payroll interface run number, and
other parameters.

PI_INRUN reads the pay run ID and run number and calls PIPINRUN.

PIPINRUN calls PIPCMPAR (which in turn calls other subroutines). PIPCMPAR selects, compares,
and exports data to tables PI PARTIC and PI PARTIC EXPT.

PIPINRUN calls PIXPORT (which in turn calls other subroutines). PIPXPORT reads table
PI PARTIC EXPT, transfers the changed data to temporary table PI_EXTIO or PI PARTIC EXTBL.

PIPINRUN returns control to PI_ INRUN.
PI_INRUN calls PI_EXTFL.

If exporting to a file, PI_ EXTFL reads the data in PI_ EXTIO and creates the export file. If exporting
to a table, PI_ EXTFL reads the data in PI PARTIC _EXTBL and creates the export table.

Export Process Details

The Export process includes three phases — select, compare, and export:

34

During the select phase, payroll data is retrieved from the PeopleSoft HCM tables.

During the compare phase, the selected data is compared against the data from the previous export
run.
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The comparison phase identifies any data changes that have occurred since the last export.

During the export phase, the data is exported to either a flat file or a table.

A full-records export performs the select and export phases; all data is exported. A changes-only export
performs the select, compare, and export phases; only data that has changed is exported.

PI_INRUN calls PIPINRUN

Export processing is based on the pay run ID and run number. For each pay run ID, PIPINRUN retrieves
the company and pay group from the pay calendars. The company and pay group are used to verify the
payroll interface definitions and to select the employees who will be processed.

PIPINRUN calls PIPCMPAR

First, PIPCMPAR verifies the payroll interface setup for the selected configuration ID:

1.

Using the company and pay group, PIPCMPAR obtains the configuration ID from the Pay Group
table.

Using the configuration ID, it retrieves the file definitions and the system ID from the Configuration
table.

a. For the selected system ID, PIPCMPAR verifies all records and fields in PS Tables table.
b. For the selected system ID, PIPCMPAR verifies all fields in the Field Definition table.
c. PICMPAR verifies that all the parameters defined in the Definition table are valid.

Using the company and pay group, PIPCMPAR selects from the Job table all employees (with status
values defined in the System table) with a matching company and pay group.

Second, PIPCMPAR performs the actual export process. The export process differs for full-records
exports and changes-only exports.

L.

For a full-records export, PIPCMPAR does the following for each selected employee in the pay group:

a. For each table defined in PS Tables, retrieves rows based on the where clause definition (as well
as instance IDs, process IDs, and other information that is set up in the interface).

b. Exports the results to tables PI PARTIC and PI PARTIC EXPT in the format specified in the
Definition table (LOG, PHY, CSV, and so on).

Note: For full-records exports, all values are considered new, and therefore, changed. Flags in the
PI_PARTIC and PI_PARTIC EXPT tables are initialized to Y and 1.

2. Changes-only export, PIPCMPAR, does the following for each selected employee in the pay group:

a. For each table defined in PS Tables, retrieves rows based on the where clause definition (as well
as instance IDs, process IDs, and other information that is set up in the interface).

b. Compares the value of each field (and row, if designated) to the value that was sent in the last
export (the previous run number).
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c. Exports the results to table PI_ PARTIC and PI_PARTIC _EXPT in the format specified in the
Definition table (LOG, PHY, CSV).

Note: For changes-only exports, flags in the PI PARTIC and PI PARTIC EXPT tables are set to
Y and 1 if values change or to N and 0 if values do not change.

PIPINRUN calls PIPXPORT

PIPXPORT reads table PI PARTIC EXPT and writes the changed data to temporary table PI_EXTIO or
PI PARTIC EXTBL.

Note: If no changes occurred, table PI_EXTIO or PI PARTIC EXTBL is empty at the end of the export
process.

PI_INRUN calls PI_EXTFL

When the export processing is finished, control returns to the Application Engine. PI INRUN calls
PI_EXTFL to create the export file.

PI_EXTFL does the following:
1. For each row of data in table PI_EXTIO:

Writes a line to the export file defined in the File Handle table for the file definition. The data is
written in the character set defined on the PI System table (LOG, PHY, CSV, and so on).

2. Deletes the contents of table PI_EXTIO.

3. Deletes the run control record.

PI_PARTIC and PI_PARTIC_EXPT Tables

36

When a full-records or changes-only export is processed, flags are set in the PI PARTIC and
PI PARTIC EXPT tables. The values of these flags determine which data is written to the export file (or
table).

This diagram illustrates the parent-child relationship between the PI_PARTIC and PI PARTIC_EXPT
tables:

This diagram illustrates the parent-child relationship between the PI PARTIC and PI PARTIC EXPT
tables.

PI_PARTIC
Table Pl_CHANGE_IND
PI_PARTIC_EXPT Pl_CHANGE_IND
Table EXPORT_ROW

The PI_PARTIC table contains one row of data for every employee and for every process. It contains
high-level information that determines which employees are processed during the comparison phase. Two
key fields in this table are EMPLID and PI RUN_NUM. The PI RUN_ NUM is very important when
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doing a reprocess run. A critical field on the PI PARTIC table is PI CHANGE IND. If an employee has
had a data change since the last Export process, the PI. CHANGE IND flag is set to Y.

The PI_ PARTIC_EXPT table contains the historical (changed) data for the comparison phase. New rows
are inserted into this table during each Export process run. Every field that will be sent to the third-party
payroll system is in this table. In front of each data element on the PI PARTIC EXPT table is a change
flag. If the field has changed since the last process, this flag is set to 1; otherwise, it is set to 0. If the field
belongs to a group, the data element is prefixed with 2.

Within the PI PARTIC EXPT table, the Export Row column is a 250-byte character representation of
employee-level data. This data field is the result of information that is set up using the Definition Table
(INTRFC_DEFINITION) component. If there is more than 250 bytes of data, another row is inserted into
the table and the EXPORT SEQ is incremented. The export row is positional and is based on the order
of the fields that are set up using the Definition Table component. This is very important for maintenance
during live processing.

PI_PARTIC Table
If values change, PI. CHANGE IND is set to Y.

Possible run status indicators for a successful export run are:

Field Value

PI_PARTIC STATUS *  Compared (C). Process is complete.
*  Compare Error (E). An error occurred.

*  InProgress (P). Process is running.

Note: When the process finishes, the flag should be set to C or
E. If the flag is set to P, then an error has occurred.

PI_CHANGE IND *  Change (Y). Data has changed since the previous export.

*  Process Change (P). Data has changed and caused a
process to occur.

*  No Change (N). No data has changed.

Note: Some data changes trigger a process; for example, if an
employee is terminated, a stop transaction for deductions may
be issued.
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Field

Value

PI CHANGE_TYPE

*  New Hire (N). The employee is a new hire. All data is
sent to PI PARTIC EXPT.

*  Data (D). Data changed.

*  Process (P). Data has changed and caused a process to

occur.
*  Reactive Pay (R). The employee has been rehired.
*  Terminated Pay (T). The employee has been terminated.

+  Blank. No data changed. No data was sent to PI PARTIC
_EXPT.

PI_PARTIC_EXPT Table

If values change, PI. CHANGE IND is set to Y and the byte-length field flags that are attached to each
field value are set to 0, 1, or 2. All exported data is written to EXPORT ROW, a 250-character field.

If the export file is defined at a length greater than 252 characters, then data is loaded into additional
EXPORT ROW fields and the EXPORT SEQ sequence field is incremented.

Possible run status indicators for a successful export run are:

Field

Value

PI_CHANGE_IND

*  Change (Y). Data has changed. Data fields with a 1 flag
will be exported.

*  Process change (P). Data has changed and caused a

process to occur.

*  No change (N or blank). No data fields will be exported.

EXPORT ROW *  Zero (0). No change.

*  One (1). Change.

*  Two (2). Change in a group field.
Example 1

Assume the following for the employee with EmplID KUI001:

*  Full-records export, run number 1.

» Data values for salary, union dues, savings bond, and vehicle allowance.

38
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Export Run Num

Salary

U-Dues SV-BND

VEH

Full-records 1

1500

10 100

PI_PARTIC table—This is a full-records export and all data values are considered changed.

PI CHANGE INDissetto Y.

Field Values
EMPL ID KUI001
PI RUN_NUM 1
PI_CHANGE_IND Y

PI PARTIC EXPT table—PI CHANGE IND is set to Y and the byte-length field flag is set to 1 for all

data values.

Field Values

EMPL ID KUI001

PI RUN_NUM 1
PI_CHANGE_IND Y

EXPORT ROW 11500 110 1100 115

Export file—All data values are written to the export file (or table).

Employee (EMPLID) | Salary U-DUES SV-BND VEH
KUI001 1500 10 100 15
Example 2

Assume the following for the employee with EmplID KUI001:

* Changes-only export, run number 2.

* Data values for salary and savings bond have changed.
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Export Run Num Salary U-Dues SV-BND VEH
Full-records 1 1500 10 100 15
Changes-only 2 1800 10 150 15

PI PARTIC table—PI CHANGE IND is set to Y.

Field Values
EMPL ID KUI001
PI_ RUN_NUM 2
PI CHANGE_IND Y

PI_PARTIC EXPT table—PI CHANGE_IND is set to Y and the byte-length field flag is set to 1 for data
values that have changed and to 0 for data values that have not changed.

Field Values

EMPL ID KUI001

PI_ RUN _NUM 2

PI CHANGE_IND Y

EXPORT ROW 11800 010 1150 015

Export file—Changed data values are written to the export file (or table).

Employee (EMPLID) | Salary U-DUES SV-BND VEH
KUI001 1800 150
Example 3

Assume the following for the employee with EMPLID KUI001:

* Changes-only export, run number 3.
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Export Run Num Salary U-Dues SV-BND VEH
Full-records 1 1500 10 100 15
Changes-only 2 1800 10 150 15
Changes-only 3 1800 10 150 15
PI_PARTIC table — PI CHANGE IND is set to N.

Field Values

EMPL_ID KUI001

PI_RUN_NUM 3

PI_ CHANGE IND N

PI_PARTIC EXPT table — PI CHANGE IND is set to N and the byte-length field flag is set to O for all

field values.

Field Values

EMPL ID KUI001

PI RUN_NUM 3

PI_ CHANGE_IND N

EXPORT ROW 01800 010 0150 015

Export file — No data values have changed; no data is written to the export file (or table).

Employee (EMPLID) | Salary

U-DUES

SV-BND VEH

KUI001

Copyright © 1988, 2026, Oracle and/or its affiliates.

41




Understanding PeopleSoft Payroll Interface Processing Chapter 3

PI_EXTIO and PI_PARTIC_EXTBL Tables

The Export process can write data to either an export file or an export table.
This diagram illustrates exporting data to either a file or table:

This diagram illustrates exporting data to either a file or table.

PI_EXTIO :
= > Export Fil
Table port Hie

PI_PARTIC_EXTBL

Export Tabl
Table ] port Table

PI_EXTIO Table

In the PI_EXTIO table, the REC_ DATA PARTIAL field should contain the exact contents of the external
file. However, if the record length of the external file exceeds 252 bytes, then the rows in PI_EXTIO are
split and the RECDATA_SEQ_NO field is incremented.

PI_PARTIC_EXTBL Table

In the PI PARTIC EXTBL table, a row for each changed field is written and the SEQ _NUM field is
incremented by 1 unless the field has a group ID assigned to it. For fields with group IDs, the same

SEQ NUM is applied to all fields in the group. For the sequence numbering logic to work properly, you
must set up grouped fields correctly. For example, the DED group ID can be used to pair the Deduction
Code and Deduction Amount fields. These two fields must adjoin each other on the record; fields without
the DED group ID cannot be positioned between them.

See Setting Up the Definition Table.

Export Processing and Multiple Jobs

42

To export data for an employee with multiple jobs, the following criteria is used:
* An export record is created for each job that is set up with a Payroll Interface company/pay group.

* All records that use the employee record number in the key send the appropriate data for that record
number.

e All records that do not contain the employee record number in the key (for example, personal data)
send the same information that applies to all export records.

* All of the employee's jobs are exported, whether the jobs are from the same or different pay groups or
the same or different companies.

*  When a concurrent job is added or terminated, it is processed the same way that a single job is added
or terminated.

If you define unique IDs by combining the PeopleSoft EMPLID and record (job) number, you create
separate employees in the third-party payroll system for each job.
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If you use multiple jobs in PeopleSoft HCM, but only want to export a single job through Payroll
Interface, you might instead identify a particular job record number for all employees, then create an
instance ID attached to the record-mapped-to job, to include only that specific job record number.

Payroll System IDs

You can add another key besides the PeopleSoft EMPLID, the national ID, and the payroll interface
employee ID. You can use a view, the multiple national ID field on the personal data pages, or the Payroll
Interface existing translation logic. The approach that you choose depends on the third-party payroll
requirements.

If you need a single check, create a view to combine the values into one amount for each deduction code.
Payroll Interface treats each employee ID or employee record number as a separate row of information.
Each job is treated as a separate check. This gives you tremendous flexibility when mapping information
to the third-party payroll system.

Related Links

Deduction Processing and Multiple Jobs

Import Processing

This topic discusses:
e Import process flow.

* Import tables.

Import Process Flow

This diagram illustrates the Import process flow:

This diagram illustrates the Import process flow.

Payroll Interface Application Engine COBOL
C II—L
Run Control ID H—call<» FI_INRUN 8 FPIPINRUN
— aaslEINE
I
call call

¥ ¥
PI_EXTFL PIPMPORT |—call»|  COBOL

h 4

Import File

PI_EXTIO Table —— 7 Import Tables

Import processing occurs in the following way:
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1. To start the Import process, enter a pay run ID, run number, and other parameters using the Import/
Export Payroll Data component, Import/Export Payroll Data run control page.

2. PI_INRUN reads the run control record and calls PI_ EXTFL.

3. PI EXTFL loads the import file into table PI_ EXTIO and returns control to PI INRUN.
4. PI_INRUN calls PIPINRUN.

5. PIPINRUN calls PIPMPORT (which in turn calls other subroutines).

6. PIPMPORT reads the PI_EXTIO table and loads the data into seven import tables.

7. PIPINRUN returns control to PI INRUN.

8. PI_INRUN deletes the PI_EXTIO table and the run control.

Import Tables

44

Payroll Interface uses seven import tables to store the payroll results that are generated by the third-party
payroll system. The import tables include many user-defined fields. You do not need to map data to all of
these fields, but you do need to map to a few, such as check number and gross wages. The import tables
are:

- PI_CHECK

« PI_EARN DETAIL
« PI_DED DETAIL

.+ PI_TAX DETAIL

« PIL EARN BAL

- Pl DED BAL

« PI TAX BAL

Note: After the Import process is run, further processing or technical configuration may be required to
check the validity of the data or to ensure that employee-level data can be accessed in a secure manner.

To import numeric and signed numeric fields, the data value in the import file must not contain any
spaces. For example, to import a numeric field with a length of 10, decimal length of 2, display decimal
enabled, and a value of 10.22, the value in the data file must equal 0000010.22 (leading zeros), and not
bbbbb10.22 (where b represents a blank space).

Payroll Interface does not perform reverse translations (mappings). The data loaded into the import tables
resides in the third-party payroll system's format. For example, suppose you select the Using Interface
Employee Table option for the System Table (SYSTEM _TABLE) component, Interface System Table 1
page, Convert field. During the Export process, the PeopleSoft EMPLID is translated to the third-party
payroll system employee 1D, and the third-party payroll system employee ID is written to the export file
or table. During the Import process, however, no reverse translation takes place. The third-party payroll
system employee ID is loaded into the Payroll Interface import tables.
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Note: If you select the Using Interface Employee Table option, the data in the Payroll Interface import
tables can be joined to other PeopleSoft EMPLID-keyed tables through the PI EMPLID TBL table. This
table includes the EMPLID, EMPL_RCD, and PI EMPLID fields.

Related Links
Setting Up the System Table

Export and Import Testing

This topic discusses:

» Testing exports and imports.
*  Successful exports.

*  Unsuccessful exports.

* Detecting errors.

Testing Exports and Imports

To test export and import interface definitions, run the Payroll Interface Export and Import processes until
no errors occur and the data results are correct. Import interface definitions are usually set up and tested
after the export interface definition is verified.

Testing Exports
To test an export interface definition the first time:
1. Delete the contents of the Payroll Interface tables shown below.
2. (optional) Run the Calculate Deductions and Confirmation processes.
3. Run a full-records Export process.
Use the Pay Run ID prior to the pay run that is to be used for production.
4. When the Export process completes, check for errors.
Delete the content of these tables before running the Export process the first time:
* PI RUNCTL
« PI RUN _TBL
« PI RUN _PYGRP
« PI PARTIC
« PI_PARTIC_EXPT

« PI_EXTIO
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PI_PARTIC_EXTBL
PI_MESSAGE
DED_LINE
DED_CALC

DED MESSAGE

Testing Imports

To test the import interface definition the first time:

L.

2.

4,

Chapter 3

Delete the contents of the Payroll Interface tables shown in the succeeding table.

Obtain a copy of the import file that is produced by the third-party payroll system.

Run the Import process.
Use the pay run ID for the associated Export process.

When the Import process finishes, check for errors.

Delete the content of these tables before running the Import process the first time:

PI_ RUNCTL

PI_ RUN_TBL
PI_ RUN PYGRP
PI MESSAGE
PI_EXTIO
PI_CHECK

PI_ EARN DETAIL
PI_ DED DETAIL
PI_TAX_DETAIL
PI EARN BAL
PI DED BAL

PI_TAX BAL

Related Links

Table Management

Successful Exports

46

You can identify a successful export run in the following ways:
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* Changes that occurred during the pay period to PeopleSoft HCM mapped-data elements are exported
and written to a file or table.

* The compare process identifies correct changes.

* The implementation of additional processing logic (beyond the delivered supported application
functionality) works correctly, including:

*  Modifying the delivered Payroll Interface COBOL, for example, creating a new process ID.

* Processing files using Application Engine, Structured Query Report (SQR), or other programming
languages, for example, reformatting a record layout.

*  Writing PeopleCode, for example, to force a new set of export records given a specific job action
(that is, rehire or transfer).

* Creating new views, incorporating any American National Standards Institute (ANSI) SQL
statement. For example, join the Department table with Job to extract department GL expense
codes or managers, develop specific WHERE clauses, and perform Logic/Arithmetic/SQL
functions.

* The contents of the export file (or table) are imported into the third-party payroll system and the
data elements and transactions have been processed accurately per the third-party payroll system's
import processing requirements. These types of transactions involve updating, inserting, or deleting
employee data.

Unsuccessful Exports

For debugging purposes, sometimes it may be useful to run the PIPINRUN process directly. First, use the
Import/Export Payroll Data component, Import/Export Payroll Data run control page to enter and save the
Run Control ID and Pay Run ID. Then, instead of submitting the request to the process scheduler using
the RUN button, run PIPINRUN at the command line of the process server or any connected computer
with fully compiled current COBOL. During the run, PIPINRUN calls PIPCMPAR and PIPXPORT, the
results are written to the PI_EXTIO table, and then processing stops. To rerun the PIPINRUN process, the
contents of the PI_ EXTIO table as well as the PI RUNCTL table must be deleted.

Example 1

Export Result: PI PARTIC and PI PARTIC EXPT are both empty.

If the failure of the export is not obvious, for example, the process terminates or a Payroll Interface error
message such as MISSING RUN CONTROL is displayed, then analyze the employees. The Pay Run ID
determines the pay calendar's company and pay group. PIPCMPAR selects against JOB.COMPANY and
JOB.PAYGROUP to retrieve the appropriate employees. The DMS statement used in PIPCMPAR.DMS
to select these employees performs an insert into PI_ PARTIC. Therefore, if PI PARTIC is empty, it is
because the PIPCMPAR SQL that is trying to select employees and do the insert failed.

Most likely, an interface error message is in PI MESSAGE stating that there were no records to export.
However, to determine why no employees were selected, you will need to analyze the pay run ID, the
associated pay calendar, the Pay Group table, and the corresponding employee job records.
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Example 2

Export Result: PI_PARTIC is loaded and PI PARTIC EXPT is empty.

If the PI PARTIC table is loaded, then the Export process select phase was successful (which means

that the pay run ID, the pay calendar, the Pay Group table, and the Job records were set up correctly).

If the process did not end, but the PI PARTIC EXPT table is empty, then the Export process compare
phase was not successful. Do an inquiry on the interface messages (PI_ MESSAGE) to determine why the
process failed. When all of the issues are fixed, you should be able to reprocess the export.

Example 3

Export Result: PI_ PARTIC is loaded, PI PARTIC_EXPT is loaded, PI_EXTIO is loaded (when it should
be empty) and no export file is created.

If PI_ EXTIO is loaded, the Export process select, compare, and export phases finished successfully.
However, the Application Engine's file I/O process that writes the contents of PI_EXTIO to the export file
(and then deletes PI_EXTIO) did not finish successfully. Make sure the file IDs and file handles are set up
correctly. If they are, then analyze the Application Engine programs PI INRUN and PI EXTFL.

Note: This does not apply if you are exporting data to a table.

Example 4

Export Result: PI_PARTIC is loaded, PI PARTIC _EXPT is loaded, PI_EXTIO is empty, and no export
file is created.

This scenario could mean that the Export process was successful and no changes exist. It also could mean
that the Export process was successful and the external file was created, but the file is not located where
you expected it.

If known data changes have occurred and the file cannot be found, then evaluate the PSPSEQIO COBOL
program for issues surrounding the insert into the PI_ EXTIO table. It would be helpful to run the COBOL
process separately to insure that PI_ EXTIO is being loaded at the end of the compare and export phases.
At that point, the analysis should shift to the Application Engine's write to the external file.

Note: This does not apply if you are exporting data to a table.

Related Links
Understanding Data Exchanges

Detecting Errors

48

To determine whether an error has occurred after running the Calculate Deductions or Deduction
Confirmation processes, first refer to the Review Deductions and Review Error Messages components.

See Reviewing Deductions.

To determine whether an error has occurred after running the Export or Import processes, first refer to the
Error Messages (PI MESSAGES) component and various reporting components.

See Reviewing Exports or Imports.
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Error Messages

If the explanation in the Error Message component is not clear, you can use the message number to
determine where in the COBOL routine the problem occurred. For example, suppose message 004030
returns the following information:

The Dedcalc process was not confirmed. This data is not available
until the confirm is processed. The message data below identifies 2
field values. 1. Company 2. Paygroup.

To locate the problem:
1. Search for 004030 in PSCPYMSG.CBL to determine the corresponding 88 level name for MSGID.
In this case, it is MSGID-DEDCALC-NOT-CONFIRMED.

2. Using a search tool, do a search against PI*.CBL to look for all the occurrences of MSGID-
DEDCALC-NOT-CONFIRMED.

The result is in PIPINRUN.CBL, paragraph MM 100-CONFIRM-DEDCALC.

The location of the error in the COBOL routine may point to a SQL statement or array search that may
give additional clues to the problem.

Error: Dynamic SQL Failure Due to Invalid PS Table Setup

If you use PeopleSoft Application Designer to change any of the tables or fields that are set up in the PS
Tables (PS_ TABLES) component, you must make sure that these changes are reflected in the PS Tables
component as well. If you do not, the Export process will end when attempting to run the dynamically
created SQL statement. If it is not obvious which table or field is causing the error, you can run the Export
process from a DOS prompt.

To run PIPINRUN from the DOS prompt:
1. From the DOS prompt, run PIPINRUN with the SQL Trace turned on.
2. Atthe SQL Trace prompt, enter 191.

A trace file is written to CATEMP\PS\<dbname>\COBSQL . The SQL causing the process
to end should be toward the end of the trace file with a SQL statement name such as S JOB,
S GENL DEDUCTION, and so on.

3. Copy the SQL to the database's SQL Inquiry tool and run it using the parameters listed below the
statement in the trace file.

The SQL Inquiry tool should point to the problem field.

See PeopleTools: Application Designer Developer's Guide

Error: Maximum Number of Export Records Exceeded for EMPLID

PIEXPT-COUNT-MAX represents the maximum number of records that can be generated for an
EMPLID. During the Export process, this maximum number can be reached when you are processing
files that comprise a high number of rows in PS_JOB.
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PIEXPT-COUNT-MAX is set to 200 by default. If you want to increase this number, you need to modify
to the COBOL in two places:

* In PICIEXPT.CBL, insert the desired number where you see 200 in bold.
88 PIEXPT-COUNT-MAX VALUE 200

* In PIPIEXPT.CBL, insert the desired number where you see 200 in bold.
02 PIEXPT-DATA OCCURS 200

Be sure to recompile the programs when you are done.

You may encounter similar error messages for "Maximum number of export records exceeded." Again,
just follow the code line through and increase the 88 VALUE and the corresponding OCCURS values.

Table Management

50

Payroll Interface is a table-driven export and import engine. As you set up and maintain an interface
definition, you may need to work directly with various Payroll Interface tables.

Note: If using PeopleSoft Data Mover to run DELETE, IMPORT, and EXPORT scripts, use the internal
name for the table, for example, PI PARTIC. If using Microsoft SQL Query Analyzer or some other non-
PeopleSoft tool to run SQL statements, use the external name for the table, for example PS_PI PARTIC.

See PeopleTools: Data Management

Managing the Process Tables

Occasionally, you may want to delete the data in the Payroll Interface process tables to free disk space,
reduce processing times, or send a full record export file to the third-party payroll system.

Warning! PeopleSoft does not support a specific purge strategy. Back up tables before you run the SQL
DELETE statement.

To purge the process tables, follow these general guidelines:

1. Stop all data input into the PeopleSoft system.

2. Run the normal daily process (usually a changes-only export run).

3. Delete the data in the selected process tables.

4. Run the normal daily process again (the system will return by default to a full-records export run).

You should delete the data in the tables whenever changes are made to the export file definition (for
example, changing field characteristics such as increasing or decreasing field sizes or edit masks or
adding or deleting fields from the interface definition).

The PI_PARTIC and PI_ PARTIC EXPT tables can get very large. You should monitor the size of these
tables on a regular basis to ensure that Payroll Interface functions properly. You may want to archive
historical data in these tables.
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The PI RUN_TBL tables contains the PI. RUN_NUM field. If you purge this table, the PI run
number is reset to 1. If you do not want to reset run number, do not purge the PI RUN_TBL or the
PI_ RUN_PYGRP tables. When you run the Export process, the run number will be incremented to the
next number.

Warning! Do not purge the PI EMPLID TBL if you have mapped the PeopleSoft EMPLID to the third-

party payroll system employee ID.

The Payroll Interface process tables include:

Managing the Control Tables

AERUNCONTROL
PI RUNCTL

PI RUNCTL_AE
PI_ RUNCTL_SID
PI_ RUN_TBL

PI_ RUN PYGRP
PI PRESELECT
PI_ EMPLID TBL
PI_PARTIC
PI_PARTIC_EXPT
PI_EXTIO
PI_PARTIC_EXTBL
PI MESSAGE
DED CALC
DED_LINE

DED MESSAGE

Occasionally, you may want to transfer the Payroll Interface control tables (also referred to as the
setup tables) from one database to another for example, when you move from a test environment to a
production environment.

Warning! Never copy the process tables (PI_PARTIC, PI PARTIC_EXPT, and so on) from a test
environment to a production environment. These tables are automatically populated in the production
environment.

To export tables, run this script:

SET LOG C:\TEMP\PI EXPORT.LOG
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« SET OUTPUT C:\TEMP\PI TABLES.DAT
«  EXPORT PI_SYSTEM TBL

«  EXPORT PI_SYSTEM_STAT

«  EXPORT PI_SYSTEM_LANG
«  EXPORT PI PS RECORD
 EXPORT PI_PSREC FLD

« EXPORT PI_PS REC_LANG

« EXPORT PI_INSTANCE_TBL
«  EXPORT PI_INST VALUE

«  EXPORT PI_INSTANC_LANG
« EXPORT PI PROCESS TBL
EXPORT PI_PROCESS VAL

«  EXPORT PI PROC_TB_LANG
«  EXPORT PI PROC_VA_LANG
«  EXPORT PI_FIELD TBL

«  EXPORT PI_FIELD XLAT

« EXPORT PI FIELD LANG

.« EXPORT Pl GROUP TBL

«  EXPORT PI GROUP_LANG

«  EXPORT PI_DEFN_FILE

«  EXPORT Pl DEFN_RECORD
«  EXPORT PI_DEFN_FIELD

« EXPORT PI DEFN F LANG

. EXPORT PI_DEFN R _LANG

«  EXPORT PI_CONFIG TBL

«  EXPORT PI_CONFIG _FILE

«  EXPORT PI_CONFIG_LANG

«  EXPORT FILE_ HANDLE_LNG
«  EXPORT FILE HANDLE TBL

To import tables, run this script:

Chapter 3
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L]

SET LOG C:\TEMP\PI_IMPORT.LOG
SET INPUT CATEMP\PI TABLES.DAT
REPLACE ALL *

SET LOG CA\TEMP\PI_IMPORT.LOG
SET INPUT CATEMP\PI TABLES.DAT

IMPORT * IGNORE_DUPS

Understanding PeopleSoft Payroll Interface Processing

REPLACE_ALL *;—Deletes all data from the PeopleSoft table and replaces it with the data in your
import file.

IMPORT * IGNORE_DUPS;—Leaves all data in the PeopleSoft table and loads only new rows of data. It
will not replace any data already in the table. So if you have a row that exists in both the source table and
the target table, no action is taken at all, even if some of the fields on that row have changed
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Setting Up Earnings Data

Understanding Earnings

Payroll Interface does not calculate earnings. You use Payroll Interface to track and export changes
to earnings data that occur during a pay period. The third-party payroll system performs the earnings
calculations and the gross-to-net calculations.

Payroll Interface recognizes two earnings categories, regular earnings and additional pay. Regular
earnings refers to the employee earnings that are entered on the Job Data component, for example,
regular or overtime pay. Additional pay refers to employee earnings that are entered on the Additional
Pay component and represents earnings that an employee is paid on a regular basis in addition to regular
earnings, for example, a vehicle allowance.

Two earnings components are included with Payroll Interface, the Earnings Table (EARNINGS TABLE)
component and the Earnings Program Table (EARNS PROGRAM_TBL) component:

* The primary purpose of the earnings components is to enable you to set up the earnings codes and
earnings program that are required on the Pay Group Table component, Calc Parameters (calculation
parameters) page.

* A secondary purpose of the earnings components is to enable you to set up earnings codes for
additional pay and to add these codes to the earnings program.

Related Links
Understanding Payroll Schedules

Setting Up Earnings Codes and Earnings Programs

To set up earnings codes and earnings programs, use the Earnings Table (EARNINGS TABLE) and
Earnings Program Table (EARNS_PROGRAM_TBL) components in PeopleSoft Payroll for North
America.

Pages Used to Set Up Earnings Codes and Earnings Programs

Page Name Definition Name Usage
Earnings Table - General Page EARNINGS TABLE1 Set up earnings codes. The Payment

Type, Effect on FLSA, and Eligible for
Retro Pay group boxes are not used by
Payroll Interface.
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Page Name Definition Name Usage
Earnings Program Table Page EARNS PROGRAM TBL Set up the earnings program.

Understanding Earnings Codes and Earnings Programs

An earnings code defines a type of earnings, for example, maternity leave. You set up earnings codes for
regular earnings as well as additional pay. To satisfy the requirements of the Pay Group Table component,
Calc Parameters page, you must set up default earnings codes for regular, overtime, and holiday pay.

An earnings program defines a set of earning codes that is valid for one or more pay groups and

the employees who belong to those pay groups. To satisfy the requirements of the Pay Group Table
component, Calc Parameters page, you must set up a default earnings program that includes the default
earnings codes for regular, overtime, and holiday pay.

Related Links
“Establishing Earnings Codes” (PeopleSoft Payroll for North America)
“Establishing Earnings Programs” (PeopleSoft Payroll for North America)

Earnings Table - General Page

Use the Earnings Table - General page (EARNINGS_TABLEL!) to set up earnings codes.
Navigation:
Set Up HCM > Product Related > Payroll Interface > Earnings > Earnings Table > General

Set Up HCM > Product Related > Payroll for North America > Compensation and
Earnings > Earnings Table > General

See the““Earnings Table - General Page” (PeopleSoft Payroll for North America) in the Payroll for North
America product documentation.

The Payment Type, Effect on FLSA, and Eligible for Retro Pay group boxes are not used by Payroll
Interface.

Note: To set up the earnings codes that are required for the Pay Group Table component, use on/y the
General page (ignore the Taxes, Calculation, and Special Processes pages).

To set up earnings codes for additional pay, use the General page and, if necessary, the Taxes, Calculation,
and Special Process pages.

Earnings Program Table Page

56

Use the Earnings Program Table page (EARNS PROGRAM_TBL) to set up the earnings program.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Earnings > Earnings Program Table >
Earnings Program Table
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Set Up HCM > Product Related > Payroll for North America > Compensation and
Earnings > Earnings Program Table > Earnings Program Table

See the “Earnings Program Table Page” (PeopleSoft Payroll for North America) in the Payroll for North
America product documentation.

Setting Up and Maintaining Additional Pay

To set up and maintain additional pay, use the Additional Pay (ADDITIONAL PAY) component.

Page Used to Set Up and Maintain Additional Pay

Page Name Definition Name Usage

Additional Pay Page ADDITIONAL PAY1 Set up and assign additional pay earnings
to an employee.

Specify a different department to charge
for the additional pay.

Change employee tax data for additional
pay.

Understanding Additional Pay

Additional pay refers to earnings that an employee is paid on a regular basis in addition to regular
earnings, for example, a vehicle allowance, variable compensation, or benefit credits. (Do not confuse
additional pay with one-time payments, such as overtime or an expense reimbursement.)

To set up and maintain additional pay:
1. Use the Earnings Table component to set up an earnings code for the additional pay.
2. Use the Earnings Program Table component to add the earnings code to the earnings program.

3. Use the Additional Pay component to set up and assign the additional pay to an employee.

Additional Pay Page

Use the Additional Pay page (ADDITIONAL PAY) to set up and assign additional pay earnings to an
employee.

Navigation:

Payroll Interface > Update Payroll Information > Additional Pay > Additional Pay

Copyright © 1988, 2026, Oracle and/or its affiliates. 57



Setting Up Earnings Data

This example illustrates the fields and controls on the Additional Pay page (1 of 3).

Chapter 4

Additional Pay
Kirby Torres EMP I kU004 Empl Record 0
Additional Pay Fird | Wiew Al First'*' 1 of 4 B Last
“Earnings Code |01 @, General Credits [+ [=]
Effective Date Find | Wiewr Al First' &' 1 of1 "2 Last
Effective Date |01/02/1999 [ [+ [=]
Payment Details Find | Wiew Al First ‘4 1 af1 ‘*/ Last
‘Addl Seq Nbr 1 End Date El [+][=]
Rate Code @, Reason | Benefits Administration Credit v
Earnings F102.31
Hours Hourly Rate
Goal Amount Goal Balance
Sep Check Nin [ pisable Direct Deposit
OKto Pay ClProrate Additional Pay
Applies To Pay Periods
“IFirst M second I Third Fourth Fifth
Job Information
Tax Information

This example illustrates the fields and controls on the Additional Pay page (2 of 3).

Jab Infarmation
Employee Type
Compensation Rate

Default Job Data

Position
Business Unit
Department
Joh Code
Combination Code
GL Pay Type
Shift

Job Data Cwerride

Position
Business Unit
Department
Joh Code

Combination Code
GL Pay Type

Hourly
§1,000.000000

19000042
GBRIBU
54000
BEODZ0

Mot Applicable

Standard Hours  40.00
Frequency Biweekly

Global Business Institute BU)
Lah Facility
Murse-Registered-1CL

&

&

[Say SRy Sl 5

&

Edit ChartFields

*Addl Shift

Jse Job Shift

58

Copyright © 1988, 2026, Oracle and/or its affiliates.



Chapter 4

Setting Up Earnings Data

This example illustrates the fields and controls on the Additional Pay page (3 of 3).

Tax Information

State (}J
Tax Periods 1
Locality @

"Tax Method | Annualized
‘Tax Frequency | Use Pay Group Freguency
‘Benefit Deductions Taken | Mo Override
Benefit Ded Subset ID @,

‘General Deductions Taken | Mo Override

General Ded Subset 1D @

)

Specify a different department to charge for the additional pay. Change employee tax data for additional

pay.

Field or Control

Description

Addl Seq Nbr (additional sequence number)

Select / unless there are multiple additional pay records.

Earnings, Hours, andHourly Rate

Select to indicate whether additional pay is hours multiplied by
an hourly rate or a fixed amount, but not both.

If an hourly rate is indicated, but the field is left blank,
information is automatically populated from the employee's
job record.

Goal Amount

Select to have your payroll system stop issuing this additional
pay when the amount has been reached.

Applies to Pay Periods

Field or Control

Description

First, Second, Third, Fourth, andFifth

Select the appropriate options to indicate the pay periods in
which this additional pay should be identified in your payroll
system.

For example, if an employee were paid twice a month, but
received a monthly car allowance, you would select either
First or Second, but not both.

Job Data Override

Use the Job Data Override group box to change the department that is charged for the additional pay.
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Field or Control

Description

Position, Business Unit, Department, Job Code,
Combination Code, andGL Pay Type

Enter data in any of these fields to override the default value.

Addl Shift (additional pay shift)

Select Use Job to use the shift that is specified on the
employee's Job record.

Tax Information

Use the Tax Information group box to modify the employee's state and local tax data.

Field or Control

Description

State Select to enter the state that the employee worked in, if
different from the employee's regular pay. This field is
validated against the employee's state and local tax data.

Locality Select to enter the locality that the employee worked in,

if different from the employee's regular pay. This field is
validated against the employee's state and local tax data.

60
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Setting Up Deduction Data

Understanding Deductions

Payroll Interface recognizes two types of deductions: benefit deductions and general (non-benefit)
deductions. Benefit deductions are deductions that are associated with benefit programs, and include
deductions for health plans, life insurance plans, and other benefit plans. General deductions are
deductions that typically are not associated with benefits, and include deductions such as parking fees,
and union dues.

You can set up and maintain deductions using Payroll Interface and the Manage Base Benefits business
process in PeopleSoft HR; or, alternatively, you can have the third-party payroll system manage
deductions.

Note: To simplify data entry, conversion, and maintenance issues, you may want to have the third-
party payroll system manage deductions. Certain types of deductions, such as garnishments, are highly
confidential and are almost always maintained in the third-party payroll system.

Related Links

PeopleSoft Human Resources Manage Base Benefits

Setting Up the Deduction Table

To set up the Deduction Table, use the Deduction Table (DEDUCTION_TABLE) component.

Pages Used to Set Up the Deduction Table

Page Name Definition Name Usage

Deduction Table - Setup Page DEDUCTION TABLEI1 Set up deduction parameters.
Deduction Table - Tax Class Page DEDUCTION TABLE2 Set up deduction tax classifications.
Deduction Table - Process Page DEDUCTION TABLE4 Set up deduction processing.
Deduction Table - Schedule Page DEDUCTION TABLES Set up deduction schedules.
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Understanding the Deduction Table

The Deduction Table component enables you to select a plan type, enter a deduction code, and set up
the deduction processing rules that enable you to specify processing details such as deduction priorities,
deduction tax classifications, deduction pay period schedules, and other special payroll process indicators.

Whether you are setting up a benefit deduction or a general deduction, you begin with the Deduction
Table component. For example:

* To set up a medical deduction, you would (1) use the Deduction Table component to select a plan type
(Medical), enter a deduction code, and set up the deduction processing rules and (2) use components
in the Manage Base Benefits business process to set up the benefit plans, benefit programs, and other
deduction calculation parameters.

» Tosetupa50.00 USD general deduction for parking, you would (1) use the Deduction Table
component to select a plan type (General Deduction), enter a deduction code, and set up the deduction
processing rules and (2) use the General Deduction Table (GENL_DEDUCTION_TBL) component to
enter the dollar amount and other deduction calculation parameters.

The plan type that you select is critical in the deduction process because it indicates to the system whether
you are setting up a deduction code for a benefit deduction or a general deduction. It also indicates to

the system from which component, the Benefit Program Table (BEN_PROG_DEFN) component or the
General Deduction Table component, to retrieve the deduction calculation parameters.

This graphic illustrates the relationship between the Deduction Table component, benefit deductions, and
general deductions:

This diagram illustrates the relationship between the Deduction Table component, benefit deductions, and
general deductions.

Payroll Interface

Deduction Table Component
(set up deduction processing rules)

General Deductions

Benefit Deductions

Benefit Program Table Component General Deduction Table Component
(set up deduction calculation parameters) {set up deduction calculation parameters)

Human Resources

Manage Base Benefits Payroll Interface

Deduction Table - Setup Page
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Use the Deduction Table -Setup page (DEDUCTION_ TABLE1) to set up deduction parameters.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Setup
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This example illustrates the fields and controls on the Deduction Table - Setup page.

Setup Tax Class Tax Effect Frocess Schedule

Plan Type 00 General Deduction Deduction Code BOO-09
Deduction Information Find First'4 1 of1 '*/ Last
‘Effective Date 01/01/1 980 |[#] +][=]

‘Description | Credit Union
Short Description [T

Deduction Priority | 500

Special Processing bt Deduction Finid | Wiews All First'4 1 of1 P
Subset Last
‘Subset ID Description =+ [=]

MWaximum Arrears Payback @,

® No Maximum

O Flat Maximum for Payback |

O Factor x Regular Deduction I

Field or Control Description

Deduction Code Set up deduction codes that mirror the deduction codes in the
third-party payroll system.

Deduction Priority Not used by Payroll Interface; however, you can set up
deduction priorities that mirror the deduction priorities in the
third-party payroll system.

Note: The Maximum Arrears Payback group box and Deduction Subset group box are not used by
Payroll Interface.

Deduction Table - Tax Class Page

Use the Deduction Table - Tax Class page (DEDUCTION_TABLE?2) to set up deduction tax
classifications.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Tax
Class
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This example illustrates the fields and controls on the Deduction Table - Tax Class page.

Setup Tax Class Tax Effect Process Schedule

Plan Type 00 General Deduction
Deduction Code BOO-09 Credit Uniah
Deduction Information Find First ‘&' 1 of 1 ‘&' Last
Effective Date 01017189380 =]
Tax Classifications Find | Wigsw All First't' 1 0f1 '} Last
[+][=]
Deduction Classification Canadian Sales Tax
@ After-Tax @ None
O Before-Tax O Goods and Services Tax
O Nontaxable Benefit O Harmonized Sales Tax
O Nontaxable Btax Benefit O Provincial Sales Tax
O Taxable Benefit QO Provincial Sales Tax Insurance
O ac Taxable Benefit O Provincial Premium Tax
Special Accurnulatar(s) Find | Wiesw Al First 4 1 0f 12 Last
*Accumulator OJ ‘Effect on Special Balance | Adds to Special Balance v ﬂ j

Deduction Classification

Use this group box to select an appropriate tax classification for the deduction, including:
*  After-tax or before-tax for employee deductions.

*  Nontaxable benefit and nontaxable before-tax benefit for employer contributions.

A deduction can have more than one classification. However, it is still considered one deduction. For
example, a benefit deduction plan, such as 401(k), can have both before-tax and after-tax classifications
as well as a nontaxable classification for employer contributions.

Note: (USF) A retirement plan deduction, such as TSP benefit deductions, can have a before-tax and

a nontaxable classification for any employer contributions. Certain benefits, such as FEGLI, will have
an after-tax classification for the employee contribution. If your agency has a FEGLI plan that provides
coverage in an amount equal to three times your base salary of 40,000 USD a year, you pay for the after-
tax deduction.

Field or Control Description

After-Tax Select to reduce net pay. An example is a monthly parking
deduction.

Before-Tax Select to reduce net pay and taxable gross. An example is an
employee contribution to a retirement program, such as a 401
(k) plan.
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Field or Control

Description

Nontaxable Benefit

Select to represent an employer contribution (not subject to
federal tax) to an employee benefit plan, such as a health plan
or retirement plan. The contribution has no payroll effect.
The after-tax matching contribution for savings plans is a

nontaxable benefit.

Nontaxable Btax Benefit (nontaxable before-tax benefit)

Select to represent an employer contribution (not subject to
federal tax) to an employee benefit plan. Currently used only

for the before-tax matching contribution to savings plans.

Taxable Benefit

Select to represent an employer contribution (subject to federal
tax) to an employee benefit plan, such as life insurance. The
contribution increases federal withholding taxable gross

(for tax purposes) but does not increase total gross (for pay
purposes).

Deduction Table - Process Page

Use the Deduction Table - Process page (DEDUCTION_TABLE4) to set up deduction processing.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table >

Process

This example illustrates the fields and controls on the Deduction Table - Process page.

Setup || TaxClass || TaxEffect | Process || Schedule

Plan Type 00 General Deduction
Deduction Code BOO-09 Credit Union
Deduction Information
Effective Date 01/01/1980

Process Information

Deduction Classification After-Tax

Sales Tax None
Partial Deduction Allowed

Partial Deduction Allowed
Deduction Arrears Allowed
[Opeductions Taken From Sep Chk
O Stop Deduction at Termination

Maximum Yearly Deduction

Liability Accounts - Non Commitment Accounting 201600 2, Payroll Deductions

Find First' 4 1 0f 1/ Last
[+ [=]
Find | Wiew Al First ' *' 1 of1 "2 Last

[+ [=]
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Use this group box to define parameters for deductions during deduction processing.

Field or Control

Description

Partial Deduction Allowed

Not used by Payroll Interface.

Deduction Arrears Allowed

Not used by Payroll Interface.

Deductions Taken From Sep Chk (deductions taken from
separate check)

Not used by Payroll Interface.

Stop Deduction at Termination

For each deduction classification, select this option to stop
the deduction for a terminated employee. For example, most
health insurance plans are prepaid; premiums deducted for
the current month are used to provide coverage for the next
month. If an employee is terminated and no longer has health
benefits, the deduction should not be taken.

Liability Accounts - Non Commitment Accounting

Not used by Payroll Interface. However, you may enter
general ledger account numbers for your own information.

Deduction Table - Schedule Page

66

Use the Deduction Table - Schedule page (DEDUCTION TABLES) to set up deduction processing.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table >

Schedule
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This example illustrates the fields and controls on the Deduction Table - Schedule page.

Deduction Information

Effective Date 01011980
Deduction Schedule

-]

Deduction Frequency

)

Deduction Frequency

Setup Tax Class Tax Effect Process

Plan Type 00 General Deduction
Deduction Code BOO-09 Credit Lnion

Fird | Wiew Al First ‘4 1-z2af2 & Last

‘Pay Frequency |B T, Biweekly

First Pay Period Second Pay Period Third Pay Period
Fourth Pay Period Fifth Pay Period

‘Pay Frequency |5 2, Semimnthly

First Pay Period Second Pay Period
Fourth Pay Period Fifth Pay Period

Third Pay Period

Find First'*' 1 of 1 "B/ Last

[+][=]

[+][=]

Deduction Schedule

By default, deductions are taken out every pay period regardless of pay frequency. Use this group box if
you want a deduction to be taken out on a schedule other than every pay period.

Field or Control

Description

Pay Frequency

Select the pay frequency that you want to override for those
deductions that are not deducted every pay period. Values
prompt from the Frequency table: Annual, Biweekly, Daily,
Monthly, Quarterly, Semimonthly, and Weekly.

If you select a weekly frequency, you can select the Fifth Pay
Period option only if you have also selected the first, second,
third, and fourth pay period options. Likewise, if you select a
biweekly frequency, you can select only theThird Pay Period
option if you have also selected the first and second pay period
options.

Because a deduction with a monthly frequency is always
taken once a month, no override is available for a monthly
frequency. Suppose you have a semimonthly payroll, but a
health deduction should only come out of the last paycheck of
the month. In this case, you would select a pay frequency of

Semimonthly and take a deduction in the second pay period.
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Use this group box to specify the appropriate pay periods in which to take the deduction for the selected
pay frequency. You must insert a new row for every pay frequency for which you have a pay group

defined.

Field or Control

Description

First Pay Period through Fifth Pay Period

Select the appropriate pay periods that you want the deduction
to be taken in.

Viewing Benefit Deductions

To view benefit deductions, use the Benefit Program (BEN_PROG_DEFN) component.

Pages Used to View Benefit Deductions

Page Name

Definition Name

Usage

Benefit Program Page

BEN_PROG_DEFNI

View a benefit program.

Assign to Benefit Program Page

BEN PROG _PARTICPTN View the benefit programs in which an

employee is enrolled.

Understanding Benefit Deductions

68

Benefit deductions are set up using Payroll Interface and the Manage Base Benefits business process. To

set up benefit deductions:

1. Use the Deduction Table component in Payroll Interface to select the plan type (any plan type except
General Deduction), enter a deduction code, and set up the deduction processing rules.

See Setting Up the Deduction Table.

2. Use the Benefit Plan Table (BENEFIT PLAN TABLE) component and other components in the
Manage Base Benefits business process to set up benefit plans.

See “Defining Benefit Plans” (PeopleSoft Human Resources Manage Base Benefits).

3. Use the Benefit Program Table component and other components in the Manage Base Benefits
business process to build the benefit program and to define the deduction calculation parameters.

See “Understanding Benefit Programs” (PeopleSoft Human Resources Manage Base Benefits).

Benefit plans and programs are set up using the Manage Base Benefits business process; however, as a
convenience, two components are duplicated in Payroll Interface: the Benefit Program component and the
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Assign to Benefit Program component. You can use these components as quick references when testing
the interface definitions or trouble shooting deduction-related issues.

Calculating Benefit Deductions

Payroll Interface calculates pay period benefit deductions. When you run the Calculate Deductions and
Deduction Confirmation processes, the calculated benefit deduction amounts are written to the export file.
The third-party payroll system performs all gross-to-net-calculations.

See Calculating Deductions.

Benefit Program Page

Use the Benefit Program page (BEN PROG DEFNI1) to view a benefit program.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Benefit Program > Benefit Program

This example illustrates the fields and controls on the Benefit Program page.

Benefit Program || Plan Type and Option || Cost

Benefit Program k11
Effective Date 01/01/2005
‘Description (GBI S Fulltime Benefit Pgm

Short Description (GBI LUS FT
COBRA
COBRA Surcharge % | 2
COBRA Disabled Surcharge % | 50
COBRA Contact ID @,

FSA

Flexible Spending Acct RunID kU1 @ Fopa g

FSA Maximum Annual Pledge Tooo.oo

FrALA,

FMLA Plan ID |<UF Roll-Fwed

Status as of Effective Date | Active
Program Type Automated
Currency Code |USD |3,

Benefits Administration

Apply Excess Credits to |G |Gy Cash

Self-Serice Configuration

Show Credits on Enrollmnt Form
Onclude can Sales Tax on Form
Oshow Employer Costs on Form
O atert to Tax Impacts on Form

Cost Freq on Enrollment Form | Anhual Fregquency

Handbook URL I

Assign to Benefit Program Page

Use the Assign to Benefit Program page (BEN_PROG_PARTICPTN) to view the benefit programs in

which an employee is enrolled.

Navigation:

Payroll Interface > Assign to Benefit Program > Assign to Benefit Program
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This example illustrates the fields and controls on the Assign to Benefit Program page.

Assign to Benefit Program

Olivia Andrews Ernployee I B-BARET201 Benefit Record Number 0
Benefit Program Participation Find | Wigw Al First' £ 1 of1 '® Last
‘Effective Date |04/01/1987 |5 =+ [=]

‘Benefit Program B46 (@, BAS Retro Regression Currency Code USD

Setting Up and Maintaining General Deductions

To set up and maintain general deductions, use the Deduction Table (DEDUCTION_ TABLE) and General
Deduction Table (GENL DEDUCTION_TBL) components.

Pages Used to Set Up and Maintain General Deductions

Page Name Definition Name Usage

Deduction Table - Setup Page DEDUCTION TABLE1 Set up the plan type (00 — General
Deduction) and deduction code.

General Deduction Table Page GENL DEDUCTION TBL Set up a general deduction and define the
deduction calculation parameters.

For the matching entry on the Deduction
Table component, select the plan type
(00 — General Deduction).

General Deduction Page GENL_DED_DATA Assign a general deduction to an
employee.
Overriding General Deductions Page GENL DED OVERRIDE Override a general deduction that is

assigned to an employee.

Understanding General Deductions

General deductions are set up using Payroll Interface. To set up general deductions:
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1. Use the Deduction Table component to select the plan type (General Deduction), enter a deduction
code, and set up the deduction processing rules.

See Setting Up the Deduction Table.

2. Use the General Deduction Table component to set up the general deduction and to define the
deduction calculation parameters.

3. Use the General Deduction component to assign a general deduction to an employee.

4. Use the Override General Deductions component to override a general deduction assignment.

Exporting General Deductions

Payroll Interface does not calculate general deductions. However, when you run the Calculate Deductions
and Deduction Confirmation processes, general deductions are automatically processed and the general
deduction flat amounts are written to the export file along with the calculated benefit deduction amounts.
If you do not maintain benefit deductions (do not run the Calculate Deductions process), you can set up
and export general deduction amounts separately through the interface definition.

See Understanding Deduction Processing.

ction Table - Setup Page

Use the Deduction Table - Setup page (DEDUCTION_TABLE1) to set up the plan type (00 — General
Deduction) and deduction code.

Navigation:
Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Setup

This example illustrates the fields and controls on the Deduction Table - Setup page.

Setup || TaxClass | TaxEffect | Process || Schedule

Plan Type 00 General Deduction Deduction Code BOD-09
Deduction Information Find First ' * 1 0f1 ‘%' Last

‘Effective Date |01/01/1 980 |[5] +[=]
‘Description |Cradit Union
Short Description CL

Deduction Priority | 500

Special Processing = Deduction Find | Wiew All First'*' 1 of1 '}
Subset Last
‘Subset I Description +][=]
Maximum Arrears Payback @,

@ Mo Maximum

O Flat Maximum for Payback I
O Factor x Regular Deduction |
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Use the General Deduction Table page (GENL DEDUCTION_TBL) to set up a general deduction and

define the deduction calculation parameters.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Deductions > General Deduction

Table > General Deduction Table

This example illustrates the fields and controls on the

General Deduction Table page.

General Deduction Table
Deduction Code KCPARK  Parking

General Deduction

‘Effective Date 01/01/1980 |[5]

AP Payment Date Type | Check Date

[Loan Processing g {Canada)

‘Deduction Calculation Routine | Flat Arnount
Deduction Rate or %
Special Accumulator Code @,
Set ID |SHARE |@,
Vendor 1D |CANKCO0008 |G, Imperial Parking
Pay Mode |5 /@ pay at Specified Date

Cleen Admin Taxable Ben (Canada)

B Last

(+][=]

Find | Wi All First ‘4 1 of 1

b

Ol alow Upiate Via Self Service

Arnount Per Pay Period Find | Yiew Al First'* 1 af4d '*' Last
FlatiAdditional Amount $40.00 [+][=]
‘Pay Frequency |B @, Biweeky
Field or Control Description

Deduction Calculation Routine

Select to enter the deduction calculation routine. For Payroll
Interface, the only valid routines are Flat Amount and Special
Deduction Calculation.

If you select Flat Amount, enter the amount in the Flat/
Additional Amount field for each pay frequency that

your company uses. If the amount varies from employee

to employee, such as with United Way or other charitable
contributions, leave the Flat/Additional Amount field blank.
This information can be maintained at the employee level on
the General Deduction page.

If you use a deduction rate, you can also enter an amount to be
deducted. However, you need to indicate the amount here only
if it is the same for all employees within a pay frequency. If it
varies from employee to employee, you enter the amounts for
each employee on the General Deduction page.
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Field or Control

Description

Deduction Rate or %

Select to enter the deduction rate or percentage. This value can
be overridden at the employee level.

Pay Frequency

Select to add new rows as necessary. For example, to set up

a 50 USD per month parking deduction, you could create

two rows: one for a semimonthly pay frequency with 25.00
USD to be taken every pay period and the other for a monthly
pay frequency with 50 USD. (Note that when you select this
option, the Deduction Rate box is not available.)

For a deduction that varies by frequency, you must indicate
the amount to be taken each pay period for each frequency.
For the 50 USD per month parking deduction, you can

set up the deduction for the semimonthly pay group, SM1,
so that it applies only to the last pay period of the month.
Rather than taking out 25 USD each pay frequency, you
take the full 50 USD at the end of the month. To set this up,
you need to indicate both the frequency and amount. Set the
frequency as semimonthly and enter 50.00 USD. Indicate
which semimonthly period to take the deduction for SM1 on
the Deduction Table.

General Deduction Page

Use the General Deduction page (GENL DED DATA) to assign a general deduction to an employee.

Navigation:

Payroll Interface > Update Payroll Information > General Deduction > General Deduction

This example illustrates the fields and controls on the General Deduction page.

General Deduction

Arthuro Erickson

Company GBI Global Business Institute

General Deduction

‘Deduction Code |KCPARK 2, Parking

Deduction Details
‘Effective Date 12/03/2012 [#]
‘Calculation Routine | Default to Deduction Table
Deduction End Date El
Loan Interest %

Goal Amount

This data was last updated by COnline User

PersonID KLOOOG

First' &' 10f1 b Last

[+ [=]

Find | View Al

Find | Wigw Al First ‘4" 1 of1 ' Last
[ Take on all Payaroups +][=]

b Ded stopped by Self Serv User
Deduction Rate or %
Flat/Addl Amount

Current Goal Balance

Data last updated on 120372012
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Field or Control Description

Calculation Routine Select how a deduction is calculated for an employee. If you
do not make a selection, the deduction is calculated according
to the Deduction Table. These routines are identical to the
routines on the General Deduction Table. Choose from the
following:

Default to Deduction Table: Uses the calculation routine that
is specified on the Deduction Table. The Flat/Addl Amount
field and Deduction Rate or % field on this page are not used.
The system uses only values that are entered on the Deduction
Table.

Flat Amount: Establishes the deduction as a flat amount. Enter
the amount in the Flat/Addl Amount field, which is treated as
an amount per pay period. The Deduction Rate or % field is
not used.

Ded stopped by Self Serv User (deduction stopped by self- | Select when an employee has stopped a voluntary deduction
service user) through a self-service application.

Deduction End Date Select to specify when a deduction should no longer be taken.

Overriding General Deductions Page

Use the Override General Deductions page (GENL DED OVERRIDE) to override a general deduction
that is assigned to an employee.

Navigation:

Payroll Interface > Update Payroll Information > General Deduction Override > Override
General Deductions

This example illustrates the fields and controls on the Override General Deductions page.

Overricle General Deductions

Arthuro Erickson EMP I KU000G Empl Record 0
Company GBI Global Business Institute Pay Group KU3  US Semi-Monthly
Deduction Override Settings Find | Wiew Al First'*' 1 of1 %/ Last
Deduction Code KCPARK |3, Parking [+][=]
Deduction Taken In Arrears Payback

First Pay Period
Second Pay Period
Third Pay Period
Fourth Pay Period

Fifth Pay Period

O maximum

Maximum Amournt
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Understanding Tax Data

Payroll Interface does not calculate taxes. You use Payroll Interface to track and export changes to tax
data (primarily W4 withholding information) that occur during a pay period. The third-party payroll
system performs all gross-to-net calculations.

To set up tax information correctly, you must understand the data mappings between PeopleSoft HCM
and the third-party payroll system. You generally want to export some type of code or numeric value. If
an employee works for multiple companies, then you must set up tax data for each company.

Note: To simplify data entry, conversion, and maintenance issues, you may want to have the third-party
payroll system manage all tax information.

Tax Location Data

The Tax Location Table (TAX LOCATION_ TBL) component enables you to establish a tax location ID
and to identify the work states, provinces, and localities that are associated with each tax location.

Note: If you've selected the Automatic Employee Tax Data option on the “Product Specific Page”
(Application Fundamentals) of the Installation Table (INSTALLATION TBL) component, PeopleSoft
automatically sets up tax data for each work and resident state and locality of each of your employees.
Tax distribution records are created for the work state or locality if the tax location represents a single
state or locality.

Note that if the Use State Residence for Local option is selected, the system does not select the Resident
check box automatically on the newly added local tax data row when 1) an employee transfers to a
different work location in the same resident state, or 2) a new employment instance is added for a
different work location in the same resident state. Refer to the “Understanding Resident Locality in Local
Tax Data” (PeopleSoft Payroll for North America) section for more information.

Tax Distribution Data

Every employee must have at least one Tax Distribution record. The system automatically populates the
State, Province, and Locality fields from theTax Location field on the employee's Job Data record. The
state and locality codes come from the Tax Location table.

Employee Tax Data

You will use the Employee Tax Data pages to enter and maintain federal, state, and local tax data for each
of your employees.
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Note: If you've selected the Automatic Employee Tax Data option on the “Product Specific Page”
(Application Fundamentals) of the Installation Table component, PeopleSoft automatically sets up
employee tax and tax distribution data when an employee is hired, transfers to another company, or
changes jobs.

Note that if the Use State Residence for Local option is selected, the system does not select the Resident
check box automatically on the newly added local tax data row when 1) an employee transfers to a
different work location in the same resident state, or 2) a new employment instance is added for a
different work location in the same resident state. Refer to the “Understanding Resident Locality in Local
Tax Data” (PeopleSoft Payroll for North America) section for more information.

You can run SQR TAXO016, the Default Tax Data Report, to verify automatically created tax data. This
report tells you, within the date range that you specify, which employees have default data on their tax
records.

Related Links
PeopleSoft Payroll Interface Reports: A to Z

Setting Up Tax Location Data

To set up tax locations, use the Tax Location Table (TAX LOCATION_TBL) component.

Tax locations are discussed in the PeopleSoft HCM Application Fundamentals product documentation.

Related Links

“Defining Tax Locations” (Application Fundamentals)

(CAN) (USA) Setting Up Company Tax Data

To set up company tax data, use the Company State Tax Table (CO_STATE TAX TBL Company Local
Tax Table (COMP_LOCAL TAX TBL), and Company Tax Table CAN (CO_CAN_TAX TABLE)
components.

Company tax data is discussed in the PeopleSoft HCM Application Fundamentals product documentation.

Related Links

“(USA) Setting Up the Company State Tax Table” (Application Fundamentals)
“(USA) Setting Up the Company Local Tax Table” (Application Fundamentals)
“(CAN) Setting Up the Canadian Company Tax Table” (Application Fundamentals)

(CAN) (USA) Setting Up and Maintaining Tax Distribution Data

Use the Update Tax Distribution component in Payroll for North America to set up and maintain USA and
CAN tax distribution data.
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“Entering Tax Distribution Information” (PeopleSoft Payroll for North America)

Pages Used to Set Up and Maintain Tax Distribution Data (USA and CAN)

Page Name

Definition Name

Usage

Update Tax Distribution Page

TAX DISTRIBUTION

(USA) Set up and maintain, for salaried
or exempt hourly employees only, a
percentage for each U.S. state or locality
in which an employee consistently
works.

Update Tax Distribution Page

TAX_DIST CAN

(CAN) Enter the tax distribution
information for Canadian employees.

Update Tax Distribution Page

(USA, USF) Use the Update Tax Distribution page (TAX DISTRIBUTION) to set up and maintain,
for salaried or exempt hourly employees only, a percentage for each U.S. state or locality in which an

employee consistently works.

Navigation:

Payroll Interface > Update Payroll Information > Tax Distribution USA > Update Tax

Distribution

Payroll for North America > Employee Pay Data USA > Tax Information > Update Tax
Distribution > Update Tax Distribution

Payroll for North America > Employee Pay Data USF > Tax Information > Update Tax
Distribution > Update Tax Distribution

See the “Update Tax Distribution Page” (PeopleSoft Payroll for North America) for USA in Payroll for
North America product documentation.

Update Tax Distribution Page

(CAN) Use the Update Tax Distribution page (TAX DIST_CAN) to enter the tax distribution information

for Canadian employees.

Navigation:

Payroll Interface > Update Payroll Information > Tax Distribution CAN > Update Tax

Distribution

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Tax
Distribution > Update Tax Distribution
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Note: All fields on this page have the same functionality as the fields on the U.S. version of the page

except for the following fields.

See the “Update Tax Distribution Page” (PeopleSoft Payroll for North America) for CAN in Payroll for
North America product documentation.

Field or Control

Description

Province

Canada doesn't allow distribution to more than one province.

Select the province in which the employee works.

Percent of Distribution

Enter the tax distribution percentage for the province. For
Canadian payroll, the distribution percent must be /00 for a
single row. The default value is 700.

(USA) Setting Up and Maintaining U.S. Employee Tax Data

Use the Employee Tax Data USA component to maintain USA employee tax data.

Related Links

“(USA) Entering U.S. Employee Tax Data” (PeopleSoft Payroll for North America)

Pages Used to Set Up and Maintain U.S. Employee Tax Data

Page Name

Definition Name

Usage

Federal Tax Data Page TAX DATA1 Set up employee federal tax data.
State Tax Data Page TAX DATA3 Set up employee state tax data.
Local Tax Data Page TAX DATAS Set up tax data for each locality where an

employee works.

Federal Tax Data Page

(USA) Use the Federal Tax Data page (TAX DATA1) to set up employee federal tax data.

Navigation:

Payroll Interface > Update Payroll Information > Employee Tax Data USA > Federal Tax Data

Payroll for North America > Employee Pay Data USA > Tax Information > Update Employee

Tax Data > Federal Tax Data
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See the “Federal Tax Data Page” (PeopleSoft Payroll for North America) in the PeopleSoft Payroll for
North America product documentation.

State Tax Data Page
(USA) Use the State Tax Data page (TAX DATA3) to set up employee state tax data.
Navigation:
Payroll Interface > Update Payroll Information > Employee Tax Data USA > State Tax Data

Payroll for North America > Employee Pay Data USA > Tax Information > Update Employee
Tax Data > State Tax Data

See the “State Tax Data Page” (PeopleSoft Payroll for North America) in the PeopleSoft Payroll for North
America product documentation.

Local Tax Data Page

(USA) Use the Local Tax Data page (TAX DATAS) to set up tax data for each locality where an
employee works.

Navigation:
Payroll Interface > Update Payroll Information > Employee Tax Data USA > Local Tax Data

Payroll for North America > Employee Pay Data USA > Tax Information > Update Employee
Tax Data > Local Tax Data

See the “Local Tax Data Page” (PeopleSoft Payroll for North America) in the PeopleSoft Payroll for
North America product documentation.

(CAN) Setting Up and Maintaining Canadian Employee Tax Data

Use the Update Employee Tax Data component in Payroll for North America to set up and maintain CAN
employee tax data.

Related Links
“(CAN) Entering and Maintaining Canadian Income Tax Data” (PeopleSoft Payroll for North America)

Pages Used to Set Up and Maintain Canadian Employee Tax Data

Page Name Definition Name Usage
Canadian Income Tax Data Page TAX DATA CANI Set up Canadian income tax data.
Quebec Income Tax Data Page TAX DATA CAN3 Set up Quebec income tax data.
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Page Name Definition Name Usage

Provincial Income Tax Data Page TAX DATA CAN4 Set up provincial income tax data.

Canadian Income Tax Data Page

(CAN) Use the Canadian Income Tax Data page (TAX DATA CAN1) to set up Canadian Income Tax
(CIT), including specifying special CIT withholding status, TD1 exemptions and adjustments, and other
tax credits.

Navigation:

Payroll Interface > Update Payroll Information > Employee Tax Data CAN > Canadian Income
Tax Data

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Employee
Tax Data > Canadian Income Tax Data

See the “Canadian Income Tax Data Page” (PeopleSoft Payroll for North America) in the PeopleSoft
Payroll for North America product documentation.

Quebec Income Tax Data Page

(CAN) Use the Quebec Income Tax Data page (TAX DATA CAN3) to enter QIT withholding status,
exemption, and tax credit information for employees based in Quebec.

Navigation:

Payroll Interface > Update Payroll Information > Employee Tax Data CAN > Quebec Income
Tax Data

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Employee
Tax Data > Quebec Income Tax Data

See the “Quebec Income Tax Data Page” (PeopleSoft Payroll for North America) in the PeopleSoft
Payroll for North America product documentation.

Provincial Income Tax Data Page

80

(CAN) Use the Provincial Income Tax Data page (TAX DATA CAN4) to enter provincial TD1 personal
tax credit amounts.

Navigation:

Payroll Interface > Update Payroll Information > Employee Tax Data CAN > Provincial Income
Tax Data

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Employee
Tax Data > Provincial Income Tax Data
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See the “Provincial Income Tax Data Page” (PeopleSoft Payroll for North America) in the PeopleSoft
Payroll for North America product documentation.
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Understanding Payroll Schedules

To track and export changes that occur to employee-level payroll data, you run the Payroll Interface
processes at least once each pay period using the payroll schedules that you establish in PeopleSoft HCM.

Payroll schedules consist of pay groups and pay calendars. Pay groups tell the system which employees to
process. Pay calendars tell the system when to process these employees.

To enable payroll scheduling, perform these tasks:

1.

2.

3.

4.

Set up the pay groups.
Set up a balance ID—required for pay calendars.
Set up a pay run ID—required for pay calendars.

Set up the pay calendars.

Note: Set up your pay groups and pay calendars following the requirements of the third-party payroll
system. The payroll schedules that you use to run the Payroll Interface processes should coincide with the
payroll schedules that are used by the third-party payroll system.

Setting Up Pay Groups

To set up pay groups, use the Pay Group Table (PAYGROUP_ TABLE) component.

Pages Used to Set Up Pay Groups

Page Name Definition Name Usage

Pay Group Table - Definition Page PAYGROUP TABLEI Set up a pay group and its basic

characteristics. Enter the PI
configuration ID.

Process Control Page PAYGROUP_TABLE2 Set up process controls and establish

default employee types.

Calc Parameters Page PAYGROUP _TABLE3 Set up other processing parameters for

pay groups.
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Page Name

Definition Name

Usage

Paysheets Page

PAYGROUP_TABLE4

Set up the proration rules and paysheet
options for each pay group that you
establish. This page is used rarely by
Payroll Interface.

Check Distribution Page

PAYGROUP_TABLES

Set up the order in which you want to
sort paychecks and to select address and
delivery options. This page is used rarely
by Payroll Interface.

Check Sequencing Page

PAYGROUP TABLEG6

Set up print sequence options. This page
is used rarely by Payroll Interface.

Report Parameters Page

PAYGROUP_TABLE7

Define other report parameters for pay
groups. This page is used rarely by
Payroll Interface.

Bank/Tip Info Page (Bank/Tip
Information)

PAYGROUP TABLES

Set up the bank from which employees
are to be paid. Enter the source bank ID.

Time and Labor Page

PAYGROUP_TABLE9

This page is never used by Payroll
Interface.

Payroll Interface cannot process dynamic
time and labor data.

Understanding Pay Groups

Pay groups are set up using the Pay Group Table component. The PI Configuration ID field on the Pay
Group Table - Definition page is important for Payroll Interface. ThePI Configuration ID links your

PeopleSoft pay groups to the third-party payroll system.

Warning! 1f the PI Configuration ID is not set up correctly, the Payroll Interface processes will not

function properly.

See Setting Up the Configuration Table.

Additional information about pay groups is discussed in PeopleSoft HCM Application Fundamentals:

See “Setting Up Pay Groups” (Application Fundamentals).

Pay Group Table - Definition Page

Use the Pay Group Table - Definition page (PAYGROUP_TABLE1) to set up a pay group and its basic

characteristics.

Navigation:
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Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table >

Definition

This example illustrates the fields and controls on the Pay Group Table - Definition page.

Definition Process Control Calc Parameters

Glabal Business Institute
IS Monthly

Company GBI
Pay Group kL4

Pay Group Information
‘Effective Date |1 21262004 |[5]
‘Set ID SHARE |G,

‘Description |US Maonthly

Find First ‘4 1 of1 ‘B Last

‘Status | Active

Clretiree Pay Group

v | [#][=]

Short Description S Monthly PI Configuration ID @,
‘Country |USA |G USA Deduction Priority
Currency |USD 3 pallar
‘Employee Type Default | Salaried Freguency
‘Pay M D, MWonthly
‘Draily D @, Daily
GL Usze
Rate Type [OFFIC |3, ConvDate | |G Monthly |1 @ onthly
FPages1-3 Fages 4-6 PagesT-49
Field or Control Description

PI Configuration ID (Payroll Interface Configuration ID)

Select to enter the Payroll Interface configuration ID.

Warning! 1f the PI configuration ID is not set up correctly, the
Payroll Interface processes will not function properly.

Process Control Page

Use the Process Control page (PAYGROUP_TABLE2) to set up process controls and establish default

employee types.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Process

Control
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Definition Process Control Calc Parameters

Company GBI  Global Business Institute
Pay Group KU4 S Monthly
Pay Group Infarmation
Effective Date 12/26/2004
Continue With Errors

O continue With Errors
Error Pay End Date 1Zr|ni0||| Mane Chosen v|

Emplayee Type(s) for Pay Group

‘Employee Type | Excep Hrly v

M print Paysheets

O confirmation Required for Job Earnings on Paysheet

O confirmation Required for Partial Pay Peried on Paysheet
Fages1-3

FPages 4-6 FPages 7-49

Find First ‘4 1 of1 '»/ Last

Status Active [#H[=]
Processing Contral
Industry | Core v|
Industry Sector | Care vl

First' 4/ 1 of 2" Last
[#[=]

Find | Wiew All

Calc Parameters Page

86

Use the Calc Parameters (calculate parameters) page (PAYGROUP_TABLED3) to set up other processing

parameters for pay groups.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Calc

Parameters

This example illustrates the fields and controls on the Calc Parameters page.

Definition || Process Control || Cale Parameters

Company GBI  Glohal Business Institute

Pay Group KU4 LS Monthly

Pay Group Information

Effective Date 120262004
Earnings Program ID KU1 |Gy
Holiday Schedule |1KUJ01

Earnings

‘Regular Hours |REG (3,

"Overtime Hours |OTF |3

Fages1-3 Fages 4- 6 Pages 7-49

"Holiday [HOL |3,

Find First ' 1 of1 B Last

Status  Active

U5 Earnings Frogram
@, Us Holiday Schedule

Default Benefit Program KU1 |G,
Retro Pay Program ID KU1 (@

‘Regular Earnings REG @,

Retro Pay Trigger Program ID KU1 |3
Final Check Program ID KU1 |3,

FLSA Required FLSA Period Definition

(#][=]
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Bank/Tip Info Page

Use the Bank/Tip Info (Bank/Tip Information) page (PAYGROUP_TABLES) to set up the bank from

which employees are to be paid.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Pages 7—

9 > Bank/Tip Info

This example illustrates the fields and controls on the Bank/Tip Info page.

Report Parameters BankTip Info Time and Labor
Company GBI  Global Business Institute
Pay Group KL4 LIS Manthly
Pay Group Information Find First' 4" 1 af2 ' Last
[+][=]
Effective Date 127262004 Status  Active
Delay Withholding of Taxes
O Delay Withholding of Taxes Adjust to Minimum Wage
Min Wage Adjustment Earns Code TPA @ 5T - Tip Adjustment
Tip Credit Earnings Code TCR @ Tip Credit
Source Bank ID (K03 C)J West Armerica Bank
Direct Deposit Bank ID @,
Minimum Net Pay ‘Maximum Net Pay F10,000
Fages1-3 Fages 4 -6 Fages 7-9
Field or Control Description
Source Bank ID Select the bank from which employees in this pay group are to
be paid.

save the pay group, you must enter a value.

Note: This field is not used by Payroll Interface. However, to

Setti

Copyright

ng Up Balance IDs

To set up balance IDs, use the Balance ID Table (BALANCE ID TABLE) component.

See “Creating Balance IDs” (Application Fundamentals).
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Setting Up Pay Run IDs

To set up pay run IDs, use the Pay Run Table (PAY RUN_ TABLE) component.

See “Creating Pay Run IDs” (Application Fundamentals).

Setting Up Pay Calendars

To set up pay calendars, use the Pay Calendar Table (PAY CALENDAR_TABLE) component.

See “Creating Pay Calendars and FLSA Calendars” (Application Fundamentals).
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Cloning a Payroll Interface Definition

Understanding the Cloning Process

Rather than setting up an entirely new interface definition, it may be easier to begin an implementation by
cloning (copying) an existing interface definition, either a definition that you set up previously or one of
the sample data definitions that is delivered with Payroll Interface.

Pl Cloning Utility

The Payroll Interface control tables, sometimes referred to as the setup tables, are a set of 10 components
that you use to set up an interface definition.

To create a copy of an interface definition, you use the PI cloning Utility to clone five of these
components: PS Tables (PS_ TABLES), Field Definition Table (INTRFC_FIELD), Group
Table (INTRFC_GROUP), Instance Table (INTRFC_INSTANCE), and Definition Table
(INTRFC_DEFINITION).

It is not necessary to clone these five components: System Table (SYSTEM TABLE), Employee
Table (INTRFC_EMPLOYEE), Process Table (INTRFC_PROCESS), File Handle Table
(INTRFC_FILEHANDLE), and Configuration Table (INTRFC_CONFIG).

The PI Cloning Utility has two sub-utilities, the System ID Cloning Utility and the Interface Definition
Cloning Utility. This table lists which components and underlying tables each sub-utility clones:

PI Cloning Utility Component Underlying Tables

Use the PI Cloning Utility, System ID PS Tables + PI PS RECORD

Cloning Utility option to clone these

components and the underlying tables, + PIL_PSREC_FLD

which include the System ID field as a
PI PS REC LANG

key field.
Field Definition Table « PI FIELD TBL
PI FIELD LANG
+  PI FIELD XLAT
Group Table « PI GROUP_TBL

PI_GROUP_LANG
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PI Cloning Utility Component Underlying Tables

Instance Table + PI INSTANCE TBL

+ PI INSTANC _LANG

clone this component and the underlying
tables, which include the File ID as a
key field.

Use the PI Cloning Utility, Interface Definition Table + PI DEFN FILE
Definition Cloning Utility option to

- PI DEFN F LANG
Pl DEFN_RECORD
.«  PI_DEFN_R_LANG

«  PI_DEFN_FIELD

Cloning Procedure

Use the P.I. Cloning Utility Application Engine process (PI_ CLONE) to clone an existing interface
definition. The steps that you must perform before and after running the utility are outlined here.

To clone an interface definition:

1.

2.

Set up a system ID for the new interface definition using the System Table component.
Set up the file handles using the File Handle Table component.

For each file ID you will clone in step 3, create a file handle.

Clone the existing interface definition using the P.I. Cloning Utility process.

Update the file definitions using the Definition Table component.

For each file ID that you cloned in step 3, enter the system ID that you created in step 1.
Set up a configuration ID using the Configuration Table component.

Enter the system ID that you created in step 1, the file handles that you created in step 2, and the file
IDs that the cloning process created in step 3.

See PeopleTools: Process Scheduler.

After you have performed these steps, you can manually configure the interface definition following the
requirements of the third-party payroll system.

See:

90

Understanding the Control Tables

Working with Interface Definitions
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Things to Consider

Verify the system ID after you have cloned the components. You may need to manually change the
System ID field in the Definition Table component - Interface Definition File page (this is step 4 in the
cloning procedure).

Verify the process IDs after you have cloned the components. Some processes may be specific to certain
file types. For example, if you are cloning from a logical (LOG) file type to a comma-separated value
(CSV) file type, then you don't want to retain Process ID = 00001 in the Deduction record definition.

Long description fields in the PS Tables component and in the Definition Table component - Interface
Definition Record page become blank on the cloned records.

The PI EMPLID TBL table maps the PeopleSoft EMPLID to the third-party payroll system

employee ID. When the Export process is run, every employee is assigned a row in this table. If the

PI EMPLID_TBL table contains data, you must delete it before running the Export process with the new
(cloned) interface definition. If you do not delete the data, you will get a "duplicate rows" error message
when you run the Export process.

Note: The PI EMPLID TBL table contains five fields: EMPLID, EMPL RCD, EFFEDT,
PI SYSTEM ID, and PI EMPLID. To delete the data from this table, use this SQL statement: DELETE
FROM PI_EMPLID_TBL.

See Deduction Processing

Clon

ing an Interface Definition

Pages Used to Clone an Interface Definition

Page Name Definition Name Usage

Clone Payroll Interface Page PI_ RUNCTL_SID PNL Select the cloning options and run

the P.I. Cloning Utility Application
Engine process (PI_CLONE) to copy an
interface definition.

Clone Payroll Interface Page

Copyright

Use the Clone Payroll Interface page (PI RUNCTL SID PNL) to select the cloning options and run the
PI. Cloning Utility Application Engine process (PI_CLONE) to copy an interface definition.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Clone Payroll
Interface > Clone Payroll Interface
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This example illustrates the fields and controls on the Clone Payroll Interface page.

Clone Payroll Interface
Fun Control I PSS Report Manager Frocess Manitar Fun

Clone System 1D

From Sys IV S5V To Sys 1D |NTS
[Ips Tables
Field Table
Group Table
Instance Table
Clone Interface Definition

From File 1D | C 5% To File ID MNTSH

Clone System ID

Use the System ID Cloning Utility to copy the PS Tables, Field Table, Group Table, and Instance Table

components and system IDs.

Field or Control

Description

Clone from Sys ID (clone from system ID)

Select the system ID of the interface definition that you want

to copy (the existing interface definition).

Clone to Sys ID (clone to system ID)

Select the system ID of the interface definition that you want

to create (the new interface definition).

Note: You must set up the system ID using the System Table
component before you can enter it here.

See Setting Up the System Table.

PS Tables, Field Table, Group Table, and Instance Table

Select the components that you want to copy.

Clone Interface Definition

Use the Interface Definition Cloning Utility to copy the Definition Table component and file IDs.
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Field or Control Description

Clone from File ID Select the file ID of the export or import file that you want to
copy.

Clone to File ID Select the file ID of the export or import file that you want to
create.

Note: If you are copying more than one file ID (for example, the CSV sample data set includes four
export files), set up and run the Interface Definition Cloning Utility separately for each file ID.
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Setting Up a Payroll Interface Definition

(Part 1)

Understanding the Control Tables

The Payroll Interface control tables, sometimes referred to as the setup tables, are a set of 10 components
that you use to set up the export and import interface definitions. As shown in the following table, the
components can be organized into four general usage groups. Although some dependencies exist, all 10
components work together and, for the most part, can be set up in any order.

Usage

Component

Use these components to identify the third-party payroll
system and the employees who will be processed each pay
period.

*  System Table (SYSTEM_TABLE) component

*  Employee Table INTRFC_EMPLOYEE) component

Use these components to identify the PeopleSoft HCM tables
and fields that store the payroll-related data, and to define the
file and data formatting.

*  PS Tables (PS_TABLES) component
»  Field Definition Table INTRFC_FIELD) component

*  Definition Table INTRFC_DEFINITION) component

Use these components to set up additional processing for the
payroll-related data. The processing can be simple (grouping
fields) or more complex (invoking special COBOL routines).

*  Group Table (INTRFC_GROUP) component
+ Instance Table (INTRFC_INSTANCE) component

»  Process Table INTRFC_PROCESS) component

Use these components to identify the export or import files and
to connect the PeopleSoft HCM pay groups to the third-party
payroll system for processing.

File Handle Table (INTRFC_FILEHANDLE) component

*  Configuration Table (INTRFC_CONFIG) component

Note: Beginning an implementation is often easier if you clone (copy) an existing interface definition.
After you have created the clone, you can use the control tables to further configure the export or import

interface definition.

Related Links
Cloning an Interface Definition
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Common Elements Used in Working with Control Tables

Field or Control Description
Null Blank Character Flds (null blank character fields), Select to indicate whether blank and zero PeopleSoft character
andNull Zero Numeric Flds (null zero numeric fields) fields should be written to the export file as null data. Null

implies no data value for the field. You can override this
option at the field level.

Convert Case Select if the system requires uppercase.

Note: You can override this setting for specific files.

Setting Up the System Table

To set up the System Table, use the System Table (SYSTEM_TABLE) component.

Pages Used to Set Up the System Table

Page Name Definition Name Usage
Interface System Table 1 Page PI_ SYSTEM_PNL Set up system IDs.
Interface System Table 2 Page PI_ SYSTEMI1 PNL Set up payroll statuses.

Understanding the System Table
Use the System Table to set up a system ID that identifies the third-party payroll system.

Payroll Interface delivers several system IDs, including CSV, PHY, LOG, and NFC. These system IDs
correspond to these delivered data formats: comma-separated-values, physical, logical, and National
Finance Center. You can use the delivered system IDs or create your own.

You can use multiple system IDs to set up interface definitions for multiple third-party payroll providers.
The system IDs separate the information required for each third-party implementation.

Related Links

Sample Data Definitions

Interface System Table 1 Page

Use the Interface System Table 1 page (PI SYSTEM_PNL) to set up system IDs.

Navigation:
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Set Up HCM > Product Related > Payroll Interface > Interface Controls > System Table >

Interface System Table 1

This example illustrates the fields and controls on the Interface System Table 1 page.

‘Description Physical File Format

Interface System Table 1 Interface Systern Table 2
System ID PHY
Definition
‘Effective Date (010111950 |5 *Status

‘System Code | Other

*Export | Records with Field Changes

‘Convert | Using Interface Employes Table

‘Employee Field ID EMPLID

Export Dest | External File

‘Character Set |ASCI

“File Type | Physical

Logical File Type

External Field ID Indicator
Field I Length (in bytes) I

Fird | iew Al First &' 1 of 1 ‘' Last
Short Desc Physical ﬂ ﬂ
Version
‘Eifect Date Transaction Ind ‘ Current v|
‘Process Filter | Mo Filtering v|
Oconvert case
Delimiter File Types
Data Delimiter I_ Include Header

Literal String Character I_

Endl Last Field with Delimiter Mull Zero Numeric Flds

Remove Trailing Spaces
Null Blank Character Flds

Field or Control

Description

System ID

Select to enter a system ID that identifies the third-party
payroll system. You can use one of the system IDs delivered
with Payroll Interface (CSV, LOG, NFC, PHY, and so on) or
you can define your own.

System Code

Select the appropriate system code.
*  ADP Interface: ADP third-party payroll system.

*  Other: Third-party payroll system other than ADP.

Version

For documentation only. Payroll Interface does not use this
value.

Export

Select to indicate how data changes are exported.
*  Field Change Only: Export only fields with changed data.

*  Record With Field Changes: Export entire records, but
only those with fields that have changed.

Note: The physical file format (PHY) does not export field
changes only. The entire row is exported if a defined field
changes.
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Field or Control

Description

Convert

Select to indicate how employees are identified by the third-
party payroll system.

»  Using Interface Employee Table: Converts the PeopleSoft
EMPLID to the third-party payroll system employee ID
(PI EmplID).

Note: If you select this option, you must map the
PeopleSoft EMPLID to the third-party payroll system
employee ID (populate the PI EMPLID TBL table) for
each employee before you run the Export process. If you
do not do this, the system will issue an error message.
Perform the mapping by either (1) manually entering the
third-party payroll system employee ID in the Employee
Table - Interface Employee Table page, PI Emplid field
or (2) using PeopleCode to automate the process, when
possible. You must update the mapping when employee
changes occur, for example, new hires or terminations.

»  Using PeopleSoft Employee ID: Automatically inserts
the PeopleSoft EmplID in the Employee Table - Interface
Employee Table page,PI Emplid field (and populates PI
EMPLID_TBL) when you run the Export process.

*  Using National ID: Automatically inserts an applicable
national identification code (for example, the employee's
Social Security Number or Social Insurance Number)
in the Employee Table component - Interface Employee
Table page,PI Emplid field (and populates the P1
EMPLID_TBL table) when you run the Export process.

Employee Field ID

Select to indicate which Payroll Interface field contains the
employee ID. The value of the employee field ID is defined
on the Field Definition Table component - Interface Field2
page. Because of the three convert options, the field that you
select as the employee field ID does not need any PS Record/
PS fields mapped to it on the Interface Field2 page.
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Field or Control

Description

Effect Date Transaction Ind (effective date transaction
indicator)

Select Current to export only data that's current at the end of
the pay period; select A// to export both current and retroactive
data.

Note: Be sure to verify that your payroll vendor's import
utility accepts multiple effective-dated transactions.

The effective date indicator performs two main functions:

*  Selecting employees for processing: If you choose A//,
all employees who have ever been in the pay group
being processed are eligible for processing. If you choose
Current, only those employees who were in the pay group
during the pay period are eligible for processing.

*  Retrieving employee data: If you select A//, the meaning
of the value A/ Effdts (all effective dates) in the Where
Clause Type field on the PS Tables page literally means
all effective dates. If you choose Current, then All Effdts
on the PS Tables page refers to all effective dates that are
effective during the pay period.

Process Filter

Select to indicate whether the system should process records
with a company value that is different from the process
company.

*  None: All rows that are created by Payroll Interface for
each company and pay group combination are inserted
into the PI PARTIC_EXPT table and are available for
export. The last history rows that are created for the
current system ID are retrieved for comparison.

*  Company: If you define a key field of Company on the
Definition Table component - Interface Definition Fields
page, this field is compared to the process company. The
system exports only records with a matching company.

For comparison, the system retrieves the last history rows
that were created for the current system ID and company.

See Working with Company Filtering.

Character Set

Select to enter the appropriate character set for the language
that is used in the export or import file.

Note: The Import process recognizes only the ASCII character
set.

See Working with Character Sets.
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Field or Control

Description

File Type

Select a file type:

CSV (comma-separated value): Data is delimited, or
separated, by commas.

Logical: Data is defined using an identifier followed

by its value, not fixed format. For example, the field
identifier of 1X2 might always immediately precede a
value of 1 or 2 to indicate tax status. The field identifier
is defined by your third-party payroll system and must
exactly match the field identifier that is defined in Payroll
Interface. If you use a logical file, select External Field
ID Indicator and enter the field length.

Other Delm (other delimited): Data is delimited by the
character that you specify in theData Delimiter field.

Note: A delimited data file can contain only one Payroll
Interface record definition of the data type. You can

have two record definitions only for a Stop Transaction
record. Common examples are deductions, savings plans,
additional pay, and direct deposit.

Numeric values cannot contain the thousands edit
characters. For example: 1,100,100 appears in both the
import and export files as 1100100. The system does
support a display character for the decimal place, for
example, 100.50 or 100,50.

Physical: Data is defined by its position in the file. For
example, a value of 1 or 2 in the 30th character position
in the file might represent tax status. In such files, blank
characters are often inserted to maintain positional
integrity when a data value is not available to take that
position.

Tab Delm (tab delimited): Data is delimited by the Tab
character.

Logical File Type and Delimiter File Types

Use the options in the Logical File Type group box and Delimiter File Types group box to further define

the export file.

Copyright © 1988, 2026, Oracle and/or its affiliates.



Chapter 9

Setting Up a Payroll Interface Definition (Part 1)

Field or Control

Description

Literal String Character

If the decimal character is the same as the delimiter character,
it must be enclosed in the literal string character. This applies
to both export and import files. For example, if the decimal
character is a comma, and the file type is CSV, all numeric
values that contain decimals must be enclosed by the literal
string character: "100,50" for example.

In an export file, all character values must be enclosed by
the literal string character. A sample record might be: 1235,
"abcd","ef gh", "Last Name, First Name".

When data values contain the literal string character, the

single character is repeated within the data value when it

is written to the export file. During the import process, the
system examines the data value for two literal string characters
together and changes them to just one. For example, a data
value from the database is Suite 200, Unit "A" West. The data
value is written to the export file as "Suite 200, Unit ""A""
West". The import process interprets the export data string and
loads it into the database as: Suite 200, Unit "A" West.

Remove Trailing Spaces

You can override this selection at the field level.

Include Header

For delimited file types, select to indicate whether a header
record is the first record. When this option is selected for
export files, a header is written as the first record in the file.
The header name is the external column name for each field
on the record. When this option is selected for input files, the
header record is compared to the record definition. If they do
not match, the system stops processing for that file.

Interface System Table 2 Page

Use the Interface System Table 2 page (PI_ SYSTEM1 PNL) to set up payroll statuses.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > System Table >

Interface System Table 2
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This example illustrates the fields and controls on the Interface System Table 2 page.

Interface System Takle 1

System Il PHY
Active Employees for Export Find | Wiew All First'4' 1 of1 "2 Last
Effective Date 01/01/1980 [+][=]

Description Physical File Format

Interface System Tahle 2

Payrall Perzonalize | Find | view al | 2 | E First'* 1 afq

otatuses Lagt
Payroll Status

|Active h [#] [=]

Payroll Statuses

Field or Control

Description

Payroll Status

Select the pay statuses of the employees to process. This
setting directly corresponds to the Selecting Active
Employees check box on the Payroll Interface Run Control

page.

Note: Employee payroll status is assigned in Job data.

Note: Payroll Interface processes only the current row if more
than one effective sequence exists for a particular date.

Setting Up the Employee Table

102

To set up the Employee Table, use the Employee Table (INTRFC_EMPLOYEE) component.
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Page Name Definition Name

Usage

Interface Employee Table Page

PI_EMPLID_PNL

Set up employee IDs when the third-
party payroll system employee IDs are
independent of the PeopleSoft EMPLID.

Understanding the Employee Table

Use the Employee Table component to determine how your employees are identified in the third-party

payroll system.

You can export data from any table or view in PeopleSoft HCM,

as long as the record includes the

PeopleSoft EmplID. To identify employees in a third-party payroll system, you can use the PeopleSoft
and map the PeopleSoft EmplID to a third-party employee ID (PI EmplID) or some other unique

identifier such as a Social Security Number.

Related Links
Deduction Processing and Multiple Jobs
Export Processing and Multiple Jobs

Interface Employee Table Page

Use the Interface Employee Table page (PI_ EMPLID_PNL) to set up employee IDs when the third-party
payroll system employee IDs are independent of the PeopleSoft EMPLID.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Employee
Table > Interface Employee Table

This example illustrates the fields and controls on the Interface Employee Table page.

Interface Employee Table
}"T"I_i!l_i_:'_r!"__ﬁ':":'f'_s_ EnP D KILN011 EmplRecord 0
Payrall Interface Employee 1D Find | view Al First ‘&' 1 0f1 P Last
‘Effective Date |12/04/2012 |[5] ] [=]
‘System D |PHY @, Ppysical File Format
P1 Emplid k11011
Field or Control Description

System ID

Select the System ID for the third-party payroll system.
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Field or Control Description

PI Emplid (Payroll Interface employee ID) Enter the ID that uniquely identifies your employees to the
third-party payroll system.

Note: The value of the PI Emplid field can be the third-party
payroll system employee 1D, the PeopleSoft EMPLID, or

a national identifier such as the employee's Social Security
Number. The option that you select for the System Table -
Interface System Table 1 page,Convert field determines how
thePI Emplid field is populated.

See Setting Up the System Table.

Setting Up the PS Tables

To set up the PS Tables, use the PS Tables (PS_ TABLES) component.

Pages Used to Set Up the PS Tables

Page Name Definition Name Usage
PS Tables Page PI_ PSREC PNL Select PeopleSoft tables and fields that

contain employee payroll-related data.
Data is extracted from these tables and
fields during the Export process.

PeopleSoft Field Inquiry PI_PSFLD INQ View attributes for a selected field.

Understanding the PS Tables

Use the PS Tables component to identify the PeopleSoft HCM tables and fields that contain the data that
will be exported to the third-party payroll system or used during the Export process.

You can export data from any table or view in PeopleSoft HCM, as long as the record includes the
PeopleSoft EMPLID field. The system uses the parameters on the PS Tables page to construct the SQL
select statements.

Note: Any field that is identified in the PS Tables component can be added to the Field Definition
component. Any field that is defined in the Field Definition Table component can be added to the
Definition Table component.

PS Tables Page

Use the PS Tables (PeopleSoft Tables) page (PI PSREC PNL) to select PeopleSoft tables and fields that
contain employee payroll-related data.

104 Copyright © 1988, 2026, Oracle and/or its affiliates.



Chapter 9

Navigation:
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Set Up HCM > Product Related > Payroll Interface > Interface Controls > PS Tables > PS

Tables

This example illustrates the fields and controls on the PS Tables page.

PS Tables
Details Find | Wigs Al Firgt ‘&' 10f1 2 Last
System ID PHY Physical File Format (=]
Record (Table) Name ADDL_PAY_DATA
Description |PeopleSoft Addition Pay Data EL

‘Process Type | Export

[Oped calc Data

Field Details
Field Attribute -
Button Field Hamie
Field Attribute
Buttan ACCT_CD @,
Field Attribute
Button ADDLPAY_REASON @,

Field Attribute

Button ADDL_PAY_FREQUENCY @

vl
‘Where Clause Type | 10, All EffDts | Active EffSeq v|
O Paygroup Company in Where Opata Required
O Paygroup Country in Where [J.Job Data

Perzanalize | Find | Viewal | B B First © 1-30r36 1 Last

Orker Collate Order Ife_\«' Effective Date Effective Sequence

by Field
O O O [+ [=]
O O O [+ [=]
O O O [+ [=]

Data is extracted from these tables and fields during the Export process.

Field or Control

Description

System ID

The system ID for the third-party payroll system.

Process Type

Select to indicate which Payroll Interface process to perform
with the table or view.
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Field or Control

Description

Where Clause Type

Select to indicate which type of SQL Where clause to
construct when retrieving the data from the database:

*  EmplID: Employee ID only.

*  ID and Active Effdt: Employee ID and the active effective
date as of the pay end date.

» ID, Active Effdt, Active EffSeq: Employee ID, the active
effective date, and the latest effective sequence as of the
pay end date.

» ID, All Effdts, Active EffSeq: Employee 1D, all effective-
dated rows that fall between the pay-begin date, the pay-
end date (non-retroactive processing), and the latest
effective sequence for each effective date.

» ID, All Effdts: Employee ID and all the effective-dated
rows that fall between the pay-begin date and the pay-end
date (non-retroactive processing).

* ID, Effdt=Pay End Dt: Employee ID and effective date
equal the pay end date.

To become more familiar with the differences between these
Where clause types, try them out using PeopleSoft Query.

See PeopleTools: PeopleSoft Query

Note: If you select Import in theProcess Type field, this field
is not available.

Paygroup Company in Where

Select to indicate whether the Where clause for retrieving
data from this PeopleSoft table should include a test on

the Company field. When this check box is selected, the
system compares the Company field in the record against the
Company field in the employee's job data.

Select this check box when an employee could have more
than one entry in the PeopleSoft table that could be uniquely
identified by the Company field. An example of this is the
employee's tax data.

Paygroup Country in Where

Select to indicate whether the Where clause for retrieving data
for this PeopleSoft table should include a test on the Country
field. When this check box is selected, the system compares
the Country field in the record against the Country field from
the company/pay group to which the employee belongs. The
company/pay group is based on the employee's job data.

Select this check box when an employee could have more
than one entry in the PeopleSoft table that could be uniquely
identified by the Country field. An example of this is the
employee's national ID data.
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Field or Control

Description

Ded Calc Data (deduction calculation data)

Select to indicate that one or more fields listed for this table or
view comes from the PI DED CALC table. When you run the
Export process with a run control defined to exclude DedCalc,
the system excludes any record for which this check box is
selected.

When the PS record table name is PI. DED CALC, this check
box is always selected.

Data Required

Select to indicate that a row of data must be returned from the
database for this table, but not that every field that is defined
for this record must contain data.

If a row of data is not returned for this record, the system
issues an error message, and no data for the employee is
written to the export file.

Job Data

Select if the record contains COMPANY, PAYGROUP, or
ACTION.

If the PS record table name is JOB, this check box is always
selected.

Field Details

Use the Field Details group box to define field attributes.

Note: You should enter Order by (sequence) values for all key fields. The EFFDT and EFFSEQ fields
must be in descending order (Collate Order Desc). All other fields should be in ascending order (Collate

Order Asc).

Field or Control

Description

Order by

Select to indicate the sequence in which the field should be
processed. A number from zero (blank) to 99 represents the
sequence of the field in the ORDER BY clause of the SQL
select statement.
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Field or Control

Description

Collate Order

This field is applicable only when the value for the Order
by field is greater than zero. Select to indicate the sequence
order of the field in the ORDER BY clause of the SQL select
statement. (If the value of theOrder by field is zero or not
specified, the collate order is none by default.)

Asc: Ascending order. Sequences data from lowest to highest.
This is the default value for all fields.

Desc: Descending order. Sequences data from highest to

lowest.

Note: The EFFDT and EFFSEQ fields must be in descending
order.

See Working with Key Fields.

Key Field

This check box is automatically selected if the field is defined
in PeopleSoft Application Designer as a key for a PS record.

You must manually select this check box for views.

Effective Date

Only one field can be the Effective Date field. The system
uses theEffective Date field name in constructing the Where
clause of the SQL select statement when the SELECT _
WHERE TYPE includes the effective date.

The Effective Date field for the DED CALC Table isPay End
Date.

Effective Sequence

Only one field can be marked as the Effective Date sequence
number. The system uses the effective date sequence number
in constructing the Where clause of the SQL select statement
when the SELECT_WHERE_TYPE includes the Effective
Date sequence field.

This field is used with the JOB record and any other records
with both an effective date and effective sequence.

Field Attribute

Select to view the PeopleSoft Field Inquiry secondary page.

Setting Up the Field Definition Table

To set up the Field Definition Table, use the Field Definition Table (INTRFC FIELD) component.
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Pages Used to Set Up the Field Definition Table

Page Name

Definition Name

Usage

Interface Fieldl Page

PI_FIELDI_PNL

Set up third-party payroll system fields.

Interface Field2 Page

PI_FIELD2 PNL

Set up corresponding PeopleSoft fields.

Understanding the Field Definition Table

Use the Field Definition Table component to define the data type and format of the fields that appear
in the export file. Any field that is identified in the PS Tables component can be added to the Field

Definition component.

Note: The Field Definition Table component and the Definition Table component contain effective-
dated entries. You must keep these components synchronized. Be sure that future-dated rows in the Field
Definition Table component are not referenced in the Definition Table component before their effective
dates. Also, if you mark a field inactive in the Field Definition Table component, be sure that the field is
no longer included in the Definition Table component.

See Working with Key Fields.

Interface Field1 Page

Use the Interface Field1 page (PI_ FIELD1 PNL) to set up third-party payroll system fields.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition

Table > Interface Fieldl

This example illustrates the fields and controls on the Interface Field1l page.

Interface Field1 Interface Field2

System ID 5V CEY Sample Layout
Field Definition
‘Effective Date 01/01/1980 |[5]

Description Deduction Code

External Field ID D001

‘Type | Character
External Column Name Deduction Code

Field Farmat
*Field Length {in bytes)

=]

Integer Length
Sign Position

Justification | Left
Date Format

Decimal Length l_

Round Decimal

Null Blank Character Flds

Field ID D001
Find | Wiew All
‘Status | Active -
Short Desc |Ded Cd
Process Type | Export hd
Text
Default Value 77
Display Decimal
Blank If Zero
Negative [ [ luse Positive Sign
Pad Character I_

Remove Trailing Spaces
Null Zero Numeric Flds

First 4/ 1 of 1 2/ Last

=
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Field Definition

Field or Control Description

Process Type Select the Payroll Interface process.

Note: Exp/Imp (export/import) can be used as the process type
only if the characteristics of the field are the same for both
import and export. Otherwise, you need to set up records for
each process type. The Employee ID field is the only field that
is mapped as both an export and import type; you do not need
to define a PS record or field name for it.

External Field ID If the System Table - Interface System Table 1 page, External
Field ID Indicator option is selected, the external field ID
becomes by default the value that you enter here. The external
field ID can be up to 10 characters.
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Field or Control

Description

Type

Select from the following options:
*  Character

Use the Justification field to specify whether characters
are left or right justified.

Note: When you are mapping from a large field to a
smaller field, the results are truncated. For example, if
you map '0123456789' from a 10-character field to a 7-
character field, the result is '0123456'.

*  Date

Use the Date Format field to specify the third-party
payroll system's date format.

e Number

Use the Display Decimal andDecimal Char (decimal
character) fields to specify a decimal separator.

o Signed

Use the Sign Position field to select the placement of the
sign for signed numerical fields.

e Value

Select to specify a predefined data item for the Text field.
For example, with thePay Run ID field, enter Pay Run
ID as the text. (Including Pay Run ID in the header record
may help ensure that the correct file is processed.)

If using the company filtering feature, use the Processing
Company or Processing Pay Group values for the Text
field.

See Working with Company Filtering.

Text

Select to enter a translate value.

Note: This field is active only if you have selected Value in
theType field.

See Working with Text Translate Values.
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Field or Control

Description

External Column Name

Select to enter a name of up to 50 characters if the Interface
field is used in a delimited data file structure with a header.
The system uses this name to construct the header record.

Default Value

If you use constant in the Text field, the value that you enter
here is used.

You can also use a default value for the character type. For
example, if the field is part of a header record, you can specify
some fixed text as the default value.

Field Format

Use the options in the Field Format group box to define the file's field formats.

Field or Control

Description

Field Length (in bytes)

For physical file formats, the length determines where the
field will be positioned. When you are setting up the Interface
Definition Fields page, you can view the exact character
position of the field.

Integer Length

The system calculates the integer length to verify that you
have set up a numeric field as intended.

For a signed field type, the system subtracts one position from
the integer length to allow for the sign. Use Sign Position to
specify where the sign goes.

Blank if Zero

This field is active only for number or signed field types.
Select if the payroll system uses blanks in place of zeros.

Interface Field2 Page

Use the Interface Field2 page (PI_FIELD2 PNL) to set up corresponding PeopleSoft fields.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition

Table > Interface Field2
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This example illustrates the fields and controls on the Interface Field2 page.

Interface Field1 Interface Field2
SystemID C3SY  CEY Sample Layout Field ID D001
Field Definition Find | Wiew Al First' 4/ 1 af1 '} Last
Effective Date 01/01/1980 Description Deduction Code +][=]
PS Record Name DED_CALC @, Process D 000005 |3, 14z chr
PS Field1 Name DECCD @, PS Field2 Name DED_CLASS @,
PS Field3 Name @, Pl Translate Indicator | Translate or Use DefaultValue v
Instance ID @,
Translate Values Personalize | Find | viewal | B First 0 1.2074 2 Last
'PS Value 1 PS Value 2 PS Value 3 Pl Value
KUDEMS B D1 [+ [=]
KUHMOK B 1 [+ [=]
Field Definition
Field or Control Description

PS Record Name and PS Field1 Name, PS Field2 Name, PS
Field3 Name

Select the PeopleSoft record and field names that correspond
to the third-party payroll system field. If the third-party payroll
system field value is derived from multiple PeopleSoft fields,
enter the additional field names as well.

Process ID

Select when a COBOL process is required to correctly
translate or format a PeopleSoft value to a third-party payroll
system value.

Note: Process IDs are defined on the Interface Process Table.

PI Translate Indicator (payroll interface translate indicator)

Select to specify how translate values are handled:
No Translate Values
Translate All

Translate or Use Default Value: Translate if a translate
value is found; if not, use the default value that is defined

on the Interface Field1 page.

Translate or Use PS Value: Translate if a translate value is

found; if not, use the PeopleSoft value.

Instance ID

Select to control which values of a field should be mapped to
the external payroll system.
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Translate Values

Select to translate PeopleSoft field value PS Value 1 (and, if needed,PS Value 2 and PS Value 3) tothe
third-party payroll system value, PI Value. For example, if DEDCD (deduction code) is KUDEN9
and DED_CLASS (deduction class) is B (before tax), then the translated value is D1.

Translate values are available for all export fields and for the Currency Code field for import.

Related Links
Creating COBOL Routines

Setting Up the Definition Table

To set up the Definition Table, use the Definition Table (INTRFC DEFINITION) component.

Pages Used to Set Up the Definition Table

Page Name Definition Name Usage

Interface Definition File Page PI FILE1 PNL Set up a file layout for the import or
export file.

Interface Definition Record Page PI FILE2 PNL Set up the records in a file.

Interface Definition Fields Page PI_FILE3 PNL Set up the fields in a record.

Understanding the Definition Table

Use the Definition Table component to define the physical structure of the export or import file, including
the records in the file and the fields in the records. Any field defined in the Field Definition Table
component can be added to the Definition Table component.

Note: Each record in the file must include the field that is defined as the EMPLID on the System Table
component.

Warning! 1f you use PeopleSoft Application Designer to change any of the tables or fields set up

using the PS Tables component, you must make sure that these changes are reflected in the PS Tables
component as well. If you think that a change that you have made has not taken affect, delete the database
cache file and log back into the system.

See PeopleTools: Application Designer Developer’s Guide

Interface Definition File Page

Use the Interface Definition File page (PI_FILE1 PNL) to set up a file layout for the import or export
file.
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Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition File

This example illustrates the fields and controls on the Interface Definition File page.

Interface Definition File Interface Definition Record Interface Definition Fields

File ID PHY
File IO Definition Find | iew Al First &' 10f1 ‘2 Last
‘Effective Date |01/01/1950 |[5) ‘Status [ Active v H[=]
Description Physical File Layout Short Desc Physical F

SystemID |PHY @ physical

Process Type | Export L
File Type | Physical hd Oconvert case Include Header
PlRecord Length | 111 Max Fields Per Output Rec | 30
Data Delimiter I_ External Field ID Indicator M

File ID Definition

Field or Control Description
System ID Select the system ID for the third-party payroll system.
Convert Case Select this check box to have the system automatically select

the Conv. Case check box for each new field that you enter

on the Interface Definition Fields page of this component. If
you need to update the value of the Conv. Case check box for
existing fields, you must manually select or deselect that check
box on the Interface Definition Fields page for each of those
fields. Selecting or deselecting the check box on this page does
not update existing values.

Include Header Is on or off by default according to values that are set up on
the System Table component for the selected system ID.

PI Record Length Select to enter the record length for the file type. For comma-
separated (CSV), tab-delimited, and other delimited file types,

the value must be zero.

Max Fields Per Output Rec (maximum fields per output Used for logical records. Select the value that is defined by the
record) third-party payroll system.
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Field or Control

Description

External Field ID Indicator

Used for logical records. When this check box is selected, the
data records contain the external field ID as defined on the
Interface Field1 page for all of the fields that are defined in the

interface definition record.

Interface Definition Record Page

116

Use the Interface Definition Record page (PI_FILE2 PNL) to set up the records in a file.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition Record

This example illustrates the fields and controls on the Interface Definition Record page.

Interface Definition File Interface Definition Record Interface Definition Fields
File ID Find | Wiew All First'*' 1 of1 "2 Last
File ID PHY FPhysical File Layout Effective Date 01701715980 [+][=]
Record Definition Find | View All First'4' 1 of 3 Last
Rec Seq Nbr el Record ID HEAD ‘Record Type | Header w =+ [=]

Description Header for Personal Data

PS Record |JOB @, Base Rec I_

*Occur Ind | Single Rec to Single Defn Fec v

InstancelD @ Record Terminated Value |~

Process ID @ Record Terminated Length 1
Description ]

Field or Control

Description

Rec Seq Nbr (record sequence number)

Select to indicate the sequence of each record within the file.

Note: The system assigns sequence numbers as you add or
delete records. If your external system requires a specific
record sequence, make sure the sequence reflects that.

Record ID

Each record definition should have a unique ID. Record
definitions are used for organizing data for the Export process
and for defining the export file. So you are likely to have more
record definitions on this table than are described by your
payroll system documentation.

If the third-party payroll system has its own record IDs, you
might want to use those.
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Field or Control

Description

Record Type

Select from the following:

*  Header: Written out first to identify the beginning of a
file. Multiple headers are allowed.

*  Trailer: Written out last to identify the end of a file.

*  Data: Imported or exported data. A data record must have
a primary PS record.

*  Process: Record definitions used by a COBOL process
and associated with specific process events, such as stop
deductions. Process records must also identify theBase
Rec field (base record).

*  Not Procd (not processed): Used for import files only.
This indicates a payroll system record within the import
file that is not processed by Payroll Interface.

If you select any type other than Process, then the row
builds a record type within the file.

If you have multiple data-type records, the first data
record should have the Primary PS Record set to Job.

Note: (for CSV files) Each data-type record needs to be
assigned to a separate, individual interface definition file.
If you have multiple records (and interface definitions),
assign each of them to the appropriate PI Configuration
ID.

PS Record

Select to identify the PeopleSoft table that is selected from (for
export) or inserted into (for import) as the primary PeopleSoft
table for this interface record.

Note: Each data record must contain the field that is defined as
the employee field ID on the System Table component.

Base Rec (base record)

Available for process record types.

The data value that is used in the Base Rec field is a record
sequence number from another row on this table. The base
record ties the indicated process to another sequence number
row. For example, if the row that is labeled with sequence
number 80 concerns deduction data and the row that is labeled
140 defines the process ID that is used to stop the deduction,
then 80 is the base record for record sequence number 140.
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Field or Control Description

Occur Ind (occurrence indicator) Select to identify the correspondence between rows in the PS
record and the records in the export file.

*  Multi Recs to Multi Defn Recs (multiple records to
multiple definition records)

Data is pulled from a PeopleSoft record that may

have multiple records (or rows) of information to
multiple definition payroll system records (or rows) of
information. The Occurrence Key field is required to
distinguish each occurrence.

Example: Ded Calc and Additional Pay may have more
than one row of employee data that the system needs to
read to determine whether data changed. You would pull
all rows of data and write them to multiple rows on the
payroll system data file.

Example:

(SSN, Ded Code, Ded Amount)
"354567980","401K",200.00
"354567980","HEALTH",150.00
"354567980","UWAY",50.00
"354567980","VISION",25.00

or

(SSN, Pay Code, Pay Amount)
"354567980","CAR",200.00
"354567980","DIEM",250.00
"354567980","FLEX",60.00

*  Multi Recs to Single Defn Rec (multiple records to single
definition record)

Data is pulled from a PeopleSoft record that may have
multiple records (or rows) of information to a single
payroll system record (or row) of information.

Example: Direct Deposit may have more than one row of
employee data that the system needs to read in order to
determine whether the data changed. You would want to
pull all rows of data from PeopleSoft and write them to
one row on the payroll system data file.

Example:
(SSN, Trans/ABA, Account #, Account Type, Amount)
"354567980","123456789","85987-00","C",500.00,

"123456789",85987-001","S",200.00,"123456789",
"85987-002","S",50.0
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Field or Control Description

»  Single Rec to Single Defn Rec (single record to single
definition record)

Data is pulled from a single PeopleSoft record (or row)
and put in a single payroll system record (or row) of
information.

Example:

(Name, Address, City, Country)

"Doe,Jane","854 Mill Rd"," Anywhere","USA"

Instance ID Defined on the Instance Table - Interface Instance Table page.

Process ID Select when a special COBOL process is required to correctly
translate or format PeopleSoft values for your payroll system.

Payroll Interface delivers process IDs for several special
events. These events set an indicator that can be used later by
another special process indicator:

See Reviewing Delivered COBOL Processes for Special
Events.

Record Terminated Value and Record Terminated Length | Available for data entry only if the file type selected on the
Interface Definition File page is Physical or Logical. Enter
a value only if your external payroll system needs a specific
value to identify the end of the record.

Interface Definition Fields Page

Use the Interface Definition Fields page (PI_FILE3 PNL) to set up the fields in a record.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition Fields
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This example illustrates the fields and controls on the Interface Definition Fields page.

Interface Definition File Interface Definition Record Interface Definition Fields
File ID Find First & 1 0f1 2 Last
FilelD PHY Fhysical File Layout Effective Date  01/01/1980 [+] [=]
Definition Find | Wiewr All First'$' 1073 * Last
Rec Seq Nbr 8 Record ID HEAD  Headerfar Personal Data [+ [=]
PSRecord JOB
Fields Personalize | Find | view s | 2D | B First' 4 4-2af2 "B Last
zt(';:leme Redefine  Field ID Description Po‘ﬁ“i“o'l: L;I';"I‘]' Field1 Hame '::;"::‘:" Re;i‘;'lfe ‘Key Field Group I
10 il COMPMYGL,  Company 1 [ al Fecord Levw Q@ +] -]
20 | RUNID @, Ronld 7 [ | Record Leviy @ =+ =]
Fields

Use the options in the Fields group box to define, order, and group the individual fields in a record.

Field or Control

Description

Field Sequence (field sequence number) and Field ID

Select to enter a field and its position within the record (field
IDs are defined on the Field Definition Table component).

Note: When you set up a transaction and its corresponding
stop transaction, the field sequences in both records must
match.

Redefine (redefine)

If the field's position in a record is also used by a subsequent
field for a different purpose, use this check box to select

the secondary field for later use. The secondary field must
immediately follow the first definition with this position in the
record.

Start Position, Field Length, and Field1 Name

Calculated from the Interface Field Table.

For physical files, the starting position and field length can be
used to validate that the length of the fields has been set in the
correct layout.

Convert Case

Used for ASCII files only. Select to override the case default
for a field.

Reverse Sign

Select if the field is signed numeric type and the payroll
system requires that the sign be reversed.
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Field or Control

Description

Key Field

Select from the following values:
*  None: Indicates a data-only field.
Non Key: Indicates a non-key field.

*  Record: Defines a field as a primary record key. The
system formats only one record per employee.

Note: To make a field a record key, every key value in
every row above the field must also be defined as a record
key. The system delivers a COBOL error message if you
order the key field in a manner such as Non Key, Record,
and Non Key.

*  Occurrence: Defines a field as an occurrence key.
Occurrence key processing allows multiple records to be
formatted.

See Working with Key Fields.

*  Effdt: Defines a field as an effective-date key. An
effective-date key is special type of occurrence key.
In addition to occurrence key functionality, further

processing eliminates redundant information.

See Working with Key Fields.

*  Company: If a field is defined as Company and the value
on the System Table, Interface System Table 1 page -
Process Filter field is set to Company, the system activates
a filtering mechanism. Only rows with a Company value
matching the processing company (the company tied to
the run ID) are formatted and passed to the interface.

See Working with Company Filtering.

Group ID

Select to indicate that the field belongs to a group of fields.

All fields in the record with the same group ID are exported
or imported together (if a data change occurs to one field in the
group, all fields in the group are exported).

Setting Up the Group Table

To set up the Group Table, use the Group Table (INTRFC GROUP) component.
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Chapter 9

Page Name

Definition Name

Usage

Interface Group Table Page

PI_GROUP_PNL

Set up group IDs that identify multiple
fields to be imported or exported
together.

Understanding the Group Table

Interface Group Table Page

122

Use the Group Table component to define a group ID. Group IDs are used to group two or more fields for

export or import:

* For export processing, a group ID is used to identify multiple fields that must be exported together
when data changes in any field in the group.

* For import processing, a group ID identifies multiple fields that correspond to one row in the PI
Check Table or the PI Balance Table. The PI Check Table and PI Balance Table are populated when
you import data by way of Payroll Interface from your third-party payroll service.

Note: The import group ID can associate an additional field and value for the PeopleSoft import table.
This allows a record position in the import file to be translated to a key value in the PeopleSoft import

table.

Use the Interface Group Table page (PI_ GROUP_PNL) to set up group IDs that identify multiple fields to

be imported or exported together.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Group Table >

Interface Group Table
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This example illustrates the fields and controls on the Interface Group Table page.

Interface Group Table
System D PHY

Group I CED

Process Type | Expor

Short Description |Deds

Description Deduction Code and Amount

Fhysical File Format

PeopleSoft Record Name EMPLOYEES 3,
PeopleSoft Felid1 Hame EMPLID QJ
PS Key Value EMPLID
Field or Control Description
Process Type Select to enter the Payroll Interface process, either export or

import.

For export processing, a group ID is used to identify multiple
fields that must be exported together when data changes in any
field in the group.

For import processing, a group ID identifies multiple fields
that correspond to one row in the PI Check Table or the PI
Balance Table. The PI Check Table and PI Balance Table are
populated when you import data by way of Payroll Interface
from your third-party payroll service.

Note: The import group ID can associate an additional field
and value for the PeopleSoft import table. This allows a record
position in the import file to be translated to a key value in the
PeopleSoft import table.

PeopleSoft Record Name and PeopleSoft Fieldl Name

Available for process type import. Select to define the
PeopleSoft record and field where the import data is inserted.
This allows translation of a record position in the import file to
a key value in the PeopleSoft table.

Setting Up the Instance Table

To set up the Instance Table, use the Instance Table INTRFC INSTANCE) component.
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Page Used to Set Up the Instance Table
Page Name Definition Name Usage
Interface Instance Table Page PI_INSTANCE_PNL Set up instance IDs to filter PeopleSoft
data that is mapped to Payroll Interface
fields or records.

Understanding the Instance Table

Use the Instance Table component to define instance IDs that act as filters and process records (row

instances) or fields (field instances) based on specific data values.

Instance IDs work like a dynamic Where clause and can be assigned to:

*  Records: Select when the data that is mapped to the record is valid for only a subset of data within
the primary PeopleSoft record. If the condition is not met, the record is not formatted. You can define

instances for a specific ordinal row from a table or rows based on a value in a table.

»  Fields: Select when you need to control which PeopleSoft values to use for the field. When the

condition is met, a specified PeopleSoft value is mapped to the field.

See Working with Transactions.

Interface Instance Table Page

Use the Interface Instance Table page (PI INSTANCE PNL) to set up instance IDs to filter PeopleSoft

data that is mapped to Payroll Interface fields or records.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Instance Table >

Interface Instance Table

This example illustrates the fields and controls on the Interface Instance Table page.

Interface Instance Table
System ID CEY CEY Sample Layout
InstancelD SALARY
Definition Find | Wigw All First'4' 1 of1 '* Last
Effective Date |01/01/15930 E{J Description | Salaried Employees ﬂ ﬂ
Short Description |Salaried ‘Instance Indicator | Valug w
PeopleSoft Record Name |JJOB OJ PeopleSoft Field1 Name EMPL_TYFE OJ
Include Exclude Indicator | Include Yalues v
Instance Information Fersonalize | Find | Wiew All | (E] | ]| First 4 1 of1 ' Last
'Sequence Field1 Value
1 5 [+l [=]
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Definition

Field or Control Description

Instance Indicator Select either:

*  Value: Controls selection according to the value in a field.
Deduction Class is an example. The specified values
indicate which condition must be met for the system to
select data for processing.

Note: Use the word ZERO to specify that the value should

be compared to the number 0.

*  Ordinal: Controls selection according to the occurrence of
data or entry within a table. For example, in PeopleSoft,
an employee can have several entries within the Direct
Deposit Distribution Table. An ordinal instance type tells
Payroll Interface which occurrence or row of data within
the PeopleSoft record to select for export.

PeopleSoft Record Name and PeopleSoft Field1 Name Select to identify the PeopleSoft record and PeopleSoft field

that are tested against the specified values.

Include Exclude Indicator Select to include or exclude the value when it matches the
condition that you specified.

Instance Information

Field or Control Description

Sequence Select to indicate which occurrence or entry in the PeopleSoft
record to use for processing. The sequence order is dictated by
the select order on the primary PeopleSoft table used to define
the interface ID field or record.

When using an ordinal instance type, Payroll Interface selects
only the occurrence that corresponds to the row number from
the PeopleSoft record defined for export.

Field1 Value Select to indicate a value to use during processing.

To create an instance ID based on the value of zero, use the
literal value ZERO instead of 0.

To create an instance ID based on the value of space, use the
literal value SPACE instead of pressing the space bar.
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Setting Up the Process Table

To set up the Process Table, use the Process Table (INTRFC_PROCESS) component.

Page Used to Set Up the Process Table

Page Name Definition Name Usage

Interface Process Table Page PI PROCESS PNL Set up a COBOL process.

Understanding the Process Table

Use the Process Table component to access the COBOL processes that are delivered with Payroll
Interface. These processes enable transaction processing or other types of processing such as data
translation or data formatting.

You can add your own COBOL routines to the system. You can also document and control which user

exit program is called for any process that you define and describe any changes that you make to the
provided processes.

Interface Process Table Page

126

Use the Interface Process Table page (PI PROCESS PNL) to set up a COBOL process.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Process Table >
Interface Process Table

This example illustrates the fields and controls on the Interface Process Table page.

Interface Process Table

Process Details Find | Yiew &l First'* 1 of 1 &' Last
Process ID 000003 (#1[=]
‘Pl Process Phase | Before Field Translation w Short Description |City Cade
‘Type | Field -
[“luser Defined Process User Exit Program |PIPSPADP

Process Description [This process will return the Locality Code for the City 1 field. Ifthe employes has more
than one Locality Code defined, the Locality Code returned is the Locality Code where
they wiark.

Returned Yalues Persanalize | Find | view ai | 2 | E First'4' 1 of1 "B Last

Returned Value Description

[+ =
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Process Details
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Field or Control

Description

Process ID

Select the process ID for one of the delivered COBOL
processes or enter a process ID for your own COBOL routine.

See Reviewing Delivered COBOL Processes.

If you create your own COBOL routine, you must set up a

process ID for the routine using this page.

See Creating COBOL Routines.

PI Process Phase

Select to identify when the system runs the COBOL process.
A process phase is hard-coded into each COBOL process that
is delivered with Payroll Interface; if you change the process
phase, you must also modify the COBOL process.

A process ID can have more than one PI process phase
attached to it. The following are translate values for PI process
phase:

»  After Field Translation

*  Before Field Translation
*  Export File Creation

*  Import Processing

*  Record Processing

Type

Select to indicate whether the process applies to a record or a
field.

User Defined Process

Select if the process is one that you have defined or it is
delivered with this turned on.

User Exit Program

If User Defined Process is selected, select to specify the name
of the user-defined program that will transfer the control to run
the process. A value of space characters indicates a common
routine (PIPSPRCS) that is delivered with the Payroll Interface
system.
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Returned Values

Field or Control Description
Returned Value Applies only when the value for the PI Process Phase field is
Before Field Translation.

Setting Up the File Handle Table

To set up the File Handle table, use the File Handle Table INTRFC FILEHANDLE) component.

Page Used to Set Up the File Handle Table

Page Name Definition Name Usage

Interface File Handle Table Page PI FLHANDLE PNL Assign a handle to each external file that
is imported or exported.

Understanding the File Handle Table

Use the File Handle Table component to define file handles that identify the export or import files and
their physical location on the computer system. File handles are connected to the file IDs, which are set
up using the Definition Table component.

This diagram shows the relationship between file IDs and file handles:

This diagram shows the relationship between file IDs and file handles.

Definition Table File Farmat
File ID (CSV, LOG, PHY, NFC)

File Location
File Handle Table (Ctemp)
File Handle

Interface File Handle Table Page

Use the Interface File Handle Table page (PI FLHANDLE PNL) to assign a handle to each external file
that is imported or exported.

Navigation:
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Set Up HCM > Product Related > Payroll Interface > Interface Controls > File Handle
Table > Interface File Handle Table

This example illustrates the fields and controls on the Interface File Handle Table page.

Interface File Handle Table

Defiritian Personalize | Find | viewal |2 |E  Firgt * 1-50r9 b Last
File - I
Handle File Hame Description
B1 CitemmSEQDUTE PACT +| [=]
62 CitemmSERDUTEZ FME0 +] [=]
1 CATEMPUWMASTER CEY Sample CEV Master File +] [=]
o2 CATEMPIDEDUCTION CEY Sample CSV Deduction File +] [=]
3 CATEMPWBEF ORE-TAK-SAWVIMNGE. CEY Sample Before Tax Savings File ﬂ j
Field or Control Description
File Handle Select to enter any combination of two-digit alphanumeric

characters, regardless of the external file's format. Each file
handle number should be assigned a unique process type
(export or import).

File Name Select to enter the exact path and file name that corresponds to
the file handle's location. Be sure to use the appropriate syntax
for your operating system (Windows-based, Unix-based, and
SO on).

Setting Up the Configuration Table

To set up the Configuration table, use the Configuration Table INTRFC_CONFIG) component.

Page Used to Set Up the Configuration Table

Page Name Definition Name Usage
Interface Configuration Table Page PI_CONFIG PNL Set up configuration IDs and link file
IDs to file handles.

Understanding the Configuration Table

Use the Configuration Table component to define a configuration ID. The configuration ID is the
connection mechanism that joins PeopleSoft HCM to the third-party payroll system and enables the
exchange of data.

This diagram shows that the configuration ID connects the file ID to the file handle:
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This diagram shows that the configuration ID connects the file ID to the file handle.

Configuration |D

(File ID})
{File Handle)

Configuration Table

Definition Table
File 1D

File Format

File Handle Table
File Handle

File Location
(C:Mtemp)

(CSV, LOG, PHY, NFC)

Chapter 9

This diagram shows that the configuration ID also connects the PeopleSoft HCM pay group to the third-

party payroll system:

This diagram shows that the configuration ID also connects the PeopleSoft HCM pay group to the third-

party payroll system.

HRMS

Company Table
Company
Effective Date

Company
Effective Date

!

Pay Group Table
Pay Group

{Company)
{Effective Date)
(Configuration D)

PeopleSoft Enterprise

Configuration
ID

Effective

Date

— | Configuration Table

Configuration |D

(System D)
(Effective Date)

Third-Party
Payroll System

System

Effective
Date

System Table
System 1D

(Effective Date)

Note: The configuration ID is entered on the Pay Group Table - Definition page, PI Configuration ID

field and is used to identify the payroll system and the interface files that apply to the pay groups.

Related Links

Understanding Payroll Schedules

Interface Configuration Table Page

130

Use the Interface Configuration Table page (PI CONFIG_PNL) to set up configuration IDs and link file

IDs to file handles.

Navigation:
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Set Up HCM > Product Related > Payroll Interface > Interface Controls > Configuration
Table > Interface Configuration Table

This example illustrates the fields and controls on the Interface Configuration Table page.

Interface Configuration Table

Config I PHY
Definition Find | wiew Al First ‘&' 10f1 b Last
‘Effective Date |01/01/1930 | ‘Status | Active v [+][=]
Description Physical File Format
‘System D [PHY |@, Physical File Format
File IDs Persanalize | Find | view Al | B Fiest 4 1 a1 ) Last
'File 1D Descr File Handle File Hame
PHY @, Physical File Layout Pl @, CATEMPIPHYSICALTHT =+ [=]

Field or Control

Description

System ID

Select to identify the system ID for the third-party payroll
system.

File IDs

Use the options in the File IDs group box to link file IDs to file handles.

Field or Control

Description

File ID and File Handle

Select to identify the export file or import file and to specify
each file's handle as defined using the File Handle Table
component.
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Working with Interface Definitions

This topic discusses how to:
* (USF) Set up an NFC export interface definition.
* Setup a DETI import interface definition.

e Set up a new import interface definition.

(USF) Setting Up an NFC Export Interface Definition

Use the National Finance Center (NFC) sample data definition to set up an export interface for federal
agencies, who primarily use the National Finance Center as the third-party payroll system.

Note: Federal agencies generally do not import NFC data (the processed payroll results) back into
PeopleSoft HCM. You can configure Payroll Interface to import the data, but most agencies do not take
advantage of this feature

Payroll Interface uses the NFC system ID as well as the Industry and Industry Sector codes set up in
PeopleSoft HR to identify federal workers. Because the NFC sample data definition is configured to
export position and job data, you should implement full position management within PeopleSoft HR.

The NFC sample data definition includes two export files: the Entry, Processing, Inquiry, Correction
(EPIC) file contains employee data; the Position Management Data (PMSO) file contains position and job
code data. Both files include the appropriate header information required by the NFC. When you export

a full set of records, the NFC export sends only the last effective-dated row for both employee data and
position and job code data.

The NFC sample data definition includes six additional tables (views):

Table Description
GVT_PI AWD VW SF50/52 award information for the NFC's 110 record.
GVT_PI DATA VW The personal, employment, and job data that is used to process

SF50/52 forms for the NFC's EPIC 063 Data record.

GVT_PI EDUC VW Education information for the NFC's EPIC 063 Data record.
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Table

Description

GVT PI RMKS VW

SF50/52 remarks information for the NFC's Remark (RMK)
record.

GVT_PI_POIP_VW

The NFC's PMSO Individual Position record (2056).

GVT PI POMR_VW

The NFC's PMSO Position Master record (2055).

Related Links

“Understanding NFC Processing” (PeopleSoft Human Resources Administer Workforce)

Setting Up a DETI Import Interface Definition

134

Use the Detail Interface (DETI) sample data definition to set up an import interface definition that loads
the employee check detail information produced by the third-party payroll system.

To set up the import interface, obtain a copy of the data file from the third-party payroll vendor that
matches the DETI sample data definition. Then, examine the Payroll Interface fields and records that are

associated with it:

1. Ensure that the key values that you map using the PI. CHECK table are the same values that are
mapped on the three DETAIL child records, plus one more to make it a unique child.

You must also create a field definition for each data field that is present in the file, including a filler
for unwanted data when the data is defined by its position in the record.

2. Define the import records.

3. Attach your file definition to the Payroll Interface configuration ID and define the external file handle
to enable the COBOL program to find the input file.

For physical file types, some data fields may be defined according to type (such as OASDI tax type) by
their position in the import record. As shown in this example, Payroll Interface reflects this tax type by
creating a separate row for each occurrence and captures the tax type during import by attaching a group

1D:
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This example of the Interface Group Table page shows a sample Group ID used for import.

Interface Group Table

System ID T3V CEW Sample Layout

Group I D03

Process Type | Import v|

Description | Soc Security Tax (OASDI
Short Description |(0ASDI
PeopleSoft Record Hame PL_TAX_DETAIL OJ
Peoplesoft Fieli1 Hame PI_TA_TvFPE ]

PS Key Value OASDI

As shown in this example of the Interface Group Table page (Set Up HCM > Product

Related > Payroll Interface > Interface Controls > Group Table > Interface Group Table),

Setting Up a Payroll Interface Definition (Part 2)

Payroll Interface uses the entry in the PS Key Value (PeopleSoft key value) field to populate the field
defined in PeopleSoft Field1 Name with OASDI, as it is builds the data for the record given by PeopleSoft

Record Name from the import row being processed:

This example of the Interface Definition Fields page shows a sample interface definition used for import.

Interface Definition File Interface Definition Record Interface Definition Fields
File D Find Firgt 41 011 ‘b Last
File I CSVDED C8Y - Ded_Calc-Sample File Effective Date  01/01/1320 [+ [=]
Definition Fing | iew Al First &/ 1072 % Last
Rec SeqNbr 10 Record ID PDED  Deduction Record [+ [=]
PS Record DED_CALC
Fields Personalize | Find | Viewal | 22 | E First ‘4 1-4 of 4 ‘&) Last
zi:(ll(llle“ce Redefine Field ID Description Posfisl‘i‘lo:: Lef‘i;::: Field1 Hame C:):":::" Re;i;':’e ‘Key Field Group ID
10 O cont @ Company Code 1 3 O 2, +| [=]
E J Joo1 |@ Employee 1D a 1 O @, + [=]
Elil O Do01 @ Deduction Code 15 8 DEDCD O DED |@, ==
10 O D002 [@,  Deduction Amount 23 7 DED_CUR O DED @, &=

This example of the Interface Definition Fields page(Set Up HCM > Product Related > Payroll

Interface > Interface Controls > Definition Table > Interface Definition Fields), shows a sample

interface definition used for import.
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This example of the Interface Fieldl page shows a sample field ID used for import.

Interface Field1 Interface Field2
System ID C3Y  CSY Sample Layout FieldID DFDO3
Field Definition Find | wiew Al First'*' 1 of1 "' Last
‘Effective Date |01/01/1980 5] ‘Status | Active v +][=]
Description Direct Pay Soc Sec Tax (OASDI) Short Desc |OASDI
External Field I[rli Process Type | Import v
‘Type | Signed Mumber Text
External Column Name Default Value
Field Farmat
‘Field Length {in bytes)| 12 Decimal Length | 2 D[rispla_\.' Decimal
Integer Length 9 Round Decimal | Standard Rounding Rules v Celank If Zero
Sign Position | Leading v Negative - Use Positive Sign Positive
Justification | Right - Pad Character
Date Format Remove Trailing Spaces
Null Blank Character Flds Null Zero Numeric Flds

As shown in this example of the Interface Field1 page (Set Up HCM > Product Related > Payroll
Interface > Interface Controls > Field Definition Table > Interface Field1), group ID D03 is
attached to the field ID DPDO03.

Defining a New Import Interface Definition

This topic discusses how to set up a new import file definition. For this example, you use a
physical, fixed-length data file to import pay period data into the PI CHECK, PI EARN DETAIL,
PI DED DETAIL, and PI TAX DETAIL import tables.

Basic File Layout

Header and footer records are optional. To use data that's not at the employee level, place it here. For
examples, see the DETI sample data file header and footer.

Note: You can map fields that are derived from the PeopleSoft pay calendar or that are derived during the
Payroll Interface process. At the field level, select value as the type, and view the text list.

Record Ildentifiers

For each physical record to be read, set up an interface field as a record flag. On the Interface Field 1
page, enter value in the Type field and External Record Code in theText field. Then each record has a
unique flag at the beginning of the input data record.

Sample Values

This table lists sample values:

Default Value

Record Name

Field Name

PI CHECK

CHKO01

136
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Default Value Record Name Field Name
B PI_ EARN_DETAIL ERNO1
C PI DED DETAIL DEDO1
D PI TAX_DETAIL TAX01

Record Key Fields

Examine each PeopleSoft system record definition into which you want to import data. Examine the
DETI sample data file and ensure that you map the same key fields from the data file into the Payroll
Interface tables, as a minimum.

Sample Data File Layout

Each record is physical, with a fixed length, but the records do not have to be the same length. Enter the
longest record length on the Definition Table component - Interface Definition File page, PI Record
Length field.

Record A: Contains PI_EMPLID and all other data fields that are mapped to PI_ CHECK. Key record
fields are:

« CHKO1
¢ Check Number

* PI EMPLID, as defined on the System Table component - Interface System Table 1, Employee Field
ID field.

Record B, C, D, and subsequent records.: These records do not need thePI _EMPLID field. The Import
process uses the same Payroll Interface employee ID for these data records until it reads another record A
with another Payroll Interface employee ID.

To process multiple records repeatedly, set the Definition Table component - Interface Definition Record
page, Occur Ind field to Multi Recs to Single Defn Rec. For an example, see the DETI sample data file,
Record ID DPE, Coded Hours.

Record B (Earn Detail)
ERNO1 (RECORD)

Earn Type (NON KEY)
Earn Code (NON KEY)

Amount (NON KEY)
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The data file might look like this:

A, Emplid, check nbr, data field, data field, etc.
B , earn type, code, amount

B, earn type, code, amount

B , earn type, code, amount

B, earn type, code, amount

Each subsequent record repeats many times as necessary (using Multi Recs to Single Defn Rec).

Record C (Deduction Detail)
DEDO1 (RECORD)

Ded Code (NON KEY)

Ded Amount (NON KEY)

The data file might look like this:
A, Emplid, check nbr, data field, data field, etc.
B , earn type, code, amount
B, earn type, code, amount
B , earn type, code, amount
B, earn type, code, amount
C, code, amount

C, code, amount

C, code, amount

C, code, amount

C, code, amount

C, code, amount

The PeopleSoft system imports subsequent records in the same way.

Working with Character Sets

138

Use the System Table component - Interface System Table 1 page, Character Set field to select a
character set for export or import processing.

See Setting Up the System Table.

The following table lists the character sets that Payroll Interface supports.

For example, suppose your headquarters is in the U.S., but you have an office in Japan where the payroll
system uses Kanji. When Payroll Interface is run for the U.S., the Character Set field is set to /SO 8859—
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1, the Latin character set. When Payroll Interface is run for the Japanese site, theCharacter Set field must

be set to JIS X 0208, the Kanji character set.

Character Set Description

ANSI Current ANSI Code Page

ASCII US 7-bit ASCII

Big5 Big$5 (Traditional Chinese)

CCSID1027 IBM EBCDIC 1027 (Jap.-Latin)
CCSID1047 IBM EBCDIC 1047 (Latinl)
CCSID290 IBM EBCDIC 290 (Katakana)
CCSID300 IBM EBCDIC 300 (Kanji)

CCSID930 IBM EBCDIC 930 (Kana-Kanji)
CCSID935 IBM EBCDIC 935 (Simplified Chinese)
CCSID937 IBM EBCDIC 937 (Traditional Chinese)
CCSID939 IBM EBCDIC 939 (Latin-Kanji)
CCSID9%42 IBM EBCDIC 942 (Japanese PC)
CP1026 Windows 1026 (EBCDIC)

CP1250 Windows 1250 (Eastern Europe)
CP1251 Windows 1251 (Cyrillic)

CP1252 Windows 1252 (Latinl)

CP1253 Windows 1253 (Greek)

CP1254 Windows 1254 (Turkish)

CP1255 Windows 1255 (Hebrew)
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Character Set Description

CP1256 Windows 1256 (Arabic)
CP1257 Windows 1257 (Baltic)

CP1258 Windows 1258 (Vietnamese)
CP1361 Windows 1361 (Korean Johab)
CP437 MS-DOS 437 (US)

CP500 Windows 500 (EBCDIC 500V1)
CP708 Windows 708 (Arabic - ASMO708)
CP720 Windows 720 (Arabic - ASMO)
CP737 Windows 737 (Greek - 437G)
CP775 Windows 775 (Baltic)

CP850 MS-DOS 850 (Latinl)

CP852 MS-DOS 852 (Latin2)

CP855 MS-DOS 855 (IBM Cyrillic)
CP857 MS-DOS 857 (IBM Turkish)
CP860 MS-DOS 860 (IBM Portuguese)
CP861 MS-DOS 861 (Icelandic)
CP862 MS-DOS 862 (Hebrew)

CP863 MS-DOS 863 (Canadian French)
CP864 MS-DOS 864 (Arabic)

CP865 MS-DOS 864 (Nordic)
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Character Set Description

CP866 MS-DOS 866 (Russian)

CP869 MS-DOS 869 (Modern Greek)
CP870 Windows 870

CP874 Windows 864 (Thai)

CP875 Windows 875 (EBCDIC)

CP932 Windows 932 (Japanese)

CP936 Windows 936 (Simplified Chinese)
CP949 Windows 949 (Korean)

CP950 Windows 950 (Traditional Chinese)
EBCDIC IBM EBCDIC CCSID37 (USA)
EUC-JP Extended Unix Code (Japanese)
EUC-KR Extended Unix Code (Korean)
EUC-TW Extended Unix Code (Taiwan)
EUC-TW-1986 Extended Unix Code (TW-1986)
GB12345 GB 2312 (Simplified Chinese)
GB2312 GB 2312 (Simplified Chinese)
1SO-2022-JP ISO-2022-JP Japanese
ISO-2022-KR ISO-2022-JP Korean
ISO_8859-1 ISO 8859-1 (Latinl)
ISO_8859-10 ISO 8859-10 (Latin6)
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ISO_8859-11 ISO 8859-11 (Thai)
ISO_8859-14 ISO 8859-14 (Lating)
ISO_8859-15 ISO 8859-15 (Latin9 / Latin0)
ISO_8859-2 ISO 8859-2 (Latin2)
ISO_8859-3 ISO 8859-3 (Latin3)
ISO_8859-4 ISO 8859-4 (Latin4)
ISO_8859-5 ISO 8859-5 (Cyrillic)
ISO_8859-6 ISO 8859-6 (Arabic)
ISO_8859-7 ISO 8859-7 (Greek)
ISO_8859-8 ISO 8859-8 (Hebrew)
ISO_8859-9 ISO 8859-9 (Latin5)

JIS X0201 Japanese Half-width Katakana
JIS X 0208 Japanese Kanji

Java Java (Unicode encoding)
Johab Johab (Korean)

Shift JIS Shift-JIS (Japanese)

UCS2 Unicode UCS-2

UTF7 Unicode UTF-7

UTF8 Unicode UTF-8
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Working with Text Translate Values

Use the Field Definition Table component - Interface Field1 page, Text field to select translate values.

See Setting Up the Field Definition Table.

Translate values correspond to data elements that are already available to the COBOL process. The
following table lists the field values, their translate values, and where the data originates.

Value Translate Value Source

B Pay Period Begin Date PAY CALENDAR.PAY BEGIN DT

C Constant PI FIELD TBL.PI DFLT VALUE

D Compare Date PI RUN PYGRP.COMPARE DTTM

E Export Date System date at runtime

F PI Config ID PAYGROUP.PI_CONFIG_ID

G Termination Count Process Calculation

H Hire count Process Calculation = Hired this run

I External Record Code PI_ DEFN_RECORD.PI RECORD ID

L Logical Record Count Process Calculation

M Société de Traitement (Processing Paygroup) Derived during
Processing

N Interface Run Number PI_ RUN_TBL.PI RUN_NUM

o Process Option PI RUNCTL.PI RUN OPT

P Pay End Date PAY_CALENDAR.PAY_END DT

Q Check Date PAY CALENDAR.PAY CHECK DT

R Pay Run ID PI_RUN_CTL.RUN_ID

S System ID PI_CONFIG_TBL.PI SYSTEM ID
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Value Translate Value Source

T Compare Time PI RUN PYGRP.COMPARE DTTM

U Lot de Paie de Traitement (Processing Company) Derived during
Processing

X Export Time System Date Time value at runtime

Y Physical Record Count Process Calculation

Working with Company Filtering

Use the Definition Table component - Interface Definition Fields page, Key Field field to select Company
as the key field.

See Setting Up the Definition Table.

Company filtering restricts Payroll Interface processing to a single company. With company filtering, the
Company value that is assigned to a particular row of data must be the same as the company that you are
processing for the row to be formatted and passed to the interface. If company filtering is not used, all
rows created by Payroll Interface for each company and pay group combination are available for export.

For example, in PeopleSoft, you indicate that an employee has transferred from one company to another
by adding a new JOB row with the Transfer action. In some third-party payroll systems, however, the
company is part of the employee key; therefore, when an employee transfers to another company, Payroll
Interface creates a new employee dossier (pool of data). For the transferred employee, you issue a
termination on the old company and a hire on the new company.

After a transfer occurs, the system creates two images within Payroll Interface, one for each company.
With company filtering, a change in employee data may apply to both images (the case for personal data
rows, which would not have Company as a key field). In other cases, it may apply to one image (such as
JOB row data, which you would generally want to filter by company). You can track retroactive changes
even if the changes pertain to a company that the employee has already left. If you had not used company
filtering, the third-party payroll system would store one set of transactions, without creating separate
dossiers and without redundant data (like personal data rows).

This graphic shows how company filtering maps an employee's company data into separate files:
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This diagram shows how company filtering maps an employee's company data into separate files.

PeopleSoft Enterprise HRMS Payroll Interface Third-Party Payroll System
Employes A Mapping Images Files
Personal Data Rows
Company ABC Employee A
| Fiic—p| |Company ABC
Job Data Rows SRR
Company ABC
Employee A
Company XYZ Company XYZ
Job Data Rows
Company X¥Z - Fil e

This example shows a worker employed in multiple companies over a period of five years. Assume that
only one pay group exists per company.

Company Effdt Comprate
CCB 01-01-1999 500
CCB 01-01-1998 450
PST 01-01-1997 425
PST 01-01-1996 400
CCB 01-01-1995 325

If you change data in the 1995 row, you must send the data to company CCB. If you change the 1997 row,
you send the data to company PST.

To implement company filtering:
1. Select Company for the System Table component, Interface System Table 1 page, Process Filter field.

2. Select Company for the Definition Table component - Interface Definition Fields page,Key Field field
for those records that will be filtered by company.

Copyright © 1988, 2026, Oracle and/or its affiliates. 145



Setting Up a Payroll Interface Definition (Part 2)

Chapter 10

3. For the company fields, use either a constant value equal to the processing company (used for
personal data) or use the company from the Job Data component (or from a view based on the tables
underlying the Job Data component).

Note: The system compares the field that is mapped as company to the processing company only after

translation.

Working with Key Fields

Use the Definition Table component - Interface Definition Fields page, Key Field field to define a field as

an occurrence (Occurrence) key or and effective-date(Effdt) key.

See Setting Up the Definition Table.

When you define a field as an occurrence key, multiple records (rows) are formatted for export. When
you define a field as an effective-date key, the retrieved data is put through an extra process to eliminate
redundant records (rows) from the PI PARTIC EXPT table.

For example, suppose the Job Data table contains the data shown in this table:

Effective Date Effective Sequence Comprate Department ID
1999-01-15 0 100 00100
1998-12-12 0 100 00200
1998-12-10 0 85 00200
1997-06-10 0 85 00300
1997-05-31 0 75 00400

If you define the Effective Date field as an occurrence key, the following data is formatted for export:

Effective Date Comprate
1999-01-15 100
1998-12-12 100
1998-12-10 85
1997-06-10 85
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Effective Date Comprate

1997-05-31 75

If you define the Effective Date field as an effective-date key, the following data is formatted for export:

Effective Date Comprate
1998-12-12 100
1997-06-10 85
1997-05-31 75

Warning! Accurate processing depends on the collate order that you specify for the effective-dated field.
On the PS Tables component - PS Tables page, Collate Order field, you must select Asc (ascending). If
you do not select the ascending collate order, you will eliminate all but the last row.

Working with COBOL Processes

This topic discusses how to:
* Review delivered COBOL processes.
* Review delivered COBOL processes for special events.

¢ Create COBOL routines.

Reviewing Delivered COBOL Processes

Use the Process Table component - Interface Process Table page, Process Description field to review
descriptions of the COBOL processes that are delivered with Payroll Interface.

The delivered COBOL processes are either field or record processes (you can associate a process with
either a field or a record) that perform processing tasks outside the normal scope of Payroll Interface.

See Setting Up the Process Table.

Example: Process ID 000015

This COBOL process performs a validation against some data values and sets the value of the field to
which the process is attached to one of the values listed in the Interface Process Table page, Returned
Value field. Because the timing is Before Field Translation, you can then use these values in the Field
Translation list. The list of values in theReturned Value field documents the process so that you know
which values can be used in the Field Translation list and what they represent. This technique enables you
to leverage one COBOL routine for two fields.
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This process is useful because the PeopleSoft system stores certain tax values in two separate fields:

one field for percents and another field for flat amounts. For this type of field, some payroll systems

have one field with a Type code to specify whether it is a percent or an amount. The COBOL process
determines which PeopleSoft field contains the value and returns those fields that are equal to the one
identified in the Returned Value field. The Payroll Interface process then converts or translates the value
in theReturned Value field to another value based on the Field Translation list.

Delivered Processes

This table lists and describes the COBOL processes that are delivered with PeopleSoft Payroll Interface:

Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000001

Record
Processing

Ded End Dt

Record

No

None

When the primary
PeopleSoft source
for the transaction is
additional earnings,
matches the earnings
end date against

the pay end date to
determine whether
the additional
earnings should be
stopped.

000002

Before Field
Translation

Area Code

Field

No

None

Extracts the U.S.

area code from the
phone number field if
the field contains 10
characters. If the field
contains fewer than
10 characters, spaces

are returned.

000003

Before Field

Translation

City Codel

Field

Yes

PIPSPADP

Returns the locality
code for the City 1
field. If the employee
has more than one
locality code defined,
the code returned

is where he or she

works.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000004

Before Field
Translation

City Code2

Field

Yes

PIPSPADP

Uses the City2 Code
value only if resident
state and work state
are different. Uses the
translate entries when

needed.

000005

Before Field

Translation

Cnt Deduct

Field

Yes

PIPSPADP

Adds 1 to a counter
for deductions
using fields that
are mapped to the
ONI1 field. Issues

a warning message
when the employee
has more than 24
deductions.

000005

Export File

Creation

Tilde Chr

Field

No

None

For delimited data
file structures only.
Inserts a Delete
character as defined
in the working
storage of the
COBOL program
PIPXPRCS.CBL
A tilde (~) follows
the value of the
field to be deleted.
Only works when
invoked from a
Process Control
record definition.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000006

Record
Processing

Co change

Record

No

None

Recognizes that the
PeopleSoft company
ID for this employee
has changed. When
using this process,
the PeopleSoft
company ID must

be mapped to a field
within the record. If
the converted value
for the PeopleSoft
company ID changes,
the record containing
this process ID is
formatted.

000008

After Field
Translation

Excess

Field

Yes

PIPSPADP

Returns the translated
deduction code for
the direct deposit
bank account
identified to contain
the "excess" within
PeopleSoft.

000008

Export File
Creation

Skip Blank

Field

Yes

PIPXPADP

Bypasses this field in
the output file if the
Export Full option is
selected and the field
is blank.

000009

Before Field
Translation

Lcl recip

Field

Yes

PIPSPADP

Creates values to
apply to the translate
table. If Local 2
exists, then Field 1
will be resident local
and Field 02 will be
work local.

000010

Before Field

Translation

First Name

Field

No

None

Extracts the first
name from the
PeopleSoft Name
field on the Personal
Data Table.
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Process ID Process Description Type User Defined | User Exit | Description
Phase Process Program

000011 Before Field Last Name Field No None Extracts the last name
Translation from the PeopleSoft

Name field on the
Personal Data Table.

000012 After Field New Hire Field Yes PIPSPADP | Sets the new hire
Translation action to a lowercase
N. This is set

when no history
records exist for the

employee.
000013 Before Field Old PI ID Field No None Uses the employee's
Translation previous PI
EMPLID.
000014 Before Field Before Field Field No None Maps the previous
Translation Translation export value for this
field into the current
record.
000015 Before Field Pct or Amt Field No None Derives a type code
Translation from data in two

related numeric
fields. The first is the
amount; the second
is the percent. Both
fields must be on the
same table and row.
The return values
reflect non-zero
entries in the fields.
Examples include
Federal Tax Data,
Additional Amount,
and Additional
Percent.

000016 Export File Bypass Rec Record No None Bypasses the entire
Creation record on the output
file.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000016

Import
Processing

Bypass Rec

Record

Yes

PIPMPADP

Validates and
bypasses the record
during the import
process.

000017

Before Field
Translation

Phone No

Field

None

Extracts the 7-digit
phone number from
the free-form Phone
field.

000018

Record

Processing

Pygrp chg

Record

None

Recognizes that the
PeopleSoft pay group
for this employee

has changed. When
using this process,
the PeopleSoft

pay group must be
mapped to a field
within the record. If
the translated value
for the PeopleSoft
pay group changes,
the record containing
this process ID is

formatted.

000019

After Field
Translation

Rehire Cd

Field

Yes

PIPSPADP

If the employee's
status code was
terminated the last
time this employee's
data was exported,
but the current status
code is Active, sets
the Rehire code.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000020

Before Field
Translation

RmSlIsh/Dsh

Field

None

Returns the data
value from the
PeopleSoft database
minus any embedded
slashes or dashes.
Use to return the
U.S. ZIP code
value without the
separating dash and
to return a phone
number without

dashes.

000021

Before Field

Translation

State 2 Cd

Field

Yes

PIPSPADP

Uses the Resident
State Code if resident
state and work state
are different. Uses the
translate entries when
needed.

000022

Before Field
Translation

Std Hours

Field

None

Calculates standard
hours per pay period
from standard weekly
hours and pay

frequency of the pay
group.

000023

Record

Processing

Stop DirDp

Record

No

None

Recognizes that the
Direct Deposit code
no longer applies for
this employee. The
record containing
this process ID is
formatted.

000024

Record
Processing

Stop AdPay

Record

No

None

Recognizes that
Additional Payment
no longer applies for
this employee. The
record containing
this process ID is
formatted.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000025

Before Field
Translation

Stop Code

Field

None

Returns a Yes
indicator (a returned
value of "Y") when
one of the following
events occurs: Stop
Deduction, Stop
Direct Deposit, Stop
Additional Pay, PI
Employee ID change,
Company change or
Pay Group change.

000026

Record
Processing

Stop Ded

Record

No

None

Recognizes that the
deduction code no
longer applies for
this employee. The
record containing
this process ID is
formatted.

000027

Record
Processing

Stop Goals

Record

No

None

Recognizes that
deduction goals no
longer apply for
this employee. The
record containing
this process ID is
formatted.

000028

Before Field
Translation

Stop Date

Field

None

Returns a stop

date when any

of the following
events occur: Stop
Deduction, Stop
Direct Deposit, Stop
Additional Pay, PI
Employee ID change,
Company change and
Pay Group change.
The date supplied

is the pay begin date
minus one day. If the
event does not occur,
spaces are supplied
for the stop data.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000029

Record
Processing

Stop Save

Record

No

None

Recognizes that

the savings plan
deduction no longer
applies for this
employee. The
record containing
this process ID is
formatted.

000030

Before Field
Translation

ST Recip

Field

Yes

PIPSPADP

Creates values to
apply to the translate
table. If State 2
exists, then Field 1 is
the resident state and
Field 2 is the work
state.

000031

Record
Processing

Transfer

Record

Yes

PIPSPADP

Detects when the
transfer transaction
should be formatted.

000031

Export File

Creation

Transfer

Record

Yes

PIPXPADP

Recognizes when

the P EMPID

for an employee

has changed. The
transfer transaction is
generated to include
the appropriate
change indicators for
the fields that have
changed.

000032

Before Field

Translation

MD Local %

Field

None

Calculates the
Maryland locality
percentage. Translate
values apply only
when State 1 is
Maryland.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000033

After Field
Translation

SUI/SDI

Field

Yes

PIPSPADP

Generates an error
message and does not
export the employee's
datato ADP ifa
change is detected

in this field and the
employee has not
been assigned a new
PI_EMPLID. Use to
validate a change to
the SUI/SDI state tax
code.

000034

Before Field

Translation

>3 DirDep

Field

Yes

PIPSPADP

Edits the employee
data for more than
three direct deposit

accounts.

000035

After Field
Translation

New PI ID

Field

None

Uses the current or
"new" PI-EMPLID
when the old PI_
EMPLID is not the
same as the current PI
_EMPLID assigned
to the PeopleSoft
employee ID.

000036

Import

Processing

DPA09

Field

Yes

PIPMPADP

Saves pay date 1
from the Direct Pay
header record for
access by process
000040.

000037

Import
Processing

DPA10

Field

Yes

PIPMPADP

Saves the pay period
end date 1 from the
Direct Pay header
record for access by
process 000040.

000038

Import
Processing

DPA11

Field

Yes

PIPMPADP

Saves the pay date

2 from the Direct
Pay header record
for access by process
000040.
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Process ID

Process
Phase

Description

Type

User Defined
Process

User Exit
Program

Description

000039

Import
Processing

DPA12

Field

Yes

PIPMPADP

Saves pay period end

date 2 from the Direct
Pay header record

for access by process

000040.

000040

Import

Processing

DPB11

Field

Yes

PIPMPADP

Selects pay dates 1
or 2 from the Direct
Pay header record. PI
_CHECK key fields
are based upon the
value of this field.

000041

Import
Processing

PCX 3E8

Field

Yes

PIPMPADP

Updates PI-
BALANCE YEAR,
PI BALANCE
PERIOD and PI_
BALANCE QTR
based upon the as of
date.

000042

Import

Processing

PCX 3E9

Field

Yes

PIPMPADP

Updates all of the
current employee's
balance entries before
they are inserted in
the database.

000043

After Field
Translation

Goal Amts

Field

Yes

PIPSPADP

Paired with special
process 000044.
Does not send the
goal limit amount if
it is zero on setup.
Formats the reset of
a goal limit amount to

zero when needed.

000044

After Field

Translation

Goal Code

Field

Yes

PIPSPADP

Pairs the Goal Limit
codes with the Goal
Limit Amount.
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Process ID Process Description Type User Defined | User Exit | Description
Phase Process Program
000045 Before Field Middle Int Field No None Retrieves the person's
Translation middle initial from
the Name field.
Names are entered
last name, first name,
and middle name.
This routine takes
the first character
following the space
after the first name.
000046 Before Field Middle Nme Field No None Retrieves the person's
Translation middle name from
the Name field.
000047 Export File Skip Field Field Yes PIPXPADP | Causes the export
Creation process to bypass the
field on the output
file when the Export
Full option is used
and the field is blank.
000048 Export File Bypass Fld Field No None Bypasses the field in
Creation the output transaction
file.
000049 Record Eff Status Record No None Checks the effective
Processing status field. If it is not
active, the data will
not be formatted for
export.
000050 Record CSV Record Yes PIPSPRCS | Marks records with
Processing a stop deduction as
having a stop on the
PI Partic Export.
000200 Before Field GVT Remark Field No None (USF only) Creates
Translation an array of remarks

codes from the SF50
remarks for inclusion
in EPIC Record.
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Process ID Process Description Type User Defined | User Exit | Description
Phase Process Program
000201 Before Field Tang Amt Field No None (USF only) If
Translation Tangible Benefits > 0
sets to "Y" else blank.
000202 Before Field Intang Amt Field No None (USF only) If
Translation Intangible Benefits
>0 sets to "Y" else
blank.
000203 Export File Geo Code Field No None (USF only) Process
Creation GVT_GEOLOC CD
Code.
000204 Before Field Hire Date Field No None (USF only) Hire Date
Translation evaluation.
000205 Before Field Posn Title Field No None (USF only)
Translation Position Title Code/
Description.

Reviewing Delivered COBOL Processes for Special Events

The Definition Table component - Interface Definition Record page, Process ID field enables you to
access COBOL processes that signal special events (transactions) such as a Stop Deduction. These events
set an indicator that can be used later by another special process indicator. The following table lists the
processes that PeopleSoft Payroll Interface delivers for special events.

See Setting Up the Definition Table.

Note: The processes listed in this topic are a subset of the COBOL processes that are delivered with

Payroll Interface.

See Reviewing Delivered COBOL Processes.

See Working with Transactions.

Process ID Description Record Type Special Event

00001 ON1 Change Data Used for logical file types.
Assigned to data records for
DED CALC and savings.

000023 Stop DirDP Process Stops direct deposit.
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Process ID Description Record Type Special Event

000024 Stop AdPay Process Stops additional payment.
Assigned the stop record.

000026 Stop Ded Process Stop deduction. Assigned the
stop record.

000027 Stop Goals Process Stop deduction goal. Assigned
the stop record.

000029 Stop Save Process Stop savings plan deduction.
Assigned the stop record.

000050 Savings, Additional Pay Data Assigned to the data records

for non-logical file formats
(such as CSV) for additional
pay and savings plan before
and after tax.

These record IDs must be
named:

"SAVE" for before-tax
savings

"SPAT" for after-tax savings

"APAY" for additional pay

Creating COBOL Routines

160

You can create your own COBOL routines for use with Payroll Interface. The system isolates your
COBOL routines from the delivered Payroll Interface COBOL processes and calls them by retrieving the
name specified on the Process Table component - Interface Process Table page, User Exit Program field.

Shell programs for three user exit invocation points are provided with Payroll Interface. You can use these
programs as templates for your COBOL routines:

* PIPMPOTH: For routines performed during the Import process.

» PIPSPOTH: For routines performed during the Export process select/compare phases.
» PIPXPOTH: For routines performed during the Export process create export file phase.
To define your own COBOL routine:

1. Make a copy of the shell program that is associated with the Payroll Interface process phase in which
your special process routine will be performed.

Do not modify the shell programs. These programs are set up with all the necessary working storage
and linkage section data elements already defined and should be preserved as modules for future
development.
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2. Change all references to the shell program name to the name of your new routine.

Follow the PeopleSoft naming convention to make it easier to identify the timing of your own
routines. You should change the last three characters of the program name to the system ID for which
the routine is written. For example, the ADP system ID has three routines: PIPMPADP, PIPSPADP,
and PIPXPADP.

Select a process ID for your new routine.

Review copy member PICPRCSW.CBL and select an unassigned number between §0000 and §99999.
These numbers will not be used by PeopleSoft development. Add an 88 level description for your new
routine in the copy member. Code your program logic and compile your program.

Define your new routine to Payroll Interface by setting up a process ID using the Process Table
component.

Note: For AS400 and Oracle/VMS platforms, you must specify the calls to your user exit programs in
copy member PICUEXIT.CBL. Edit this copy member to add your new program in the appropriate place.

Related Links
Setting Up the System Table

Setting Up the Process Table

Working with Smart Select

The Select Type field on the Import/Export Payroll Data component - Import/Export Payroll Data page
has three options: A/l Employees in Group, Manually Select, and Smart Select. The Smart Select option
provides substantial performance benefits by enabling you to process only those employees who have had
online changes since the last time the Export process was run.

When deciding whether to use Smart Select, consider the following:

Smart Select is recommended for use with very large companies.

To activate Smart Select, you must add a PeopleCode function, UPDATE SMARTSELECT, to each
EMPLID-keyed table that is set up in the PS Tables component—including those EMPLID-keyed
tables that are referenced indirectly through views.

When data changes in these tables, a record that includes the EMPLID and EMPL_RCD key
fields, as well as the data change, is written to the PS_PI PRESELECT table. When you run the

Export process using the Smart Select option, Payroll Interface processes only those records in the
PS_PI_PRESELECT table.

Smart Select detects online changes only.

At least once per payroll cycle you should run the Export process with the A4/l Employees in Group
option selected to process records that have changes but do not have the PeopleCode function
attached, or to process records that have changes that were made outside of the online system (for
example, deduction calculations or a batch update to your employees).
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Note: If you update employees other than online, but they represent only a small percentage of all
employees, you can manually update the PS PI PRESELECT table for these employees and then run

the Export process with the Smart Select option selected.

Smart Select detects changes to EMPLID-keyed tables only. You should run the Export process with
the All Employees in Group option selected whenever you change the Payroll Interface definition,
change any tables referenced in the PS Tables component that is not keyed on the EMPLID field, or

are processing a group of employees for the first time.

Activating Smart Select

Payroll Interface provides a PeopleCode function, UPDATE _SMARTSELECT, which tracks online
changes and makes the information available to the Export process. To activate Smart Select, you must
add this function to each EMPLID-keyed table that is referenced by the PS Tables component—including
those EMPLID-keyed tables that are referenced indirectly through views. The example in this topic shows
how to activate Smart Select for the Citizenship table (record). Follow these same steps to activate Smart
Select for other EMPLID-keyed tables.

To activate the Smart Select code for the Citizenship table:

L.

2.

Start PeopleSoft Application Designer.

Select File, Open.

The Open Definition dialog box appears.

From the Open Definition dialog box, do the following:

e For the Definition field, select Record.

e For the Name field, enter CITIZENSHIP.

* Select Open.

The CITIZENSHIP (Record) dialog box appears.

Select View, PeopleCode Display.

The CITIZENSHIP (Record) dialog box displays a grid.

For the EMPLID field, locate the SPo (SavePostChange) cell in the grid.
PeopleCode may or may not be indicated for the EMPLID field in the SPo cell.

Double-click the SPo cell to open the PeopleCode editor.

The CITIZENSHIP.EMPLID.SavePostChange (Record PeopleCode) dialog box appears.

For the EMPLID field, add the following PeopleCode:

Declare Function UPDATE SMARTSELECT PeopleCode
PI PRESELECT.PI SELECT TYPE FieldFormula;

For the EMPLID field, add the following PeopleCode:
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* IfEMPL RCDis a field in the CITIZENSHIP table, add:
UPDATE SMARTSELECT (EMPLID, EMPL RCD, 'Y');
 IfEMPL RCD is not a field in the CITIZENSHIP table, add:

UPDATE SMARTSELECT (EMPLID, 0, 'N');

Note: The 'Y' or 'N' at the end of the parameter list indicates whether EMPL_RCD exists in the
record. If it does not exist, then all jobs for a multijob employee will be processed in the next
Smart Select export.

9. Save the PeopleCode and the table (record).
This example shows the Citizenship table (record):

This example illustrates the fields and controls on the CITIZENSHIP table (record).

{5 CITIZENSHIP (Record) E o ] |
Record Fields IRBC.;.M Type I
Hum Field Hame Type | FCh| FFo| Rin| Bls |RDe| BSe| SEd| 5Pr| 5Fo| Sil | 515 | Wrk| PPr
2 |DEPEMDENT_ID Char v
3 |[COUNTRY Char W W "
4 |CITIZENSHIP_STATUS Char v v
5 |CITIZEN_SGF_SER SRec
4] [»]

This example shows the PeopleCode that is required to activate Smart Select:

This example illustrates the fields and controls on the PeopleCode function UPDATE SMARTSELECT.

[ CITIZENSHIP.EMPLID.SavePostChange (Record PeopleCode) =10l =l
| EMPLID ([field) jlﬁavePustEhange j
Declare Function PanelGroupPublish PeopleCode FUNCLIE HE.PGPUELISH FieldFormula; o
Declare Function UPDATE_SHMARTSELECT FPeopleCode PI_PRESELECT.FPI_SELECT_TYPE FieldFormula;
UPDATE_SMARTSELECT (EMPLID, O, 'N');
PanelGroupPublishiCreateMessage (Message. PER30N VIS4 CITIZEN 3YNC), GetLewvelO(),
& PUBNODENAME) ;| - - =

PeopleCode Function UPDATE_SMARTSELECT

The PeopleCode function UPDATE _SMARTSELECT tracks and records online data changes using the
PS PI PRESELECT table.

Function UPDATE SMARTSELECT (&EMPLID, &EMPL RCD, &EMPL RCDN FLAG)
&COUNT = 0; SQLExec ("SELECT COUNT (*) FROM PS PI PRESELECT

WHERE EMPLID=:1 AND EMPL RCD = :2 AND PI SELECT TYPE='C' AND

PI RUN NUM= 0", &EMPLID, &EMPL RCD, &COUNT); If &COUNT > 0 Then
SQLExec ("UPDATE PS PI PRESELECT SET DATETIME STAMP=%CurrentDateTimelIn
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WHERE EMPLID=:1 AND EMPL_RCD = :2 AND PI_SELECT_TYPE='C' AND

PI RUN_ NUM= 0", &EMPLID, &EMPL_RCD); Else SQLExec ("INSERT INTO

PS PI PRESELECT (PI_SELECT_TYPE, EMPLID, EMPL RCD, DATETIME STAMP,

EMPL RCDN FLAG,PI RUN NUM) VALUES ('C',:1,:2,
%CurrentDateTimelIn, :3,0)", &EMPLID, &EMPL RCD, &EMPL RCDN FLAG); End-
If; End-Function;

Working with Transactions

This topic provides an overview of transactions and discusses how to:

Set up a transaction.
Set up a stop transaction.
Verify a transaction.

Verify a stop transaction.

Understanding Transactions

The LOG sample data that is delivered with Payroll Interface includes transactions and corresponding
stop transactions for deductions, savings plans, and additional pay. This topic describes how to set up the
transaction and the stop transaction for deductions using the LOGEXP export file.

When setting up transactions, the implementation details will vary depending on the type of transaction
and the requirements of the third-party payroll system. The following procedures, however, show which
Payroll Interface components need to be defined.

To set up a transaction:

1.

2.

3.

4,

Set up the PS Tables component—identify the tables and fields that are required for the transaction.
Set up the Field Definition Table component—define the fields that will be included in the export file.

(Optional) Set up the Instance Table component—create an instance ID if you want to restrict or
modify the data that is sent to the third-party payroll system.

Set up the Definition Table component—define the transaction record and field sequences.

To set up a stop transaction:

1.

2.

Set up the Field Definition Table component—define the fields that will be included in the export file.

Review the Process Table component—identify the COBOL process that will perform the stop
transaction.

Set up the Definition Table component—define the stop transaction record and field sequences.

Setting Up a Transaction

Follow these steps to set up a deduction transaction using the LOGEXP export file.

164
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Step 1: Set Up the PS Tables Component

Setting

Up a Payroll Interface Definition (Part 2)

Identify the PeopleSoft tables and fields that store the data that is required for the transaction:

* Table: DED _CALC.

* Fields: DEDCD (deduction code), DED CLASS (deduction class), and DED CUR (deduction

amount).

Use the PS Table (PI PSREC PNL) page to set up the PeopleSoft table and fields:

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > PS Tables > PS
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Table
This example illustrates the fields and controls on the PS Tables page for Step 1: Set Up the PS Tables
Component.
PS Tables
Details Find | view Al First ‘& 1 of 1 &/ Last
SystemID LOG Logical File Sample [+ [=]
Record (Table) Name DED_CALC
Description IEl]
‘Process Type | Export LY
‘Where Clause Type | |0, EfDt= Pay End Dt v
Paygreup Company in Where Opata Required
O Payaroup Country in Where aob pata
IDed calc Data
Field Details Personalize | Find | view Al | B B First ™ 1-30711 ¥ Last
LA ‘Field Hame ! Collate Order Ife_\.' Effective Date Effective Sequence
Button by Field
Fleld Atrbute BEMEFIT_FLAN Q, O O = =
Fleld Attribute CALCULATED_BASE @, O O o =
Fleld afiibute COMPANY @, O O = =

Step 2a: Set Up the Field Definition Table Component, Export File Fields

Define the fields for the deduction transaction: DEDAMT (shown in the following example) and DEDCD
(not shown).

The default value for DEDAMT is the calculated deduction amount. The default value for DEDCD is the
deduction code.

Note: The DED CLASS field, identified in the PS Tables component, is not included in the export file.
However, an instance ID for this field is set up in step 3.

Use the Interface Field1 page to set up the field definition for the DEDAMT field.
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Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition
Table > Interface Fieldl

This example illustrates the fields and controls on the Interface Field1 page for Step 2a: Set Up the Field
Definition Table Component, Export File Fields.

Interface Field1 Interface Fiald2
SystemID LOG  Logical File Sample FieldID DEDAMT
Field Definition Find | Wiew Al First' ' 1 of 1 2 Last
‘Effective Date |01/01/1980 |3 ‘Status | Active v +][=]
Description Deduction Amount Short Desc |Ded Amount
External Field ID AMOUNT Process Type | Export b
‘Type | Sianed Mumber v Text
External Column Name Drefault Value
Field Farmat
*Field Length {in bytes)| 10 Decimal Length | 2 [“lpisplay Decimal Decimal Char |.
Integer Length [ Round Decimal | Standard Rounding Rules w Cetank if Zero
Sign Position | Trailing v Negative - Cuse Positive Sign
Justification | Left v Pad Character
Date Format Remove Trailing Spaces
Null Blank Character Flds Null Zero Numeric Flds

Step 2b: Set Up the Field Definition Table Component, PeopleSoft Table and
Fields

Identify the corresponding PeopleSoft table and field for the DEDAMT field:
» Table: DED CALC

«  Field: DED_CUR

Chapter 10

Note: You must set up the DED CALC table and DED CUR field in the PS Tables component before
you can access them through the Field Definition component.

Use the Field Definition Table - Interface Field2 page to identify the PeopleSoft record (table) and fields:
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition
Table > Interface Field2
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This example illustrates the fields and controls on the Interface Field2 page for Step 2b: Set Up the Field
Definition Table Component, PeopleSoft Table and Fields.

Interface Field1 Imerface Field2
SystemID LOG  Logical File Sample Field ID CEDAMT
Field Definition Find | Wiew Al First ‘&' 1 0f1 2 Last
Effective Date 01/01/1980 Description Deduction Amaurnt [+ [=]
PS Record Name DED_CALC @, Process ID a
PS Field1 Name DED_CUR @, PS FHeld2 Name @
PS Field3 Name @, Pl Translate Indicator | Mo Translate Yalues he
Instance ID @,
Translate YWalues Personalize | Find | View sl | 20 1B First 0 1 af1 2 Last
'PS Value 1 PS Walue 2 PS Value 3 Pl Value
[+ [=]

Step 3: (Optional) Set Up the Instance Table Component
Instance IDs enable you to restrict or modify the data that is sent to the third-party payroll system.

Deduction class values are A (after tax), B (before tax), N (non-taxable or employer paid), and T (taxable
or imputed income). The Calculate Deductions process calculates deductions for all classes (A, B, N, T).

In this example, the third-party payroll system wants to receive deductions only for class values A and B.
Therefore, set up an instance ID DEDCLS for the DED CLASS field to export calculated deductions for
class values A and B. (Alternatively, you can set up the instanced ID to exclude class values N and T.)

Note: When setting up an instance ID, you can either include the values that you want to export or
exclude values that you don't want to export. You may need to experiment to determine which set up
works best. Alternatively, you can create a view to retrieve a restricted data set.

Use the Interface Instance Table page to set up instance IDs.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Instance Table >
Interface Instance Table
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This example illustrates the fields and controls on the Interface Instance Table page for Step 3: (Optional)

Set Up the Instance Table Component.

Interface Instance Table
SystemID LOG Logical File Sample
Instancell DEDCLE
Diefinition Find | Yiew Al
Effective Date |01/01/1 980 E{J Description Include Deduction Types
Short Description Ded Types *Instance Indicator
PeopleSoft Record Name |DED_CALC OJ PeopleSoft Field1 Name DED_CLASS OJ
Include Exclude Indicator | Include Values v
Instance Information Personalize | Find | Wiew All | (ET | = First' 4 1-30f3 '*' Last
‘Sequence Field1 Value
1 A [+ [=]
2 B ESNE
; T = =

First 4 1 af1 '» Last

[#[=]

Step 4a: Set Up the Definition Table Component, File

Define the file, record, and field sequences for the export file.

Note: If you change any of the records or fields for a transaction, be sure to make the same changes to the

records or fields for the corresponding stop transaction.

Use the Interface Definition File page to access the LOGEXP export file.

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition

Table > Interface Definition File

This example illustrates the fields and controls on the Interface Definition File page for Step 4a: Set Up

the Definition Table Component, File.

Interface Definition File Interface Definition Record Interface Definition Fields

File I LOGEXF

System ID |LOG |G | agical

Process Type | Export v
File Type | Logical | [¥] convert Case
Pl Record Length an Max Fields Per Output Rec
Data Delimiter I_ External Field ID Indicator |/

File ID Definition Find | Wiew Al First' 4 1 af1
‘Effective Date 010111950 5] ‘Status
Description Logical Export Sample Short Desc Logical

Include Header

b | ast

[+ (=]
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Step 4b: Set Up the Definition Table Component, Record

The LOGEXP export file includes nine record sequences. Record 40 is the deduction transaction. Record
50 is the deduction stop transactions.

Record Sequence Record ID Description

10 PERS Personal Data

20 EMPL Employment Data
30 JOB Job Data

40 DED Deductions

50 SDED Stop Deductions

60 SAVE Savings

70 SSAV Stop Savings

80 APAY Additional Pay

90 SPAY Stop Additional Pay

Record 40, the deduction transaction (DED), includes:

* Record type: Data

» Instance ID: DEDCLS—the instance ID created in step 3.

*  Process ID: 000001 ON1 Change—a process required for the deduction transaction.
Use the Interface Definition Record page to set up the record sequences for the export file.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition Record

Copyright © 1988, 2026, Oracle and/or its affiliates. 169



Setting Up a Payroll Interface Definition (Part 2) Chapter 10

This example illustrates the fields and controls on the Interface Definition Record page for Step 4b: Set
Up the Definition Table Component, Record.

Interface Definition File Interface Definition Eecord Interface Definition Fields

File I LOGEXF

File 1D Definition Find | Wiew All First ‘4" 1 of1 B Last
‘Effective Date [01/01/1980 |5 ‘Status [ Active v #H[=
Description Logical Export Sample Short Desc Logical

SystemID LOG |G, [ qgical

Process Type | Export w
File Type | Lonical v Convert Case Include Header
Pl Record Length an Max Fields Per Output Rec ]
Data Delimiter I_ External Field ID Indicator |y

Step 4c: Set Up the Definition Table Component, Fields
Record 40, the deduction transaction, includes five field sequences:

e Field Seq#: 10-50.

* Field Seq 40 and 50 are a grouped field (Group ID 001).

* Field Seq 50 is DEDAMT, the actual deduction amount.

Note: The field sequences (10-50) for transaction record 40 must be identical to the field sequences for
stop transaction record 50. The value of field sequence 50 changes from DEDAMT to ZAMT.

Use the Interface Definition Fields page to set up the field sequences for the record:
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition Fields

This example illustrates the fields and controls on the Interface Definition Fields page for Step 4c: Set Up
the Definition Table Component, Fields.

Interface Definition File Interface Definition Record Interface Definition Fields
File ID Find First 4 1 0f1 2 Last
File ID LOGEXP Logical Export Sample Effective Date 015011380 ﬂ ﬂ
Definition Find | iew All First 4 4 ofg " Last
Rec SeqNbr 40 RecordID DED  Deduction Data [+ =]

PS Record DED_CALC

Fields Personalize | Find | Viewall |E5 B First @) 15075 ) Last
zi:(I:lllence Redefine  Field ID Description Posi‘i‘:; Le:';[': Field1 llame ':3'.:;2" R?’i;'l:“e “Key Field Group ID

10 il CMPKEY @, Company Key 1 a COMPARY Record Lavw @, =+ =]
20 (| EMFLID &, EMPLID 10 & Record Lavw @, [+ [=]
30 ] BLMK4 @, 4 Blanks 16 4 Record Levw @, [+ [=]
40 ] DEOCD @, Deduction Code 70 10 DEDGD Occurtence s | 001 (@ =+ =]
50 O DECAMT @, Deduction Amount a0 10 DED_CUR O Mota KeyFlw| (001 |3, [+ [=]
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Setting Up a Stop Transaction

Setting Up a Payroll Interface Definition (Part 2)

Follow these steps to set up a stop transaction for deductions using the LOGEXP export file.

Step 1: Set Up the Field Definition Table Component, Export File Fields

For Payroll Interface to recognize a stop transaction, the delivered record-level process IDs must be used.
PeopleSoft code moves the pay period end date (of the pay calendar entry being used with the run control)
to the DATE VAL field in the PI PARTIC EXTBL table when a stop process is identified. Along with
the date, you'll see the corresponding field ID and CHAR VAL (for example, for a deduction code).

See Export Processing.

Define the field for the deduction stop transaction: ZAMT. When the stop transaction is processed, the
ZAMT default value, rather than the DEDAMT default value, is written to the export file.

The default value is determined by the requirements of the third-party payroll system (refer to the vendor
documentation). For LOG systems, the default value may be 000.00 or zero. For CSV systems, the default

value may be probably ~, the tilde character.

Use the Interface Fieldl page to set up a field definition for the ZAMT field:

Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition

Table > Interface Fieldl

This example illustrates the fields and controls on the Interface Field1 page for Step 1: Set Up the Field

Definition Table Component, Export File Fields.

Interface Field1 Interface Field2

System ID CSV
Field Definition

CSV Sample Layout

*Effective Date 01/01/1920 |[H
Description |Deduction Code

External Field ID

External Column Name |Deduction Code
Field Format
*Field Length (in bytes) 8 Decimal Length l_
Integer Length Round Decimal
Sign Position
Justification | |_eft v

Date Format

Null Blank Character Flds

*Type | Character v

Field D D001
Find | View All
*Status | Active v
Short Desc |Ded Cd
Process Type | Export w
Text
Default Value ZZ
Display Decimal
Blank If Zero

Negative |—

Pad Character |

Use Positive Sign

Remove Trailing Spaces
Null Zero Numeric Flds

First ' &' 10f 1®' Last

FHE

Note: Because the ZAMT field does not correspond to a PeopleSoft table or field, the Interface Field2

page does not need to be set up.

Step 2: Review the Process Table

Identify the COBOL process that will perform the stop transaction. This can be one of the processes
delivered with Payroll Interface or a user-defined process. In this example, use Payroll Interface Process

ID 000026.
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See Working with COBOL Processes.

After the process is attached to the stop transaction record (see step 3), it runs in the background during
the Export process. If the process determines that a deduction code is missing, the ZAMT default value
(rather than the DEDAMT default value ) is written to the export file and a flag on the PI PARTIC_EXPT
table is set to P.

See Export Processing.

Use the Interface Process Table page to view the processes that are delivered with Payroll Interface.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Process Table >
Interface Process Table

This example illustrates the fields and controls on the Interface Process Table page for Step 2: Review the
Process Table.

Interface Process Table

Process Details Find | View All First'4' 10f1'®' Last
+|[=
Process ID 000001 J J
*Pl Process Phase | Record Processing v Short Description Ded End Dt
*Type | Record v

[Juser Defined Process

Process Description [Deduction End Date. When the primary PeopleSoft source for the transaction is Ed
Additional Earnings, the earnings end date is matched against the Pay End Date to
determine if the Additicnal Earnings should be stopped.

Returned Values Personalize | Find | view Al | 2 | E First ‘4" 1 of1 ‘&' Last

Returned Value Description

Step 3a: Set Up the Definition Table Component, File
Define the file, record, and field sequences for the export file.

Use the Interface Definition File page to access the LOGEXP export file.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition File

Copyright © 1988, 2026, Oracle and/or its affiliates.



Chapter 10

This example illustrates the fields and controls on the Interface Definition File page for Step 3a: Set Up
the Definition Table Component, File.

Interface Definition File || Interface Definition Record || Interface Definition Fields

File ID LOGEXF

File ID Definition Find | View All First' ' 1 of 1 &' Last

*Effective Date |01/01/1280 | *Status | Active A% [+][=]

Description |Logical Export Sample Short Desc Logical
SystemID|LOG &, | icq
Process Type | Export w
File Type | Logical hd [¥] convert Case Include Header
Pl Record Length| 80 Max Fields Per Qutput Rec| 5
Data Delimiter |_ External Field 1D Indicator Y

Step 3b: Set Up the Definition Table Component, Record
Record 50, the deduction stop transaction (SDED), includes:

* Record Type: Process

» Base Rec: 40—the corresponding record for the deduction transaction.

e Process ID: 000026—the process that stops the deduction.

Setting Up a Payroll Interface Definition (Part 2)

Note: The Base Rec field joins the transaction to the stop transaction: record 40 is joined to record 50.

Use the Interface Definition Record page to set up the record sequences for the export file.
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition Record
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This example illustrates the fields and controls on the Interface Definition Record page for Step 3b: Set
Up the Definition Table Component, Record.

Interface Definition File || Interface Definition Record Interface Definition Fields
File 1D Find | View All First'4' 1 of 1 '/ Last
File ID LOGEXP Logical Export Sample Effective Date 01/01/1980 (#[=]
Record Definition Find | View All First'4' 4 of 9 '®' Last
Rec SeqNbr| 40 Record IDDED *Record Type | Data hd ﬂ ﬂ
Description|Deduction Data
PS Record DED_CALC OJ Base Rec l_
*Occur Ind | Multi Recs to Multi Defn Recs v
InstancelD DEDCLS@, Ded Types Record Terminated Value
Process ID|000001 [, 0NA1 Change Record Terminated Length 1
Description

Step 3c: Set Up the Definition Table Component, Fields
Record 50, the deduction stop transaction, includes five field sequences:
* Field Seq#: 10-50.

* Field Seq 40 and 50 are a grouped field (Group ID 001).

* Field Seq 50 is now ZAMT, the zero amount that is sent when the deduction is stopped.

Note: The field sequences (10-50) for stop transaction record 50 must be identical to the field sequences
for transaction record 40. The value of field sequence 50 changes from DEDAMT to ZAMT.

Use the Interface Definition Fields page to set up the field sequences for the record:
Navigation:

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition
Table > Interface Definition Fields
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This example illustrates the fields and controls on the Interface Definition Fields page for Step 3c: Set Up
the Definition Table Component, Fields.

Interface Definition File || Interface Definition Record || Interface Definition Fields
File ID Find First ‘& 1 of 1 &' Last
File D LOGEXP Logical Export Sample Effective Date 01/011980 EE
Definition Find | View All First ‘4 5 0fa ‘&) Last
Rec SeqMbr 50 RecordD SDED  Stop Deductions # =
PS Record DED_CALC
Fields Persanalize | Find | view all | &2 | E First ‘4 1-5 of 5 &/ Last
;‘:CI:I.‘IEHCE Redefine Field ID Description Pos?t‘\ao: Lei:;lrc': Field1 Name ng;:n Re;‘zrl:‘se *Key Field Group 1D
10 0 CMPKEY|@, Company Key 1 9 COMPANY Q, [+] [=]
20 O EMFLID [3, EWPLID 10 5 @, [+ =
30 O  [BLnks |3, ¢Blanks 18 4 Q # =]
40 O DEDCD |@, Deduction Code 20 10 DEDCD 001 |@, [#] [=]
50 O [zawT @ zeroAmount 30 10 o1 |@, FHE

Verifying a Transaction
To verify the transaction:
1. Run the Calculate Deductions and Confirmation processes.

2. Run the Export process.

Step 1: Run the Calculate Deductions and Confirmation Processes

Calculate and confirm the deductions for the employee.

Use the Calculate Deductions page to calculate the deductions:

Navigation:

Payroll Interface > Pay Period Deductions > Calculate Deductions > Calculate Deductions

This example illustrates the fields and controls on the Calculate Deductions page for Step 1: Run the
Calculate Deductions and Confirmation Processes.

Calculate Deductions

Run Controd ID PS  Report Manager Process Manitar Run

Run Parameters

Pay Run ID KUS-00-01 &, KUS-00-01

Select Deductions to Calculate

(& Only Calculate Where Needed
) (Re)Calculate All Checks
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Review the results. The employee has medical and dental before-tax and nontaxable deductions.
However, because the DEDCLS instance ID is set up, only the before-tax deductions will appear in the

export file.

Use the Review Deductions page to review deductions.

Navigation:

Payroll Interface > Pay Period Deductions > Review Deductions > Review Deductions

This example illustrates the fields and controls on the Review Deductions page for Step 1: Run the
Calculate Deductions and Confirmation Processes.

Review Deductions
Deduction Details

Employee 1D KUI011
Empl Record 0

Name William Fraas
Deductions
Benefit .

Plan Type Plan Deduction Class
Medical KUHMO1  Before-Tax
Medical KUHMO1  MNontaxable
Dental KUDEMZ  Before-Tax
Dental KUDEMZ  MNontaxable

Deduction
Code

KUHMOK

KUHMOK

KUDEMS
KUDEM9

Personalize | Find | view Al | 2 | E First ‘& 1-4 of 4 &) L ast

Description

Kaiser HMO
Kaiser HMO
Dental Plan

Dental Plan

Company GBI
Pay Group KLZ2
Pay End Date 01/02/2000

Current Coverage Current Deduction
Deduction Base Payback

59.77

60.00

Step 2: Run the Export Process

Use the Import/Export Payroll Data page to run the Export process:

Navigation:

Payroll Interface > Payroll Data Exchanges > Import/Export Payroll Data > Import/Export

Payroll Data
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This example illustrates the fields and controls on the Import/Export Payroll Data page for Step 2: Run

the Export Process.
Import/Export Payrell Data
Run Control ID PS Report Manager Process Monitor Run
Run Parameters
*Pay Run 1D |KU8-00-01 @ KUs-00-01 Run T‘;'F'E| Export -
*PI Run Option | Mew v *Pl Run Number|
Check Point Interval
Export Options
*Select Type | All Employees in Group | ] Run Select and Compare Only
*Export Change or FLIII|FL|II Set of Records vl [ exclude Calculated Deductions
Reprocess [¥] Active Employees
Compare Export

Review the export file. Because the instance ID DEDCLS is set up, only the before-tax deductions appear
in the export file. Notice, however, that the transaction has worked. The DEDAMT or 59.77 value appears
in the export file for deduction code KUHMOK:
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This example illustrates the fields and controls on the Export file showing the transaction for deduction

KUHMOK is the amount of 59.77.

GEI KUIOL1L ID

GET KUTO11 LAST

GET KUTO11 FIRST

GET KUTO11 ADDRESS

GET KUTO11 ADDRESSZ

GET KUTO11 CITY

GET KUTO11 STATE

GET KUTO11 ZIP

GET KUIO1L1 PHONE

GET KUTO11 SENLIM

GET KUTO11 HIREDATE

GET KUTO11 REHIREDT

GET KUTO11 SERWDT

GET KUIO1L1 BEIRTHDATE

GET KUTO11 LAST_DAY

gﬁl KUTO11 TERMDATE
BI KUTO11 ORTGHIRE

GET KUTO11 SEX

GET KUTO11 TITLE

GET KUTO11 HOEPT

GET KUTO11 JOETITLE

GET KUIO1L1 HCCODE

GET KUTO11 EMPTYPE

GET KUTO11 STATUS

GET KUTO11 ST_CLASS

GET KUTO11 CYCLE

GET KUIO1L1 SAL_HR

GET KUTO11 STOHRS

GET KUTO11 RATEL

GET KUTO11 LASTRATISE

GET KUTO11 SHIFTL

GET KUTO11 PAYEYEX

GET KUTO11 OTEXEMPT

GET KUTO11 FLSA

GET KUIO1L1 SUPERMAME

GET KUTO11 PAYGROLP

GET KUTO11 DEDUCTION

GET KUTO11 DEDUCTION

RUICLL

FRAAS

WwILLIAM

310 DOMTELL ST.

KERMVILLE
CA

032238
5256947011
5350555000
03,/15/19%90

03,/15,/1550
01,/08,/15851

02,715,/1550
]

62000
820050
8200530
=

A

RFT

wf

=
Qooo40, 00
000000080000, 0000

M
W
b
E
KUS

L HMO R AMOUMT
EUDEMS AMOUMT

Qooos9e, 77
QOooor. 7o

Verifying a Stop Transaction

To verify the stop transaction:

1. Terminate one of the benefits for the employee.

2. Run the Calculate Deductions and Deduction Confirmation processes.

3. Run the Export process.

Step 1: Terminate a Benefit

Terminate the medical benefits for the employee, deduction code KUHMOK.

Use the Health Benefits page to terminate the medical benefits.

Navigation:
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Workforce Administration > Benefit Information NLD > Enroll in Benefits > Health

Benefits > Health Benefits

This example illustrates the fields and controls on the Health Benefits page for Step 1: Terminate a

Benefit.

Health Benefits

William Fraas Employee
Plan Type
Plan Type 10 Iedical
Coverage

*Coverage Begin Date |03/15/1930 |5 L)
Coverage Election

® Elect

1+

O waive O Terminate

Benefit Program GBI US Pgm

Benefit Plan [KUHWO1 [, 1qgical HIO Plan 1

Coverage Code 4 Family
Health Provider ID
Employee Status Active

Enrall All Dependents

Dependent/Beneficiaries

g li] Hame Relationship to Employee
04 [@, FraasJennifer Spouse

02 [@, Fraas Jeffrey Child

[+

I KUIo Benefit Record Number 0
Find | View All First'® 1 of 2 &) | ast
[+ [=]
Find | View Al First & 1 of 1 @/ Last
*Deduction Begin Date [03/151990 |5 ==

*Election Date |03/15/1990 Eﬂ

Option Code Ad

O Previously Seen

Personalize | | ] 1-2 of 2

Health Provider ID ?;:; Covered Person Type Age Limit Flg
O Spouse M [=]
O] child Y =

Step 2: Run the Calculate Deductions and Confirmation Processes

Calculate and confirm the deductions for the employee. The terminated medical benefits no longer appear.

Use the Review Deductions page to review the deductions.

Navigation:

Payroll Interface > Pay Period Deductions > Review Deductions > Review Deductions

This example illustrates the fields and controls on the Review Deductions page for Step 2: Run the
Calculate Deductions and Confirmation Processes.

Review Deductions
Deduction Details

Employee ID KUI011
Empl Record 0

HName William Fraas

Deductions

Plan Type Elear;e e Deduction Class geoccllic s
Medical KUHMO1  Before-Tax KUHMOK
Medical KUHMO1  Nontaxable KUHMOK
Dental KUDEMZ  Before-Tax KUDEMS
Dental KUDEMZ  MNontaxable KUDEMS9

Company GBI
Pay Group KUS&
Pay End Date 01/02/2000

Personalize | Find | View All | | = Eirst 4 1-4 of 4 ‘' Last
Description Currgm Coverage Current Deduction
Deduction Base Payback
Kaiser HMO 50,77
Kaiser HMO 60.00
Dental Plan 779
Dental Plan 1.85
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Step 3: Run the Export Process

Chapter 10

Run the Export process and review the export file. Notice that the stop transaction succeeded. The ZAMT
or 000.00 value appears in the export file for deduction code KUHMOK, the terminated medical benefit.

This example illustrates the export file showing the stop transaction for deduction KUHMOK is the
amount of 00.00.

GBI
GBI
GBI
GBI
GBI
GBI
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GBI
GBI
GBI
GBI
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GBI
GBI
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GBI
GBI
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GBI
GBI
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GBI
GBI

EUIO11
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EUTO11
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EUIO11
EUIO1L
FUIO1L
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EUIO11
EUIO1L
EUIO11
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FUIO1L
EUTO11
EUIO11
EUIO11
EUIO1L
EUIO11
EUTO11
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EUIO11
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EUIO11
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EUIO11
EUIO11
EUIO1L
EUIO11

I

LasT
FIRZT
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PHOME
SSmMUM
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REHIREDT
SERVDT
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LasT_DAay
TERMDATE
ORIGHIRE
SEX
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HOEPT
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EMPTYPE
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Y CLE
Sal_HR
STODHRS
RATEL
LASTRAISE
SHIFTL
Py EYER
OTEXEMPT
FLZA,
SUPERMAME
PaGROUP
DEDUCTION
DEDUCTION

FUIO11

wWILLIAM
310 DOMTELL ST.

KERMWILLE
A

032238
525604 7011
550555001
03,15 ,/1950

03,15,/1950
01,/08 /15951

03,/15,/15580
M

63000

820050

520050

5

A

RFET
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Qooo4a, ao
QOO0OOOI0000, 0000

m-= ==
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Q00007 .70
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Maintaining Payroll Data

Understanding Payroll Data

After the interface definitions are set up and payroll processing has commenced, Payroll Interface
enables you to maintain certain payroll data, including additional pay, general deductions, employee tax
withholding information, direct deposits, and information for employees with multiple jobs.

Maintenance tasks include the initial setup of the component pages followed by the additions, changes, or
deletions that normally occur to payroll-related data over time. Because most of the payroll data works in
conjunction with other information that you are required to set up for Payroll Interface, the maintenance
tasks are discussed in this topic as well as other related setup topics in this product documentation.

Note: Depending on the requirements of the third-party payroll system, you may not need to maintain all
of the data that is discussed in this topic. Or if the data is required, to simplify data entry, conversion, and
maintenance issues, it may be easier to have the third-party payroll system manage the data.

This diagram illustrates the types of payroll data that you may need to maintain:

This diagram illustrates the types of payroll data that you may need to maintain.

Federal Taxes
Tax Data State Taxes
Local Taxes
L
fﬁ -+ Deduction Data General Deductions
Employee Pay Additional Pay
Data
Other Pay Data Savings Bonds
Direct Deposit
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Maintaining Additional Pay
To maintain additional pay, use the Additional Pay (ADDITIONAL PAY) component.

Related Links
Setting Up and Maintaining Additional Pay

Maintaining General Deductions

To maintain general deductions, use the General Deduction (GENL _DED DATA) and Override General
Deductions (GENL DED OVERRIDE) components.

Related Links
Setting Up and Maintaining General Deductions

Maintaining Tax Distribution Data

To maintain tax distribution data, use the Tax Distribution Data USA (TAX_DISTRIBUTION) and Tax
Distribution Data CAN (TAX_ DISTRIBUTION) components.

Related Links
(CAN) (USA) Setting Up and Maintaining Tax Distribution Data

Maintaining Employee Tax Data

To maintain employee tax data, use the Employee Tax Data USA (TAX_ DATA) and Employee Tax Data
CAN (TAX DATA CAN) components.

Related Links

(USA) Setting Up and Maintaining U.S. Employee Tax Data
(CAN) Setting Up and Maintaining Canadian Employee Tax Data

(CAN) (USA) Setting Up and Maintaining Direct Deposit

For information on setting up direct deposits of employee pay, see:

*  Payroll for North America,“Setting Up Banks and Direct Deposit” (PeopleSoft Payroll for North
America)

*  Payroll for North America,“Setting Up Direct Deposits” (PeopleSoft Payroll for North America)
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Setting Up and Maintaining Optional Payroll Data

To set up and maintain optional payroll data, use the Payroll Options (PAYROLL DATA) component.

Pages Used to Set Up and Maintain Optional Payroll Data

Page Name Definition Name Usage

Payroll Options 1 Page PAYROLL DATALI Set up paycheck delivery and
distribution options.

Payroll Options 2 Page PAYROLL DATA2 Set up paycheck location and payroll
deduction subset options.

Understanding Optional Payroll Data

Optional payroll processing information, such as check distribution and deduction subset options, is often
necessary when employees have multiple jobs or have multiple jobs and need to be paid through more
than one payroll system.

If you are setting up multiple jobs:

* Calculate Deductions — Follow guidelines in your PeopleSoft Benefits Administration product
documentation.

* Benefit Deductions — Follow guidelines in your PeopleSoft Benefits Administration product
documentation.

* General Deductions — Set up and maintain the Payroll Options component, Payroll Options 2 page.

See Payroll Options 2 Page.

Payroll Options 1 Page

Use the Payroll Options 1 page (PAYROLL DATAL) to set up paycheck delivery and distribution
options.

Navigation:

Payroll Interface > Update Payroll Information > Payroll Options > Payroll Options 1
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This example illustrates the fields and controls on the Payroll Options 1 page.
Payroll Options 1 Payrall Dptions 2
Charles Koberg I KLIO00G Company GBI

Paycheck Delivery Option

® Company Distribution O postal Service

Distribution kail Option

® Home Address )] Mailing Address

Employee's Current Address

Country LISA Lnited States

Address 274 Wwestheimer Rd.
Houston, Tx 77063

O Check Address Update Check Address

Paycheck Delivery Option

Field or Control

Description

Company Distribution

Select to indicate that the check should be handed out as part
of a regular company distribution.

Postal Service

Select to indicate that the check should be mailed using the
Postal Service.

Distribution Mail Option

Use the options in the Distribution Mail Option group box to indicate how an employee's check should be

distributed.

Field or Control

Description

Home Address Select to send checks to the employee's home address. The
system automatically displays the home address from the
employee's personal data in PeopleSoft HCM.

Mailing Address Select to send checks to the employee's mailing address. The

system automatically displays the mailing address from the
employee's personal data in PeopleSoft HCM.
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Field or Control Description

Check Address Select to send checks to the employee's check address. The
system automatically displays the check address from the
employee's personal data in PeopleSoft HCM.

Update Check Address Select to update the employee's check address here, rather than
on the Personal Data component.

Payroll Options 2 Page

Use the Payroll Options 2 page (PAYROLL DATAZ2) to set up paycheck location and payroll deduction

subset options.

Navigation:

Payroll Interface > Update Payroll Information > Payroll Options > Payroll Options 2

This example illustrates the fields and controls on the Payroll Options 2 page.

Fayroll Options 1 Payroll Options 2

Charles Koberg

Primary PayGroup [KUT OJ
Paycheck Location Qption

@ Home Department Location
2 Job Location

O Other Location

Other Location Infarrmation

SetiD @

Mail Drop ID

Paycheck Name

Deductions Taken

‘Deductions Taken | Mo Override

ID KLIo0G Company GBI
Deduction Calc Record | 0/@,

Location Code @,

L Deduction Subset ID @,
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Field or Control Description

Primary PayGroup Select to identify the pay group for which a consolidated
paysheet will be created when an employee is being paid in
different pay groups during the same pay run. The primary
pay group also controls whether deductions or additional pay
should be taken for the pay period.

For employees with multiple jobs, PeopleSoft recommends
that you select, as the primary pay group, the one in which the
employee is paid most often. If you leave this field blank, the
system uses the default pay group that is associated with the
first job into which the employee was hired.

Note: You are responsible for verifying that this value is
correct for each employee.

Paycheck Location Option

Use the options in the Paycheck Location Option group box to specify which location code to use as a sort
option for printing paychecks for this pay group. These options are used only if:

* The Company Distribution Order option is selected as the paycheck sequence option on the Pay
Group Table - Check Distribution page.

* The Select on Payroll Data Panel option is selected as the paycheck location option on the Pay
Group Table - Check Distribution page.

* The location is entered as a check print sequence on the Pay Group Table - Check Sequencing page.

See Understanding Payroll Schedules.

Note: You must create location codes in the Location table before you can use them here or elsewhere in

the system.

Field or Control Description

Home Department Location Select the location code (in the Department table) that is
associated with the department ID on the employee's Job
record that is used as a sort option for printing checks.

Job Location Select the location on the employee's Job record that is used as
a sort option for printing checks.

Other Location Select to enter a different location code to use as a sort option
for printing checks. In this case, the system uses the designated
agent address and transmits the check for office delivery.

If you select the Other Location option, you also must select
a setID and a location code.
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Field or Control

Description

SetID

Select the setID for the location code.

Location CD (location code)

Select a location code to indicate this location as a sort option
for printing checks. Use this option only if the Select on
Payroll Data Panel option is selected as the paycheck location
option on the Pay Group Table - Check Distribution page.

Mail Drop ID

Select to enter the employee's mail drop ID.

Paycheck Name

Select to enter a name, other than the employee name that is
entered on the Personal Data record, to whom the paycheck
should be made out. This field is not formatted, so enter the
name exactly as you want it to appear on the paycheck.

Deductions Taken

Use the options in the Deductions Taken group box to indicate how to take deductions for an employee.
Selections made on this page override the values that are entered for the pay run in the General
Deductions Taken field on the Pay Calendar table. Values include:

Field or Control

Description

Deductions Taken

*  NoOverride: This is the default value. If this is
unchanged, the deductions that are specified on the Pay
Calendar table are not overridden on the paysheet at this
stage in deduction override evaluation processing.

*  Deduction: Select this value to process the standard
general deductions for this employee as set up on the
Deduction table.

*  None: Select this value if no general deductions should be
taken out of the paycheck.

*  Subset: Select this value to take only those general
deductions that are included in the deduction subset that
you specify in theDeduction Subset ID field.

Deduction Subset ID

You must specify the subset ID if you select Subset in
theDeductions Taken field.
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(CAN) Setting Up and Maintaining Source Deductions

To set up and maintain source deductions, use the Update Source Deductions CAN (RUN_TAX103CN)
component.

Page Used to Set Up and Maintain Source Deductions

Page Name Definition Name Usage

Update Source Deductions Page RUN_TAX103CN Run the Update Source Deductions SQR
Report process (TAX103CN).

Understanding Source Deduction Processing

Use the Update Source Deductions SQR Report process (TAX103CN) to calculate and update federal,
Quebec, and provincial basic source deductions for employees by generating a new Canadian Income Tax
Data record for each employee who is active as of the effective date specified.

Set up and run this process at predefined intervals in preparation for the new year's payroll processing.
The corresponding report (TAX103CN) provides a list of all records created.

Update Source Deductions Page

188

Use the Update Source Deductions page (RUN_TAX103CN) to run the Update Source Deductions SQR
Report process (TAX103CN).

Navigation:

Payroll Interface > Update Payroll Information > Update Source Deductions CAN > Update
Source Deductions

This example illustrates the fields and controls on the Update Source Deductions page (1 of 2).

Update Source Deductions

Run Control ID ES Report Manager  Process Monitor | Run ‘

Language |w|

Report Request Parameter(s)

Effective Date | \

Reset Options

Reset Special Letters |Y | Reset Special Letters (Quebec) |Y |
Reset Federal Commission |Y | Reset Quebec Commission |Y |
Reset CPP Subject Months |N | Reset Quebec Health |Y |

Reset Cross Province |Y |
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This example illustrates the fields and controls on the Update Source Deductions page (2 of 2).

Basic Claim Amounts
Override Or Increase Federal By Quebec Increase By
[J Override Amount Percent ‘ 10.0000
Percent ‘ ‘ —
- Amount | 100
Amount ‘ ‘
Provincial Increase By ‘ Q ‘ | 1o0f1 v
*Province ‘ Q ‘ ‘ + H = ‘
Percent ‘ ‘ Amount ‘ ‘
Percentage changes will be applied before fixed amount changes.

Field or Control Description

Reset Special Letters Enter Y (yes) to reset the special letters amount to zero.
Reset Federal Commission Enter Y to reset the federal commission amounts to zero.
Reset CPP Subject Months (reset Canada Pension Plan Y (yes): Reset the employee's CPP subject months to 12.

subject months)
N (no): Reset the employee's CPP subject months to zero
when the employee's original CPP subject months are fewer
than 12 (for example, to reset CPP subject months to zero
for employees who no longer contribute to CPP). If the
employee's original CPP subject months are 12, they remain
12.

Reset Cross Province Y (yes): The Cross Province check box on the Canadian
Income Tax Data 2 page is deselected when the new record is
created.

N (no): The Reset Cross Province check box and associated
field values are copied to the newly created record.

Reset Special Letters (Quebec) Enter Y (yes) to reset the Quebec special letters amount to
Zero.
Reset Quebec Commission Enter Y (yes) to reset the Quebec commission amounts to zero.
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Field or Control

Description

Reset Quebec Health

Enter Y (yes) to deselect the Exempt from Quebec Health
check box on the Quebec Income Tax Data page for all
employees for whom Exempt from Quebec Health is
currently selected. Resetting in this way makes no employee
exempt from Quebec Health.

Field or Control

Description

Override Or Increase Federal By

Use this group box to perform updates to employees' federal
basic claim amounts.

Use percent, amount, or both to specify the value of the
increase when the Override Amount check box is not
selected.

Use amount to specify the override amount when the Override
Amount check box is selected. The amount will default to the
Federal Basic Personal Amount from the Canadian Tax Table
if amount is zero or blank.

Quebec Increase By

Use this group box to perform updates to employees' Quebec
basic claim amounts. Use either percent or amount to specify
the value of the increase.

Provincial Increase By

Use this group box to perform updates to employees'
provincial basic personal amounts. Add rows to enter multiple
provinces. Use either percent or amount to specify the value of
the increase.
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Understanding Deduction Processing

If you maintain deduction information using Payroll Interface and the Manage Base Benefits business
process in PeopleSoft HR, then you must run the Calculate Deductions and Confirm Deductions processes
before running the Export process.

The deduction processes use the information that you set up through the Manage Base Benefit business
process to calculate and confirm per pay period deduction amounts. When the Export process is run, these
amounts are exported, along with the other payroll data, to the third-party payroll system. The third-party
payroll system performs the gross to net calculations.

Note: If you do not maintain deductions (that is, if the third-party payroll system manages all deduction
information), then you do not need to run the Calculate Deductions or Confirm Deductions processes.

See Understanding Data Exchanges.

See PeopleTools: Process Scheduler

Calculating Deductions

Use the Calculate Deductions COBOL SQL process (PSPDCRUN ) to calculate pay period deduction
amounts. If an error occurs, correct the problem and then run the process again. You can run the Calculate
Deductions process as many times as necessary to correct errors. After you have resolved all of the errors,
you can run the Confirm Deductions process.

Note: To determine whether errors occurred during the Calculate Deductions process, examine both the
deduction run (Review Deductions component) and the deduction messages (Review Error Messages
component). You cannot run the Confirm Deductions process until all deduction calculation errors have
been resolved.

To calculate deductions:
1. Run the Calculate Deductions process to calculate deductions.

See Calculating Deductions.

2. Review the results of the deduction calculation run.

See Reviewing Deductions.

Confirming Deductions

Use the Confirm Deductions COBOL SQL process (PSPDCCNF) to signify that the pay period deduction
amounts have been calculated and are error free; that is, you have run the Calculate Deductions process,
checked the results, rerun the process if necessary, and verified that the results are accurate. When you run
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the Confirm Deductions process, the system stores the results in the DED CALC and DED MESSAGE
tables, and flags the pay calendar as confirmed (F flag). The deductions are now ready for the Export
process.

Note: Again, to determine whether errors occurred during the Confirm Deductions process, examine both
the deduction run (Review Deductions component) and the deduction messages (Review Error Messages
component).

To confirm deductions:

1. Run the Confirm Deductions process to confirm the calculated deductions.
See Confirming or Unconfirming Deductions.

2. Review the results of the deductions confirmation run.

See Reviewing Deductions.

Reprocessing Deductions

Use the Deductions Unconfirm COBOL SQL process (PSPDCUNC) to unconfirm and reprocess
deductions that have already been calculated and confirmed.

To process deductions, you run (and review) the Calculate Deductions and Confirm Deductions processes.
After the Confirm Deductions process is run, no further changes can be made to deduction data for the
pay period unless you reprocess the deductions.

To reprocess deductions:

1. Update or make the necessary changes to the deduction data.

2. Run the Deductions Unconfirm process to unconfirm the calculated deductions.
See Confirming or Unconfirming Deductions.

3. Run the Calculate Deductions process to recalculate deductions.

4. Run the Confirm Deductions process to reconfirm the calculated deductions.

Calculating Deductions

To calculate deductions, use the Calculate Deductions (RUNCTL_DED_CALC) component.

Pages Used to Calculate Deductions

Page Name Definition Name Usage

Calculate Deductions Page RUNCTL DED CALC Select the deduction calculation options
and run the Calculate Deductions
COBOL SQL process (PSPDCRUN) to
calculate deductions.
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Calculate Deductions Page

Use the Calculate Deductions page (RUNCTL _DED CALC) to select the deduction calculation options
and run the Calculate Deductions COBOL SQL process (PSPDCRUN) to calculate deductions.

Navigation:
Payroll Interface > Pay Period Deductions > Calculate Deductions > Calculate Deductions

This example illustrates the fields and controls on the Calculate Deductions page.

Calculate Deductions

Fun Control I PSS Report Manager Process Monitor Fun

Fun Parameters
Pay Run Il U1-04-01 QL )5 kU1 weekly Pay 01Jan 04

Select Deductions to Calculate

® Only Calculate Where Needed
O {Re)Calculate All Checks

Field or Control Description

Pay Run ID Select a pay run ID. The pay run ID identifies the pay groups
to be processed.

See Understanding Payroll Schedules.

Select Deductions to Calculate Select:

*  Only Calculate Where Needed when employee-level
changes occur. The system calculates deductions for
employees who:

*  Were not yet calculated this pay period.

e Were calculated, but errors occurred during the
calculation process.

*  Had benefit or job changes since the last deduction
calculation for the pay period.

* (Re)Calculate All Checks when benefit-table-level
changes occur that will affect deduction calculation, such
as benefit premium adjustments.

Note: This option processes both benefit-table-level
changes and employee-level changes.
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Confirming or Unconfirming Deductions

To confirm or unconfirm deductions, use the Confirm Deductions (RUNCTL _DED_CONF) component.

Pages Used to Confirm or Unconfirm Deductions

Page Name Definition Name Usage
Confirm Deductions Page RUNCTL DED_ CONF Enter parameters to run the Confirm

Deductions COBOL SQL process
(PSPDCCNF) to confirm the calculated
deductions.

Enter parameters to run the Deductions
Unconfirm COBOL SQL process
(PSPDCUNC) to unconfirm the
calculated deductions

Confirm Deductions Page

Use the Confirm Deductions page (RUNCTL DED_CONF) to enter parameters to run Confirm
Deductions COBOL SQL process (PSPDCCNF) to confirm the calculated deductions.

Also use the page to enter parameters to run the Deductions Unconfirm COBOL SQL process
(PSPDCUNC) to unconfirm the calculated deductions.

Navigation:
Payroll Interface > Pay Period Deductions > Confirm Deductions > Confirm Deductions

This example illustrates the fields and controls on the Confirm Deductions page.

Confirm Decluctions

Fun Control I P2 Report Manager Process Manitar Fun

Fun Parameters

Pay Run 1D [KU1-01-04 @ U5 KU1 Weekly Pay 01 Jan 04

Field or Control Description

Pay Run ID Select the pay run ID of the deduction calculation run that you
want to confirm or unconfirm.

See Calculate Deductions Page.
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Reviewing Deductions

To review deductions, use the Review Error Messages (DED MESSAGE) and Review Deductions
(DED_CALCULATIONS) components.

Pages Used to Review Deductions

Page Name Definition Name Usage

Error Messages Page DED_MESSAGE Review error messages after running a
deduction process.

Review Deductions Page DED CALCULATIONS Review deduction amounts after running
a deduction process.

Review Deductions Page

Use the Review Deductions page (DED CALCULATIONS) to review deduction amounts after running a
deduction process.

Navigation:
Payroll Interface > Pay Period Deductions > Review Deductions > Review Deductions

This example illustrates the fields and controls on the Review Deductions page.

Review Deductions

Deduction Deta

Employee ID KUID11 Company GBI

Empl Record 0 Pay Group KLI2

Hame William Fraas Pay End Date 01/02/2000
Deductions Farsonalize | Find | View All (E] | = First '\&' 1-4 of 4 ‘&' Last
Plan Type Benefit Deduction Class Deduction Description Current Coverage Current Deduction
an Typ Plan B <R Code . P Deduction Base Payback

Medical KUHMO1 Before-Tax KUHKOK Kaiser HMO 29.77
Medical KUHMO1 MNontaxable KUHKMOK Kaiser HMO 60.00
Denta KUDEMZ2 Before-Tax KUDENS Dental Plan 7.79
Denta KUDEMZ MNontaxable KUDENY Dental Plan 1.85

Review Deductions

To access the Review Deductions page, you must first make selections on the Review Deductions search
page. The Payline Calculation Status field has several options.
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Field or Control

Description

Payline Calculation Status

Always select and review the information for the Calculation
Error, Pay in Progress, and Updated by User options.

Note: Calculation errors (E) are automatically displayed, but
the pay in progress (P) and updated by user (U) errors are
not. If pay in progress or updated by user errors exist and are
not corrected during the Calculate Deductions process, the
Confirm Deductions process will fail.

The Payline Calculation Status option is:

»  Setto Calculated if no errors occur during the Calculate
Deductions run.

»  Setto Confirmed if no errors occur during the Confirm
Deductions run.

*  Reset to Calculated after the Deduction Unconfirm

process is run.
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Running Exports and Imports

Understanding Data Exchanges

Payroll Interface enables you to exchange data between PeopleSoft HCM and a third-party payroll
system. Data is exported from PeopleSoft HCM to the third-party payroll system using either a file or
table. Data is imported from the third-party payroll system back into PeopleSoft HCM using on/y an
ASCII formatted file. You use the same run-control process to export or import data.

Note: If you maintain deduction information, you must run the Calculate Deductions and Confirm
Deductions processes before running the Export process.

See Understanding Deduction Processing.

See PeopleTools: Process Scheduler

Exporting Data

Use the Export Application Engine process (PI_INRUN) to export data. The Export process retrieves,
maps, and exports data using the definitions and processing routines that are set up through the export
interface. When the Export process is complete (the export file or the export table is created), the third-
party payroll vendor uses the appropriate software to load the data and process the payroll.

The export process includes three phases: select, compare, and export.
» During the select phase, employee payroll data is retrieved from the PeopleSoft HCM tables.

* During the compare phase, the selected data is compared against the data from the previous export
run. The comparison phase identifies any data changes that have occurred since the last export.

* During the export phase, the data is exported to either a flat file or a table.

A full-records export performs the select and export phases; all employee data is exported. A changes-
only export performs the select, compare, and export phases; only employee data that has changed is
exported.

To export data:
1. Setup and run the Export process.

See Exporting or Importing Data.

2. Review the results of the Export process run.

See Reviewing Exports or Imports.
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Importing Data

Use the Import Application Engine process (PI_INRUN) to import data. The Import process loads

the processed payroll information (check detail and balance data) generated by the third-party payroll
system into seven Payroll Interface import tables for online viewing and reporting. Further processing or
technical configuration may be required to check the validity of the data or to ensure that employee-level
data can be accessed in a secure manner.

To import data:
1. Obtain a copy of the ASCII import file from the third-party payroll vendor.
2. (Optional) If the file is tab-delimited, convert it to comma-delimited.

See Converting Tab-Delimited Import Files.

3. Store the import file in the location that is defined in the File Handle Table component.
4. Set up and run the Import process.

See Exporting or Importing Data.

5. Review the results of the Import process run.

See Exporting or Importing Data.

Exporting or Importing Data

To export or import data, use the Import/Export Payroll Data (PI RUNCTL_PNL) component.

Pages Used to Export and Import Data

Page Name Definition Name Usage

Import/Export Payroll Data Page PI_ RUNCTL_PNL Select the export or import process
options and run the P.I. Export/Import
Driver Application Engine process (P1
INRUN) to export or import data.

Import/Export Payroll Data Page

198

Use the Import/Export Payroll Data page (PI RUNCTL_PNL) to select the export or import process
options and run the P.I. Export/Import Driver Application Engine process (PI_INRUN) to export or
import data.

Navigation:

Payroll Interface > Payroll Data Exchanges > Import/Export Payroll Data > Import/Export
Payroll Data
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This example illustrates the fields and controls on the Import/Export Payroll Data page.

Import/Export Payroll Data

Run Control ID 1

Run Parameters

*PayRuniD KU7-0001 Q| yy7.0001

*PI Run Option ‘ New v‘

Check Point Interval ‘ |

Report Manager Process Monitor

Run Type | Export

*Pl Run Number

*Select Type | All Employees in Group

" | ORun Select and Compare Only

» | O Exclude Calculated Deductions

Export Options
*Export Change or Full | Full Set of Records
Reprocess
Compare Export

4 Active Employees

Run Parameters

Field or Control

Description

Run Type

Select which process to run, either Export or Import.

PI Run Option (Payroll Interface run option)

Select a run option:

*  New: Increments the payroll interface run number and
runs a new Export process.

*  Reprocess: Reruns an existing Export process. You must
select the payroll interface run number of the process that
you want to reprocess.

*  Restart: Restarts the most recent Export process (the most

recently selected payroll interface run number).

PI Run Number

Each time that you run a new Export process, the system
increments the run number. During the compare phase, the
Export process uses the run numbers to compare the results of
the current export with the results of the previous export.
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Field or Control

Description

Check Point Interval (check point interval in minutes)

Select to specify how often, in minutes, the system should
commit during a process run.

Note: To determine the interval using number of employees
rather than number of minutes — that is, to use the Installation
Table - Third Party/System page, Commit After Empl
Processed (commit after employee processed) field value —
leave theCheck Point Interval field blank or enter 0.

Export Options

Use this group box to select options for the Export process. (These options do not apply to the Import

process).

Field or Control

Description

Select Type

Select which employees to process:

*  All Employees in Group: Process all employees in the pay
group.

*  Manually Select: Process those employees that are
specified in the Selected Employees group box.

*  SmartSelect: Process those employees that are in the
pay group for whom online changes have been made
since the last export run. If the selection process finds
that all employees in the group have not yet been run for
this company and pay group combination, SmartSelect
is overridden at the pay group level and changed to A/l
Employees in Group.

Note: Before selecting this option, you must activate
SmartSelect by attaching a PeopleCode function to all
EMPLID-keyed tables that are defined in the PS Tables
component.

See Working with Smart Select.

Note: (USF) For National Finance Center (NFC) interface
definitions, theSelect Type field does not appear. The Output
Files (s) field appears instead. You can output all files or just
the EPIC file or PMSO file.

See Working with Smart Select.
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Field or Control

Description

Export Change or Full

Select to identify which employee records to process:

*  Chgs Only (changes only): Process only employee records
with changed data.

*  Full Recs (full records): Process all employee records.

Note: If you attempt to run a changes-only export (select,
compare, export) before running a full-records export (select,
export), processing becomes Full Recs by default. To perform

a changes-only export, data from a previous run must be in

place.

Run Select and Compare Only

Select this option to run the Export process but not create the
export file.

This option enables you to review the export data before
creating the export file. It also enables you to run the Export
process at one location and create the export file at another

location.

Note: If you select this option, use the Complete Export to
File (complete export to external file) component to create the
export file.

Exclude Calculated Deductions

Select if you do not want to process deductions.

Note: Always select this option if you do not maintain
deductions (if you never run the Calculate Deductions and
Confirm Deductions processes).

See Understanding Deduction Processing.

Active Employees

Select to process only employees whose employee status is
defined as active (on the System Table - Interface System

Table 2 page, Employee Status field).

Note: Do not select this option if you want to process all
employees, regardless of their status (for example, for year-

end processing).
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Reprocess
Field or Control Description
Reprocess Select to rerun a previously completed Export process.

*  Compare: Rerun the Export process compare and export

phases.

This option deletes the data from the PS_PI PARTIC,
PS_PI PARTIC_EXPT, and PS_PI_MESSAGE tables
where the PI RUN_NUMBER matches the reprocess PI
RUN_NUMBER. The Export process performs the select,
compare, and export phases.

*  Export: Rerun the Export process export phase.

This option uses the data that is currently stored in the
PS PI PARTIC, PS _PI PARTIC_EXPT, and PS_PI

_ MESSAGE tables where the PI RUN_NUMBER
matches the reprocess PI RUN_NUMBER. The Export
process performs the export phase only.

Note: To reprocess an Export run, you usually select the

Compare option.

Selected Employees

This group box appears only when you select Select Type,Manually Select. Manually enter each
employee that you want to include in the Export process.

Field or Control Description

Employee ID and Empl Record (employee record) Enter the employee identifiers as defined on the Employee
Table - Interface Employee Table page.

Creating the Export File Separately

To create the export file separately, use the Complete Export to File (PI RUNCTL AE) component.

202 Copyright © 1988, 2026, Oracle and/or its affiliates.



Chapter 13

Pages Used to Create the Export File Separately

Running Exports and Imports

Page Name Definition Name

Usage

Complete Export to File Page PI_ RUNCTL_AE

PNL

Select the export file run options and
run the P.I. External File I/O Application
Engine process (PI_EXTFL) to create
the export file separately.

Use this page only if you have already
run the Export process using the Import/
Export Payroll Data page with the Run
Select and Compare Only option
selected.

Complete Export to File Page

Use the Complete Export to File page (Pl RUNCTL_AE PNL) to select the export file run options and
run the P.I. External File I/O Application Engine process (PI_EXTFL) to create the export file separately.

Navigation:

Payroll Interface > Payroll Data Exchanges > Complete Export to File > Complete Export to

File

This example illustrates the fields and controls on the Complete Export to File page.

Complete Export to File

Fun Control I PSS Report Manager

Fun Parameters

‘Pay Run ID |KU1-01-04 @,
Fun Type | Export w

‘Pl Run Option | Mew w
‘Pl Rum Number 1)@,

FProcess Manitar

15 KL weekly Pay 01 Jan 04

Fun

Note: Use this page only if you have already run the Export process using the Import/Export Payroll Data
page with the Run Select and Compare Only option selected.

Field or Control

Description

Pay Run ID

complete.

Select the pay run ID of the export run that you want to

Copyright © 1988, 2026, Oracle and/or its affiliates.

203



Running Exports and Imports Chapter 13

Field or Control Description

Run Type Select and enter Export.

PI Run Option(payroll interface run option) Select to enter a run option.

Payroll Interface Run Number Select to enter the run number that corresponds to the pay run
ID.

Converting Tab-Delimited Import Files

To convert tab-delimited import files, use the Convert Tab Delimiter (RUNCTL PICNVT_ TAB)
component.

Pages Used to Convert Tab-Delimited Import Files

Page Name Definition Name Usage

Convert Tab Delimiter Page RUNCTL PICNVT TAB Select the tab-delimited import file
options to run the Convert Tab Delimited
Files SQR Report process (P1002) to
convert a tab-delimited import file.

Convert Tab Delimiter Page

Use the Convert Tab Delimiter page (RUNCTL PICNVT TAB) to select the tab-delimited import file
options to run the Convert Tab Delimited Files SQR Report process (P1002) to convert a tab-delimited
import file.

Navigation:
Payroll Interface > Payroll Data Exchanges > Convert Tab Delimiter > Convert Tab Delimiter

This example illustrates the fields and controls on the Convert Tab Delimiter page.

Convert Tab Delimiter

Fun Control ID PSS Report Manager Process Manitar Run

Run Parameters

‘SystemID G2V Q. gy sample Layout
Configuration ID | G5V @, ¢5Y Sample Config 1D
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Note: Use this page to convert tab-delimited import files. Because COBOL automatically changes a tab
to a space when reading a file, you must convert tab-delimited files into comma-delimited files before
importing them.

Field or Control Description

System ID Select the system ID that identifies the third-party payroll
system.

Configuration ID Select the configuration ID that identifies the import files to be
converted.

Reviewing Exports or Imports

To review exports and imports, use the Error Messages (P MESSAGES), Run Table
(INTERFACE_RUN_TBL), Export Details INTERFACE PARTIC), Table Export
(PI_PARTIC_EXTBL), Check Summary (PI CHECK SUMM), Earnings Balances
(INTERFACE_EARN _BAL), Deduction Balances INTERFACE_DED_ BAL), and Tax Balances
(INTERFACE _TAX BAL) components.

Pages Used to Review Exports or Imports

Page Name Definition Name Usage

Interface Messages Page PI_ MESSAGES Export/Import Process

Review error messages generated by
Payroll Interface.

The Error Key field indicates the Payroll
Interface field that has the problem.
Refer to PSCPYMSG.CBL (COBOL)
for technical troubleshooting.

Run Table Page PI_ RUNTBL PNL Export/Import Process

Review information about import and
export runs.

Export Details Page PI PARTIC PNL Export Process

Review the results of the Export process.
The data shown here represents the
contents of the PI_ PARTIC_EXPT table.
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Page Name

Definition Name

Usage

Table Export Page

PI_PARTIC_EXTBL

Export Process

Review the results of the Export process
when writing data to a table. The data
shown here represents the contents of the
PI_PARTIC_EXTBL table (the export
table).

Check Summary Page

PI_CHECK_SUMM

Import Process

Review check data that is imported from
your third-party payroll system.

Select the Tax Detail link to view a page
with tax details for the check summary
that you're reviewing.

Check Tax Detail Page

PI_ CHECK_SUMM SI1

Import Process

Review tax details for a check summary.

Earnings Balances Page

PI_ERNBAL PNL

Import Process

Review earnings balances that are
imported from your payroll system.

Deduction Balances Page

PI_DEDBAL PNL

Import Process

Review deduction balances that are
imported from your payroll system.

Tax Balances Page

PI_TAXBAL PNL

Import Process

Review tax balances that are imported
from your payroll system.
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PeopleSoft Payroll Interface Reports: A to Z

Tables in this topic list PeopleSoft Payroll Interface reports, sorted by report ID.

For more information about running the reports, refer to:

*  The corresponding topic in this product documentation.

*  Peoplelools: Process Scheduler

*  Peoplelools: BI Publisher for PeopleSoft

*  Peoplelools: SOR Language Reference for PeopleSoft

For samples of the reports, see the Report Samples that are published with this online documentation.

Data Reports

This table lists and describes the data reports that are included in PeopleSoft Payroll Interface, listed

alphanumerically.

Report ID and Report Description Navigation Run Control Page
Name

Pay031 For each company/pay group, | Payroll Interface > RUNCTL_PAYINIT2

Benefit Deductions Register

lists the deduction type and
calculated deduction amount
for each employee. This
report can be run only after
the Calculate Deductions
process is run.

Reports > Benefit
Deductions Register >
Benefit Deductions Register

Data Report

PI1001 Lists detailed information Payroll Interface > RUNCTL_PIEXPT
for employees who will be Reports > Export
Export Changes Report included in the export file, Changes > Export
including both old and new Changes Report
values for fields that changed
since the last export file was
created.
TAXO016 (USA) Lists employees with | Payroll Interface > RUNCTL FRMTHRU PAY
default data in their Tax Reports > Default Tax
Default Tax Data Report records. Data USA > Default Tax
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Employee Tax Information

listing of the employee's tax
withholding information.

Reports > Employee
Tax Information USA >

Report ID and Report Description Navigation Run Control Page
Name
TAX016CN (CAN) Provides the data Payroll Interface > RUNCTL FRMTHRU PAY
that is auto-generated by Reports > Default Tax
Default Tax Data Report the system, such as the Data CAN > Default Tax
employee's hire date, default | Data Report
net claim amount from the
Canadian Tax Tables, and
province. This report also
includes the provincial tax
credit amounts from the
Canadian Income Tax Data
record.
TAXO019 (USA) Provides an individual | Payroll Interface > RUNCTL _TAXO019

Employee Tax Information

listing of the employee's tax
withholding information.

Reports > Employee
Tax Information CAN >

Report Employee Tax Information
Report
TAX019 (CAN) Provides an individual | Payroll Interface > RUNCTL TAXO019

W-4 Exemptions Report

in each company who are
exempt from federal income
tax withholding.

Reports > W-4
Exemption > W-4
Exemptions Report

Report Employee Tax Information
Report
TAX100 (USA) Lists all employees Payroll Interface > RUNCTL _TAX100

TAX100CN

Exemption Report

(CAN) Lists all employees
whose Canadian or Quebec
Tax Data records indicate
that they are exempt from
income tax withholding, are
exempt from unemployment
insurance payments, or have
fewer than 12 months subject
to Canada or Quebec pension
plan contributions.

Payroll Interface >
Reports > Exemption
CAN > Exemption Report

RUNCTL_TAX100CN

TAX103

Reset W-4 Exempt List

(USA) Identifies employees
who have not yet filed a new
Form W-4 by the due date

to continue their exemption
status, and inserts a new Tax
record to reset the special
withholding tax status and
tax status of each of those
employees. The report also
updates future-dated records
that currently specify exempt
status.

Payroll Interface >
Reports > Reset W-4
Exempt List > Reset W-4
Exempt List

RUNCTL_TAX103
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Report ID and Report Description Navigation Run Control Page
Name
TAX107 (USA) Lists all employees Payroll Interface > RUNCTL TAX107

W-4 Audit Report

who either created or updated
their W4 information on the
web.

Reports > W-4 Audit >
W-4 Audit Report

Payroll Reports

This table lists and describes the payroll reports that are included in PeopleSoft Payroll Interface, listed

alphanumerically.
Report ID and Report Description Navigation Run Control Page
Name
PAY703 Lists information from the Set Up HCM > Product PRCSRUNCNTL
General Deduction/Deduction | Related > Payroll
General Ded/Frequency Frequency Table, which Interface > Payroll
Report (general deduction/ contains payroll deductions | Reports > General
frequency report) that do not fit into a category | Deduction/Frequency >
covered by a benefit table, General Ded/Frequency
such as United Way, union Report
dues, or parking fees.
PAY704 Lists information from Set Up HCM > Product PRCSRUNCNTL
the Deduction/Deduction Related > Payroll
Deduction/Frequency Report | Frequency Table, which Interface > Payroll
contains deduction priority, Reports > Deduction/
tax effect, and frequency for | Frequency > Deduction/
benefit deductions and general | Frequency Report
deductions.
PAY705A/B Lists deduction classification | Set Up HCM > Product PRCSRUNCNTL
codes from the Deduction Related > Payroll
Deduction Class Report Table. Interface > Payroll
Reports > Deduction
Class > Deduction Class
Report
PAY708 Lists information from Set Up HCM > Product PRCSRUNCNTL
the Shift table, where you Related > Payroll
Shift Report identify the work shifts to Interface > Payroll

which you can assign an
employee. Because it contains
the rate or factor that the
system uses to calculate the
shift differential, this table
works with the Earnings and
Special Accumulator Tables to
calculate earnings.

Reports > Shift Table >
Shift Report
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Report ID and Report Description Navigation Run Control Page
Name
PAY709 (CAN) Lists information from | Set Up HCM > Product PRCSRUNCNTL
the Wage Loss Plan Table for | Related > Payroll
Wage Loss Plan Report Canadian employers. Interface > Payroll
Reports > Wage Loss Plan
CAN > Wage Loss Plan
Report
PAY711 Lists pay groups, effective Set Up HCM > Product PRCSRUNCNTL
dates, and processing Related > Payroll
Pay Group Report characteristics from the Pay Interface > Payroll
Group Table. Reports > Pay Group
Table > Pay Group Report
PAY712A/B/C Lists earnings types and their | Set Up HCM > Product PRCSRUNCNTL
payroll characteristics. Related > Payroll
Earnings Report Interface > Payroll
Reports > Earnings
Table > Earnings Report
PAY714 Lists information from the Set Up HCM > PRCSRUNCNTL
Pay Calendar Table, which Product Related >
Pay Calendar Report contains the cycles that you Payroll Interface >
create for payroll processing | Payroll Reports > Pay
by pay group. Each entry in Calendar > Pay Calendar
the table corresponds to a pay | Report
period for a pay group.
PAY717 Lists information from the Set Up HCM > Product PRCSRUNCNTL
Earnings Program Table. Related > Payroll
Earnings Program Report Interface > Payroll
Reports > Earnings
Program > Earnings
Program Report
TAX702 (USA) Prints information Set Up HCM > Product PRCSRUNCNTRL
from the State Tax Table and | Related > Payroll
Federal/State Tax Report the State Other Tax Table, Interface > Payroll
which store the most current | Reports > Federal/State
tax rates and other parameters | Tax > Federal/State Tax
that are used in calculating Report
state and federal withholding,
disability, and unemployment
taxes.
TAX703 (USA) Lists information from | Set Up HCM > Product PRCSRUNCNTRL
the Local Tax Table, which Related > Payroll
Local Tax Report contains calculations for local | Interface > Payroll

income taxes.

Reports > Local Tax >
Local Tax Report
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Report ID and Report Description Navigation Run Control Page
Name
TAX705 (USA) Lists information Set Up HCM > Product PRCSRUNCNTRL

from the Company Local Related > Payroll
Company Local Tax Report Tax Table, which identifies Interface > Payroll

the localities for which your | Reports > Agency Local

company collects and pays Tax USF > Company

taxes. Local Tax Report
TAX707 (USA) Lists information from | Set Up HCM > Product PRCSRUNCNTRL

State Tax Rate Report

the State Tax Rate Table,
which contains bracket rates
that are needed for calculating
state and federal taxes.

Related > Payroll
Interface > Payroll
Reports > State Tax
Rate > State Tax Rate
Report

Interface Definition Reports

This table lists and describes the interface definition reports that are included in PeopleSoft Payroll
Interface, listed alphanumerically.

fields are mapped to them
for both import and export
processing.

Definition Reports > Field
Listing > Field Listing

Report ID and Report Description Navigation Run Control Page
Name
PI701 Shows each system ID, its Set Up HCM > Product PRCSRUNCNTL
description, and its effective Related > Payroll
System Table Listing date, along with other data on | Interface > Interface
the System Interface Table. Definition Reports >
System Table Listing >
System Table Listing
P1702 Lists PeopleSoft tables and Set Up HCM > Product PRCSRUNCNTL
views that you can use in Related > Payroll
PS Record Listing PeopleSoft Payroll Interface. | Interface > Interface
Definition Reports >
PS Record Listing > PS
Record Listing
P1703 Lists each field on the Set Up HCM > Product PRCSRUNCNTL
PeopleSoft tables and views | Related > Payroll
PS Record-Field Listing that you can use in PeopleSoft | Interface > Interface
Payroll Interface. Definition Reports > PS
Record-Field Listing > PS
Record-Field Listing
P1704 Shows fields that are defined | Set Up HCM > Product PRCSRUNCNTL
for the third-party payroll Related > Payroll
Field Listing system and how PeopleSoft | Interface > Interface
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Report ID and Report Description Navigation Run Control Page
Name
PI1705 For each defined system ID, | Set Up HCM > Product PRCSRUNCNTL
lists the third-party payroll Related > Payroll
Field-Translation Listing system's fields along with the | Interface > Interface
PeopleSoft source fields. Also | Definition Reports >
lists translate values. Field-Translation
Listing > Field-
Translation Listing
P1706 Displays each instance of Set Up HCM > Product PRCSRUNCNTL
a PeopleSoft record to be Related > Payroll
Instance Listing exported to the third-party Interface > Interface
payroll system. Definition Reports >
Instance Listing >
Instance Listing
P1707 Displays descriptions for each | Set Up HCM > Product PRCSRUNCNTL
defined COBOL process that | Related > Payroll
Process Listing filters data before creating the | Interface > Interface
export file. Definition Reports >
Process Listing > Process
Listing
P1708 Displays values that are Set Up HCM > Product PRCSRUNCNTL
returned from a special Related > Payroll
Process Values COBOL process. These Interface > Interface
values are used in the field Definition Reports >
translation process. Process Values > Process
Values
P1709 Lists each file that isused in | Set Up HCM > Product PRCSRUNCNTL
PeopleSoft Payroll Interface. | Related > Payroll
Definition Table-File Interface > Interface
Definition Reports >
Definition Table-File >
Definition Table-File
PI710 Lists the layout of each record | Set Up HCM > Product PRCSRUNCNTL
that is used to format import | Related > Payroll
Definition Table-Record and export files. Interface > Interface
Definition Reports >
Definition Table-Record >
Definition Table-Record
PI711 Lists the layout and content Set Up HCM > Product PRCSRUNCNTL

Definition Table-Field

of each field for every record
on each file that is used in
PeopleSoft Payroll Interface.

Related > Payroll
Interface > Interface
Definition Reports >
Definition Table-Field >
Definition Table-Field
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Report ID and Report Description Navigation Run Control Page
Name
PI1712 Displays processing groups, Set Up HCM > Product PRCSRUNCNTL

file names, and descriptions | Related > Payroll
Configuration Listing that are needed for the third- | Interface > Interface
party payroll system. Definition Reports >
Configuration Listing >
Configuration Listing
P1713 Lists group IDs that represent | Set Up HCM > Product PRCSRUNCNTL
fields to be processed together | Related > Payroll
Group Listing in the export file. Interface > Interface
Definition Reports >
Group Listing > Group
Listing
P1714 Where they differ, lists each Set Up HCM > Product PRCSRUNCNTL
PeopleSoft employee ID Related > Payroll
Employee Listing along with the third-party Interface > Interface
payroll system's employee ID. | Definition Reports >
Employee Listing
PI1715 Displays each file handle, file | Set Up HCM > Product PRCSRUNCNTL
name, and description. Related > Payroll
File Handle Listing Interface > Interface

Definition Reports > File
Handle Listing > File
Handle Listing
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